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Introduction
Thank you for purchasing the color image scanner ScanSnap S1100 (hereinafter referred to 
as "the ScanSnap").

This manual explains how to handle and operate the ScanSnap.
Be sure to read this guide and "Getting Started" thoroughly before using the ScanSnap to 
ensure correct use.
We hope that this manual will provide you with useful information in order to utilize the 
ScanSnap.

If you are using a Microsoft® Windows® operating system, either Adobe® Acrobat® (7.0 or 
later) or Adobe® Reader® (7.0 or later) is required to display or print this manual.

Trademarks

Microsoft, Windows, Windows Vista, Excel, PowerPoint, Outlook, SharePoint, and 
Entourage are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries.
Word is the product of Microsoft Corporation in the United States.
Apple, the Apple logo, Mac, Mac OS, iPhoto, and Rosetta are trademarks of Apple Inc.
Adobe, the Adobe logo, Acrobat, and Adobe Reader are either registered trademarks or 
trade names of Adobe Systems Incorporated in the United States and/or other countries. 
Intel, Pentium, and Intel Core are registered trademarks or trademarks of Intel Corporation in 
the United States and other countries.
PowerPC is a registered trademark or trademark of International Business Machines 
Corporation in the United States, other countries, or both.
Cardiris is a trademark of I.R.I.S.
ABBYY™ FineReader™ Engine ©2011 ABBYY. OCR by ABBYY
ABBYY and FineReader are trademarks of ABBYY.
Evernote is a registered trademark or trademark of Evernote Corporation.
Google and Google Docs are registered trademarks or trademarks of Google Inc.
Salesforce, the Salesforce logo, and Salesforce CRM are registered trademarks or 
trademarks of Salesforce.com, inc. in the United States and other countries. 
ScanSnap, the ScanSnap logo, CardMinder, and Rack2-Filer are registered trademarks or 
trademarks of PFU LIMITED in Japan.
Other company names and product names are the registered trademarks or trademarks of 
the respective companies.
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Introduction
Manufacturer

PFU LIMITED
International Sales Dept., Imaging Business Division, Products Group 
Solid Square East Tower 
580 Horikawa-cho, Saiwai-ku, Kawasaki-shi, Kanagawa 212-8563, Japan
Phone: (81-44) 540-4538

© PFU LIMITED 2010-2012

Disclaimer

Reproducibility of the image data
Confirm that the image data scanned with the ScanSnap meets your requirements (e.g. 
image reproducibility in size accuracy, information amount, fidelity, content and color).

Disposing of the original document
Check the image data using the application where you transferred the image data to 
make sure that there are no missing parts before disposing of the original document 
scanned with the ScanSnap. 
It is the responsibility of the customer to store and manage the scanned image, and 
dispose of the original document scanned with the ScanSnap. 
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Introduction
Manuals

Read the following manuals as needed when using the ScanSnap.

Manual Description Reference Method

ScanSnap S1100
Getting Started

Read this manual before you 
start using the product 
because it contains important 
information about the safe use 
of the ScanSnap.
It also explains about the 
ScanSnap package contents, 
software installation, 
connecting the ScanSnap, and 
checking the operation.

Included in the package.

ScanSnap S1100 
Operator's Guide
(this manual)

Read this manual for 
information about basic 
operations of the ScanSnap, 
software installation, scanning 
methods, various settings, and 
handling of the ScanSnap.

Select [Start] menu → [All Programs] → 
[ScanSnap Manager] → [ScanSnap 
Operator's Guide].

Select [Applications] from the sidebar in 
Finder, and double-click [ScanSnap] → 
[Manual] → [Operator's Guide].

Troubleshooting 
(installation)

Read this manual when you 
failed to install the software or 
when the ScanSnap does not 
operate normally after 
software installation. It 
explains about the resolutions 
for such troubles.

Click [Manuals] → [Troubleshooting 
(installation)] in the [ScanSnap Setup] 
dialog box that appears when you insert 
the Setup DVD-ROM into the DVD-ROM 
drive.
Select [Start] menu → [All Programs] → 
[ScanSnap Manager] → 
[Troubleshooting (installation)].

Double-click the [Troubleshooting 
(installation)] icon in the [ScanSnap] 
window that appears when you insert the 
Setup DVD-ROM into the DVD-ROM 
drive.
Select [Applications] from the sidebar in 
Finder, and double-click [ScanSnap] → 
[Manual] → [Troubleshooting 
(installation)].

ScanSnap Connect 
Application User's Guide 
(iOS)

Read this manual for 
information about connecting 
the mobile device and the 
computer, ScanSnap Connect 
Application operations on the 
mobile device, settings and 
receiving files.

Tap  on the [File List] screen of 
ScanSnap Connect Application installed 
on your mobile device, and then tap [Help] 
on the [Information] screen that appears.
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Introduction
ScanSnap Organizer
User's Guide

Read these manuals when 
using this product for the first 
time, or when you need more 
information on product 
features, dialog boxes/
windows, operating 
environment and functions.

Select [Start] menu → [All Programs] → 
[ScanSnap Organizer] → [Manual].

CardMinder User's Guide Select [Start] menu → [All Programs] → 
[CardMinder] → [Manual].

Cardiris™ 4 User Guide From Finder, select [Applications] and 
double-click [Cardiris for ScanSnap] → 
[Manuals] → [User Guide.pdf].

ABBYY FineReader for 
ScanSnap User's Guide

Select [Start] menu → [All Programs] → 
[ABBYY FineReader for ScanSnap(TM) 
4.1] → [User's Guide].

Scan to Microsoft 
SharePoint User Guide

Select [Start] menu → [All Programs] → 
[KnowledgeLake] → [Scan to Microsoft 
SharePoint User Guide].

ScanSnap Manager
Help

Read this Help file when 
questions or problems 
regarding operations (e.g. 
when setting items) arise. 
This Help file explains about 
scanner operations, 
operational troubles and their 
resolution, dialog boxes/
windows and messages. 

Refer to this Help by either of the following 
methods:

Right-click the ScanSnap Manager icon 
 on the taskbar, and then select 

[Help] → [Help] from the menu that 
appears.
In Windows 7, the ScanSnap Manager 
icon  is displayed in the menu that 
appears when you click  on the 
taskbar.
Click the Help button ( ) for 
ScanSnap Manager.
Press the [F1] key on the keyboard when 
a dialog box is displayed.
Click the [Help] button in each dialog 
box.

Click the ScanSnap Manager icon  in 
the Dock while pressing the [control] key 
on the keyboard, and then select [Help] 
→ [Help] from the menu that appears.
Click the Help button ( ) for ScanSnap 
Manager.
From the menu bar, select [Help] → 
[ScanSnap Manager Help].

Manual Description Reference Method
5



Introduction
ScanSnap Organizer
Help

Read these Help files when 
questions or problems 
regarding operations (e.g. 
when setting items) arise. 
These Help files explain about 
operations, dialog boxes/
windows and messages.

For details about how to start up the Help, 
refer to the User's Guide for each product.

CardMinder Help

Cardiris Help From the menu bar, select [Help] → 
[Cardiris Help].

ABBYY FineReader for 
ScanSnap Help

From the menu bar, select [Help] → 
[FineReader for ScanSnap Help].

Manual Description Reference Method
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Introduction
■ About This Manual

Structure of This Manual

This manual consists of the following:

ScanSnap Overview
This chapter explains about the features, the names and functions of the parts, 
system requirements, and basic operations of the ScanSnap.

Installing the Software
This chapter explains about the software bundled with the ScanSnap and how 
to install them. 

Using the ScanSnap (for Windows Users)/ Using the ScanSnap (for Mac OS 
Users)

This chapter explains how to perform a scan, change or save scan settings, 
add, change or delete profiles, as well as other various scanner functions.

Troubleshooting
This chapter provides references for resolving troubles such as removing 
jammed documents.

Daily Care
This chapter explains about the cleaning materials and how to clean the 
ScanSnap.

Appendix
This appendix explains how to update ScanSnap Manager, how to uninstall 
the software, about settings that differ by the scanning method, how to 
purchase/clean the Carrier Sheet and the ScanSnap installation specifications.

Read this manual in order starting from "ScanSnap Overview" through "Using the 
ScanSnap" for a better understanding of ScanSnap operations.
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Introduction
Symbols Used in This Manual

The following indications are used in this manual to obviate any chance of accident or 
damage to you and people near you, and your property. Warning labels indicate the warning 
level and statements. The symbols indicating warning levels and their meanings are as 
follows.

Besides warning indicators, the following symbols are also used in this manual.

Arrow Symbols in This Manual

Right-arrow symbols (→) are used to connect icons or menu options you should select in 
succession.

Example: Select [Start] menu → [Computer].

Indication Description

WARNING
This indication alerts operators to an operation that, if not 
strictly observed, may result in severe injury or death.

CAUTION
This indication alerts operators to an operation that, if not 
strictly observed, may result in safety hazards to personnel or 
damage to the product. 

Symbol Description

This symbol alerts operators to particularly important information. 
Be sure to read this information.

This symbol alerts operators to helpful advice regarding operations.

This symbol indicates operations using Windows.

This symbol indicates operations using Mac OS.
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Screen Examples in This Manual

Windows screen
Screenshots in this manual are used according to guidelines provided by Microsoft 
Corporation.
The screenshots used in this manual are of Windows Vista.
The actual windows and operations may differ depending on the operating system that you 
are using.

Mac OS screen
The screenshots used in this manual are of Mac OS X v10.6.
The actual windows and operations may differ depending on the Mac OS that you are using.

The screen examples in this manual are subject to change without notice in the interest of 
product development. 
If the actual screen differs from the screen examples in this manual, operate by following the 
actual displayed screen.
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Introduction
Abbreviations Used in This Manual

The following abbreviations are used in this manual: 

Windows 7 : Windows® 7 Starter operating system, English Version
Windows® 7 Home Premium operating system, English Version
Windows® 7 Professional operating system, English Version
Windows® 7 Enterprise operating system, English Version
Windows® 7 Ultimate operating system, English Version

Windows Vista : Windows Vista® Home Basic operating system, English Version
Windows Vista® Home Premium operating system, English Version
Windows Vista® Business operating system, English Version
Windows Vista® Enterprise operating system, English Version
Windows Vista® Ultimate operating system, English Version

Windows XP : Windows® XP Home Edition operating system, English Version
Windows® XP Professional operating system, English Version

Windows : Windows 7, Windows Vista or Windows XP operating system

Microsoft Office : Microsoft® Office

Word : Microsoft® Word 2010
Microsoft® Office Word 2007
Microsoft® Office Word 2003
Microsoft® Office Word 2002
Microsoft® Word for Mac 2011
Microsoft® Word 2008 for Mac
Microsoft® Word 2004 for Mac

Excel : Microsoft® Excel® 2010
Microsoft® Office Excel® 2007
Microsoft® Office Excel® 2003
Microsoft® Office Excel® 2002
Microsoft® Excel® for Mac 2011
Microsoft® Excel® 2008 for Mac
Microsoft® Excel® 2004 for Mac

PowerPoint : Microsoft® PowerPoint® 2010
Microsoft® Office PowerPoint® 2007
Microsoft® Office PowerPoint® 2003
Microsoft® Office PowerPoint® 2002

SharePoint : Microsoft® SharePoint® Server 2010, English Version
Microsoft® Office SharePoint® Server 2007, English Version
Microsoft® Office SharePoint® Portal Server 2003, English Version
Microsoft® SharePoint® Foundation 2010, English Version
Microsoft® Windows® SharePoint® Services 2.0/3.0, English Version

Office Live : Microsoft® Office Live

Internet Explorer : Windows® Internet Explorer®

Microsoft® Internet Explorer®

Windows Live Mail : Windows Live™ Mail

Windows Mail : Microsoft® Windows® Mail 
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Introduction
Outlook : Microsoft® Outlook® 2010
Microsoft® Office Outlook® 2007
Microsoft® Office Outlook® 2003

Outlook Express : Microsoft® Outlook® Express

Outlook for Mac : Microsoft® Outlook® for Mac

.NET Framework : Microsoft® .NET Framework

Entourage : Microsoft® Entourage®

Mac OS : Mac OS X v10.7
Mac OS X v10.6
Mac OS X v10.5
Mac OS X v10.4

Adobe Acrobat : Adobe® Acrobat®

Adobe Reader : Adobe® Reader®

ABBYY FineReader for 
ScanSnap

: ABBYY FineReader for ScanSnap™
All the descriptions in this manual assume the usage of ABBYY 
FineReader for ScanSnap bundled with the ScanSnap. Unless otherwise 
specified, the term ABBYY FineReader for ScanSnap refers to the ABBYY 
FineReader for ScanSnap bundled with the ScanSnap.
Note that ABBYY FineReader for ScanSnap may be upgraded without 
notice.
If the descriptions differ from the actual displayed screens, refer to ABBYY 
FineReader for ScanSnap Help.

Cardiris : Cardiris™ for ScanSnap

Google Docs : Google Docs™

ScanSnap : Color image scanner ScanSnap S1100

Carrier Sheet : ScanSnap Carrier Sheet
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ScanSnap Overview
This chapter explains about the features, part names and functions, system requirements, and 
basic operations of the ScanSnap.
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Features of the ScanSnap
Features of the ScanSnap

The main features of the ScanSnap are as follows:

Turn documents into digital data by just pressing the [Scan/Stop] button
By converting paper documents cluttering up your desk into PDF or JPEG files, you can 
conveniently view, edit, manage and archive the documents in your computer.

Speedy scanning
A4 or Letter size documents can be scanned at a speed of 7.5 seconds per page under 
the following conditions:

System requirements

Intel® Core™ 2 Duo  2.2 GHz or higher
Windows 7, Windows Vista or Windows XP operating system

Intel® Core™ 2 Duo  2.4 GHz or higher
Mac OS X v10.7, Mac OS X v10.6, Mac OS X v10.5 or Mac OS X v10.4

Scan setting (*)
When [Image quality] is set to [Automatic resolution], [Color mode] to [Auto color 
detection], [Compression rate] to [3], and other settings are in default

* : - Scanning speed may slow down in [B&W] (black & white) mode depending on the document. 
Example: Scanning color brochures in [B&W] mode (converting a color image to black & 
white)

- Scanning speed may slow down when [Correct skewed character strings automatically] and/
or [Allow automatic image rotation] is enabled.

Compact, lightweight and portable
Compact enough to place on your desktop next to your computer, the ScanSnap can be 
powered by a single USB cable. This allows you to carry it anywhere with your laptop 
and have the flexibility to use it in or outside the office.

The Quick Menu makes the operation easy even for beginners
The Quick Menu will allow you to start using the ScanSnap right away even if it is your 
first time. Simply press the [Scan/Stop] button on the scanner to scan your document, 
and then the Quick Menu will appear where you can select the action you want to 
perform.
18



Features of the ScanSnap
Automatically recognize color and black & white documents (Auto color 
detection)
The ScanSnap determines the color mode of each document, saves color documents in 
color, black & white documents in black & white, and black & white documents with 
photos or illustrations in grayscale. This function will optimize your PDF file size.

Scan documents without specifying paper size (Automatic page size 
detection)
Paper size is automatically recognized so that you do not need to change the paper size 
setting. The Carrier Sheet (sold separately) allows you to scan documents larger than 
A4/Letter size, photographs and clippings.

Scan various types of documents
The ScanSnap allows you to scan not only paper documents such as standard office 
paper, postcards, business cards, photographs or clippings but also plastic cards 
(including embossed ones) such as driver’s licences or ID cards.

Automatically set the resolution by the paper size (Automatic resolution 
function)
Documents are scanned at 300 dpi at first, then the image is saved at 300 dpi if the 
document length is 148 mm (5.83 in.) or less, and converted to 200 dpi for longer 
documents. When linked with a text recognition application (e.g. for scanning business 
cards), you can save high resolution image data without having to change the scan 
settings. 

Create searchable PDF files
You can create searchable PDF files by performing automatic text recognition for PDF 
files after scanning.
You can also perform text recognition on character strings marked by a highlight pen in 
black & white documents, and add them as keywords for the PDF file.

E-mail or print a scanned image directly from scanning
You can attach the scanned image to an e-mail without needing any additional 
application or print it out instead of using a copy machine.

Compatible with both Windows and Mac OS
You can use the ScanSnap in a manner that best suits your office environment in either 
Windows or Mac OS (*).

* : The following functions are not available for Mac OS:
• Color high compression
• Setting passwords for PDF files

Convert paper documents into Word/Excel/PowerPoint files
Use the bundled "ABBYY FineReader for ScanSnap" to directly convert the scanned 
image into a Word/Excel/PowerPoint file.
In Mac OS, only conversion to Word and Excel files is supported.
19



Features of the ScanSnap
Organize and manage scanned images by linking with ScanSnap 
Organizer 

Setting a keyword (Intelligent Indexing)
Keywords can be set by the following methods: 
- Recognize a character string on a page (OCR) and set as a keyword (Zone OCR)
- Set any character string as a keyword
- Set a marked character string as a keyword (Marker Index)
- Drag and drop a keyword from the keyword list (Keyword Addition by Drag&Drop)
The keywords can be viewed in thumbnails. (Keyword Overlay)
Distributing files by keyword (Automatic Keyword Sort)
Files can also be sorted into folders according to the keyword set for files as a sorting 
condition.
Search a variety of files (Search Engine Selection)
Files can be found quickly searched by file name, keyword, text or date.
Cropping marked sections (Intelligent Cropping)
Selections on a page that are marked with a highlight pen can be cut and pasted 
elsewhere to create scrapbooks.

Easy filing of business cards
Text recognition can be performed on business cards which then can be easily 
converted into digital data with the bundled business card application. With CardMinder, 
you can create a database which facilitates data search of business cards converted 
into digital data.
The bundled business card application is as follows:

 CardMinder

 Cardiris

Share documents converted into digital data with others 
You can conveniently share documents by saving the scanned image directly in 
SharePoint or Office Live.

 Access documents converted into digital data anytime, anywhere
Through linkage with Evernote, Google Docs, Salesforce Chatter or SugarSync, you 
can access scanned images anytime from your computer or smartphone no matter 
where you are.

 Save documents converted into digital data to a mobile device
Scanned image can be saved directly to a mobile device such as tablet devices and 
smartphones.

Two separate scanned images can be merged into a single image
Two scanned images can be merged into a single image either vertically or horizontally.

Note: The ScanSnap does not conform to the TWAIN, ISIS and WIA standards.
20



Parts and Functions
Parts and Functions

This section explains names and functions of the ScanSnap parts.

■ Front

Feed guide
Open to use the ScanSnap.

Opening the feed guide turns on the ScanSnap.

[Scan/Stop] button
Press this button to start or finish scanning.
It indicates the status of the ScanSnap as follows:
Blue (lit) : Ready
Blue (flashing) : Scanning
Orange (flashing) : Error

Feed guide
You can load the document here after opening it.

Top cover
Open to remove jammed documents or clean the 
inside of the ScanSnap.
For details about how to clean the inside of the 
ScanSnap, refer to  "Cleaning the Inside of the 
ScanSnap" (page 423).

Output guide
For details, refer to  "Output Guide" (page 22).

Feeding section
Insert the document here to load.
21



Parts and Functions
■ Side

■ Output Guide

Tape seal
Remove this tape seal after installing the software.

USB connector

Output guide
Open the output guide to eject documents from the 
front of the ScanSnap.
Select an ejection method depending on the 
document type you are scanning.
For details about the documents that can be 
scanned with the ScanSnap, refer to "Documents 
for Scanning" (page 28).

When the output guide is closed

When the output guide is open
22



System Requirements
System Requirements

The system requirements for the ScanSnap are as follows:

■ Windows

*1: Service Pack 1 or later required
*2: Service Pack 3 or later required
*3: When the font size is large, some screens may not be displayed properly.
      In that case, use a smaller font size.
*4: When using a USB 3.0 port, data is transferred at the same speed as USB 2.0. 

Operating system Windows 7
(32 bit/64 bit)

Windows Vista (*1)
(32 bit/64 bit)

Windows XP (*2)
(32 bit)

CPU Intel® Core™ 2 Duo  2.2 GHz or higher recommended 
 (minimum: Intel® Pentium® 4  1.8 GHz)

Memory 32 bit: 1 GB or more
64 bit: 2 GB or more 512 MB or more (1 GB or more recommended)

Display 
resolution 800 × 600 pixels or higher (*3)

Hard disk space

Disk space required to install the software bundled with the ScanSnap is as follows:
ScanSnap Manager: 530 MB
ScanSnap Organizer: 620 MB
CardMinder: 280 MB
ABBYY FineReader for ScanSnap: 600 MB
Evernote for Windows: 150 MB
Scan to Microsoft SharePoint: 40 MB

USB port (*4) USB2.0/USB1.1

For Windows Vista or Windows XP, .NET Framework 3.5 SP1 may be installed (maximum of 
500 MB free disk space required) at the same time as ScanSnap Manager, ScanSnap 
Organizer, or CardMinder.
23



System Requirements
The following shows the estimated file size when scanning one side of a color 
document.

Do not use the USB port on the keyboard or the monitor to connect the ScanSnap (it may not 
function properly).
Make sure to use a powered hub equipped with an AC adapter if you are using a 
commercially available USB hub.
If the USB port or the USB hub is USB 1.1, scanning speed will slow down.
If the CPU or the memory does not meet the required specifications, scanning speed will 
slow down.
The actual increase in used disk space after installation and the required disk space for 
installation may differ from each other depending on your Windows system disk 
management.
A disk space approximately three times larger than the resulting scanned file size is required 
when scanning documents.
If the characters are not displayed correctly when you use CardMinder, Scan to Mobile or 
Scan to Salesforce Chatter, perform the following:
- Windows XP

Select [Control Panel] → [Regional and Language Options] → [Languages] tab → 
[Install files for East Asian languages] check box.
Install the universal font (Arial Unicode MS) from the setup disc for Microsoft Office 
2000 or later.

- Windows Vista or Windows 7
Install the universal font (Arial Unicode MS) from the setup disc for Microsoft Office 2003 
or later.

File format Compression rate Paper size 

PDF 3 A4 (catalog)

Estimated image data size (KB)

Color mode Automatic 
resolution Normal Better Best Excellent

Color 413.6 275.7 427.7 877.9 3231.1

Gray 367.9 260.5 403.9 746.9 2729.1

B&W 172.4 120.2 174.0 362.0 2048.4

Color high compression 224.3 168.8 240.0 165.3 —
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System Requirements
■ Mac OS

*1: It is recommended to apply the latest updates to the Mac OS.
*2: Evernote for Mac is not supported for versions earlier than Mac OS X v.10.5.8.
*3: When using a USB 3.0 port, data is transferred at the same speed as USB 2.0.

Operating system (*1) Mac OS X v10.7 Mac OS X v10.6 Mac OS X v10.5 Mac OS X v10.4 
(*2)

CPU Intel® Core™ 2 Duo  2.4 GHz or higher recommended
(minimum: Intel® Core™ Duo  1.83 GHz or PowerPC® G5  1.6 GHz)

Memory 2 GB or more 1 GB or more 512 MB or more (1 GB or more recom-
mended)

Display resolution 1024 × 768 pixels or higher

Hard disk space Disk space required to install the software bundled with the ScanSnap is as 
follows:

ScanSnap Manager: 800 MB
ABBYY FineReader for ScanSnap: 570 MB
Cardiris: 130 MB
Evernote for Mac: 55 MB

USB port (*3) USB2.0/USB1.1

Do not use the USB port on the keyboard or the monitor to connect the ScanSnap (it may not 
function properly).
Make sure to use a powered hub equipped with an AC adapter if you are using a 
commercially available USB hub.
If the USB port or the USB hub is USB 1.1, scanning speed will slow down.
If the CPU or the memory do not meet the required specifications, scanning speed will slow 
down.
A disk space approximately three times larger than the resulting scanned file size is required 
when scanning documents.
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System Requirements
The following shows the estimated file size when scanning one side of a color 
document.

File format Compression rate Paper size 

PDF 3 A4 (catalog)

Estimated image data size (KB)

Color mode Automatic 
resolution Normal Better Best Excellent

Color 413.6 275.7 427.7 877.9 3231.1

Gray 367.9 260.5 403.9 746.9 2729.1

B&W 172.4 120.2 174.0 362.0 2048.4
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Turning the ScanSnap ON/OFF
Turning the ScanSnap ON/OFF

This section explains how to turn the ScanSnap ON/OFF.
The ScanSnap is turned ON/OFF in conjunction with the computer. Therefore, you do not 
have to worry about turning the power ON/OFF as long as the ScanSnap is connected to a 
computer.

Turning the ScanSnap on
Open the feed guide when the computer is turned on.
The [Scan/Stop] button flashes blue to indicate that the ScanSnap is turned on, and 
lights in blue when the ScanSnap is ready to scan.

 Turning the ScanSnap off
Turn off the computer or close the feed guide.
The [Scan/Stop] button switches off when the ScanSnap is turned off.

ScanSnap in sleep mode
When the ScanSnap has not been in operation for one minute while the power is on, it 
enters sleep (power saving) mode.
The ScanSnap’s internal light switches off in sleep mode.

With some computers, the initialization of the ScanSnap may be performed several 
times when the computer is started up.

With some computers, it may take two to three minutes until the light of the [Scan/Stop] 
button goes out after the computer is turned off.
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Documents for Scanning

This section explains about the documents that can be scanned with the ScanSnap.

■ Conditions for Documents That Can Be Scanned

Conditions for documents that can be scanned with the ScanSnap are as follows:

*1: For details about how to eject documents, refer to "Output Guide" (page 22).
*2: Scanning starts when you hold down the [Scan/Stop] button on the ScanSnap for 3 seconds or 

longer.

Eject method (*1) With the output guide open With the output guide closed

Paper type
Standard office paper Standard office paper, postcards, business cards

Cards conforming to the ISO7810 ID-1 Type 
standard (54 × 86 mm)

Paper weight

52.3 to 80 g/m² (14 to 20 lb) 52.3 to 209.3 g/m² (14 to 56.1 lb)

Plastic cards
0.76 mm (embossed cards are supported)

Paper size
Width : 25.4 to 216 mm (1 to 8.5 in.)
Length : 25.4 to 360 mm (1 to 14.17 in.)
Maximum size for long page scanning (*2): 216 × 863 (mm) / 8.5 × 34 (in.) 
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Documents for Scanning
When you scan documents written in pencil, there may be black traces left on them. It is 
recommended that you scan such documents by using the Carrier Sheet. Clean the rollers as 
often as possible when you scan such documents directly without using a Carrier Sheet 
because dirt accumulating on the rollers may cause feeding errors.
For details about how to clean the inside of the ScanSnap, refer to  "Cleaning the Inside of 
the ScanSnap" (page 423).
The following types of documents must not be scanned:
- Paper-clipped or stapled documents (remove the paper clips and staples for scanning)
- Documents on which the ink is still wet (wait until the ink dries completely to scan these 

documents)
- Documents larger than 216 × 863 (mm) / 8.5 × 34 (in.) (width x length)
- Documents other than paper such as fabric, metal foil and OHP film

Be aware that picture side of postcards may get damaged when you scan picture postcards.
Cards that are bent may not be fed properly. 
If the surface of the card is dirty with grease marks (e.g. fingerprints) and such, perform 
scanning after wiping the dirt off.
Insert the plastic card straight into the feeding section of the ScanSnap. Do not tilt the plastic 
card when you insert it because the plastic card may not be fed properly.
When you scan plastic cards with strong luster, some parts of the image may appear lighter 
or darker than the original.
e.g. gold colored credit card
Insert embossed cards in landscape orientation to achieve better scanning results.
If the background color of the card and the color of the embossed characters are similar (e.g. 
no gold or silver embossing), it may be difficult for the ScanSnap to recognize embossed 
characters. In that case, click the [Option] button in the [Scanning] tab of the ScanSnap setup 
dialog box, and select the [Setting for text only document] check box for a possible resolution.
Scanning the following types of documents without using the Carrier Sheet can result in 
documents being damaged or scanned incorrectly. It is recommended that you use the 
Carrier Sheet to scan them.
- Documents smaller than 25.4 × 25.4 (mm) / 1 × 1 (in.) (width × length)
- Documents whose paper weight is less than 52.3 g/m² (17 lb)
- Documents of non-uniform thickness (e.g. envelopes and paper sheets with attached 

materials)
- Wrinkled or curled documents
- Folded or torn documents
- Tracing paper
- Coated paper
- Photographs (photographic paper)
- Perforated or punched documents
- Odd shaped documents (not square or rectangular)
- Carbon paper or thermal paper
- Documents with memo papers or sticky notes attached

Since carbonless paper may contain chemicals that can harm the rollers, take note of the 
following when scanning carbonless paper:
- It is recommended that you use the Carrier Sheet to scan such documents.
- Make sure to clean the rollers regularly to maintain the scanner performance when 

scanning carbonless paper directly without using the Carrier Sheet. Depending on the 
type of carbonless paper, the life span of the scanner may be shortened compared to 
scanning standard office paper.
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Documents for Scanning
■ Conditions for Using the Carrier Sheet

The Carrier Sheet (sold separately) is a sheet designed to transport documents through the 
ScanSnap.
You can scan documents that are larger than A4/Letter size, photographs and clippings.
Conditions for documents that can be scanned using the optional Carrier Sheet are as follows:

CAUTION

Do not use a damaged Carrier Sheet because it may damage or cause the scanner to 
malfunction.
Be careful not to cut your finger on the edge of the Carrier Sheet.

*1: For details about how to eject documents, refer to "Output Guide" (page 22).
*2: Fold in half to scan.

Eject method (*1) With the output guide closed

Paper type Documents that cannot be fed directly into the ScanSnap

Paper weight Up to 127 g/m² (up to 34 lb)
Up to 63.5 g/m² (17 lb) (when scanning documents folded in half)

Paper size

Carrier Sheet size (216 × 297 mm)
A3 (297 × 420 mm) (*2)
A4 (210 × 297 mm)
A5 (148 × 210 mm)
A6 (105 × 148 mm)
B4 (257 × 364mm) (*2)
B5 (JIS) (182 × 257 mm)
B6 (JIS) (128 × 182 mm)
Post card (100 × 148 mm)
Business card (90 × 55 mm, 55 × 90 mm)
Letter (8.5 × 11 in. (216 × 279.4 mm))
11 × 17 in (279.4 × 431.8 mm) (*2)
Custom size

Width : 25.4 to 216 mm (1 to 8.5 in.)
Length : 25.4 to 297 mm (1 to 11.69 in.)

Do not stain, or cut the end with a black & white pattern because the Carrier Sheet will not be 
recognized properly.
Do not place the Carrier Sheet upside down. Otherwise, a paper jam may occur and damage 
the Carrier Sheet and the document inside.
Do not leave your document inside the Carrier Sheet for a long time. Otherwise, the ink on 
the document may be transferred onto the Carrier Sheet.
To avoid deformation, do not use or leave the Carrier Sheet in high temperature places such 
as under direct sunlight or near a heating apparatus for a long time.
Do not fold or pull the Carrier Sheet.
To avoid deformation, store the Carrier Sheet on a flat surface without any weight on it.
Paper jams may occur when several small size documents such as photographs and 
postcards are placed inside the Carrier Sheet to be scanned at once. It is recommended that 
you scan such documents one at a time.
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How to Load Documents

Load a document in the ScanSnap in the following procedure.
For details about documents that can be loaded, refer to  "Documents for Scanning" (page 
28).

1. Open the feed guide of the ScanSnap.

You can only load one document at a time in the ScanSnap.

If you want the document to be ejected from the front of the ScanSnap or when there is 
not enough space where the document exits the ScanSnap, open the output guide. 
For details about documents that can be scanned with the output guide open, refer to 
"Documents for Scanning" (page 28).

How the document is ejected differs as below depending on whether the output guide is 
open or closed.

Feed guide

Output guide

With the output guide closed With the output guide open
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How to Load Documents
2. Insert the document straight into the feeding section of the ScanSnap, 
with the scanning side facing up.

The document is pulled in until it is set inside the ScanSnap.

Insert the document by aligning it with the left edge of 
the feeding section if you specify a standard size 
other than [Automatic detection] which is the default 
paper size.
For details about how to change the scan settings, 
refer to the following:

For Windows (→ page 82)
For Mac OS (→ page 273)

When you perform scanning with the output guide closed, leave enough space at the 
back of the ScanSnap to allow the document to be completely ejected. Make sure that 
the area where the document exits the scanner is clear of any obstacles. Otherwise, 
paper jam may occur.
If you scan the following documents with the output 
guide open, a paper jam may occur and damage the 
documents. Scan the following documents with the 
output guide closed.
- Thick paper (80 g/m² (20 lb) or heavier)
- Postcards
- Business cards
- Plastic cards
- Carrier Sheet 

Output guide
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Scanning Operation Flow
Scanning Operation Flow

This section explains the flow of operations for scanning documents.
You can scan documents in two different ways. Choose either way depending on your 
intended use. 

Using the Quick Menu
With the Quick Menu, even the first time users can easily use each ScanSnap function 
by following the instructions on the screen and perform scanning.
After scanning, select an application to link with ScanSnap Manager in the Quick Menu.
For details about how to perform scanning using the Quick Menu, refer to the following:

For Windows (→ page 67)
For Mac OS (→ page 260)

Without Using the Quick Menu
You can perform scanning by using predefined scan settings.
Before you perform scanning, select a profile which is already configured with an 
application to link with ScanSnap Manager. Documents are scanned according to the 
scan settings of the selected profile.
For details about how to perform scanning without using the Quick Menu, refer to the 
following:

For Windows (→ page 73)
For Mac OS (→ page 265)

Specify whether or not to use the Quick Menu by selecting or clearing the [Use Quick Menu] 
check box in the ScanSnap setup dialog box/window.
Display the ScanSnap setup dialog box/window in the following procedure:

Right-click the ScanSnap Manager icon  on the taskbar, and select [Scan Button Settings].
In Windows 7, the ScanSnap Manager icon  is displayed in the menu which appears when 
you click  on the taskbar.

Click the ScanSnap Manager icon  in the Dock while pressing the [control] key on the 
keyboard, and select [Settings]. 
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Scanning Operation Flow
1 2

3

4

Without Using the Quick MenuUsing the Quick Menu

The selected application starts up.

Select a profile

Turn on the ScanSnap.(→ page 27)

1. Load a document in the ScanSnap.
You can only load one document at a time.

Documents for scanning (→ page 28)
How to load documents (→ page 31)

2. Press the [Scan/Stop] button to start scanning.

3. To continue scanning, load the next document 
after confirming that the current document has 
been ejected. Scanning starts automatically when 
the next document is loaded.
The [Scan/Stop] button flashes in blue throughout 
the scan.

4. Press the [Scan/Stop] button to finish scanning 
when scanning is completed.

Select an application from the Quick Menu.
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Installing the Software
This chapter explains about the software bundled with the ScanSnap and how to install them. 

Bundled Software Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Installing in Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Installing in Mac OS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
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Bundled Software Overview
Bundled Software Overview

This section gives an overview of each bundled software and their functions. You can edit, 
manage and arrange the scanned image by using the following software:

ScanSnap Manager 
This scanner driver is required to scan documents with the ScanSnap. The scanned 
image can be saved as a PDF or JPEG file.
You need to have ScanSnap Connect Application installed on your mobile device to 
save PDF or JPEG files to your mobile device.
You can download ScanSnap Connect Application for mobile devices from the App 
Market.

ScanSnap Organizer
You can use this application to display image data (PDF or JPEG files) without opening 
them, create folders and arrange files as you like.

CardMinder
You can use this application to efficiently digitalize a large number of business cards.
Text recognition can be performed on business cards and you can create a database to 
facilitate card data management and searches.

Cardiris
You can use this application to efficiently digitalize a large number of business cards by 
performing text recognition on them.

ABBYY FineReader for ScanSnap 
This application can perform text recognition on the scanned images using OCR 
(Optical Character Recognition) and convert the image data to Word, Excel or 
PowerPoint files that can be edited.
In Mac OS, only conversion to Word and Excel files is supported.

Evernote for Windows  / Evernote for Mac
You can easily save files in Evernote using the ScanSnap.

Scan to Microsoft SharePoint
You can easily save files in SharePoint and Office Live using the ScanSnap.

Rack2-Filer V5.0 Trial Version
This application provides integrated management of digitalized paper documents 
(electronic documents) and digital data created with computer, as if you are filing paper 
documents in actual binders. For details about the languages supported in Rack2-Filer, 
refer to Rack2-Filer "Readme".
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Bundled Software Overview
You can download the following software from the Setup DVD-ROM.

SugarSync Manager for Windows  / SugarSync Manager for 
Mac
You can easily save files to your SugarSync folder using the ScanSnap.
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Installing in Windows

This section explains how to install the software in Windows.

■ How to Install the Software

When you insert the Setup DVD-ROM into the DVD-ROM drive on your computer, the 
[ScanSnap Setup] dialog box appears.

The functions of each button in the [ScanSnap Setup] dialog box are as follows.

Button Function

Readme Displays the [Readme] dialog box where you can refer to the Readme file of 
each software.

Install Products Displays the [Install Products] dialog box.
[ScanSnap] button
Installs the following software:
- ScanSnap Manager
- ScanSnap Organizer
- CardMinder
- ABBYY FineReader for ScanSnap

[Evernote] button
Installs Evernote for Windows.
[SugarSync] button
Opens the SugarSync Manager for Windows download web page.
[Scan to Microsoft SharePoint] button
Installs Scan to Microsoft SharePoint.
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Installing in Windows
Manuals Displays the [Manuals] dialog box where you can refer to the software manuals 
including "Troubleshooting (installation)".

Browse DVD Contents Opens Windows Explorer to display the files from the DVD-ROM.

Contact Us Displays contact information for customer support.

Trial Software Displays the [Trial Software] dialog box from which you can install the trial 
version software.

Button Function
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Installing in Windows
■ ScanSnap Software

Install the following software:
ScanSnap Manager
ScanSnap Organizer
CardMinder
ABBYY FineReader for ScanSnap

The procedure is as follows.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap Setup] dialog box appears.

3. Click the [Install Products] button.

The [Install Products] dialog box appears.

If the [ScanSnap Setup] dialog box does not appear, double-click "ScanSnap.exe" in the 
Setup DVD-ROM via Windows Explorer.
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Installing in Windows
4. Click the [ScanSnap] button.

The [ScanSnap] dialog box appears, displaying the [Welcome to the InstallShield 
Wizard for ScanSnap] screen.

5. Click the [Next] button.

The [ScanSnap Setup] dialog box appears.

6. Read the message about anti-virus software, and click the [OK] button.

The [Select Features] screen appears.
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Installing in Windows
7. Confirm the check boxes of the software that you want to install are 
selected, and click the [Next] button.

The [Choose Destination Location] screen appears.

8. Confirm the destination folder, and then click the [Next] button.

A confirmation about accepting the license agreement appears.

9. Read the "END-USER LICENSE AGREEMENT", select [I accept the 
terms of the license agreement], and then click the [Next] button.

The [Start Copying Files] screen appears.

10.Confirm the settings, and then click the [Next] button.

Installation starts. When the installation is complete, the [ScanSnap S1100 How to 
load a document (1/2)] screen appears.

The software will not be installed unless the check box is selected.
Note that you must install ScanSnap Manager. Also, it is recommended to install all 
software in order to utilize the features of the ScanSnap.

Depending on the number of the installed software, this step may be required more than 
once.
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Installing in Windows
11.Read the instructions, and click the [Next] button.

The [ScanSnap S1100 How to load a document (2/2)] screen appears.

12.Read the instructions, and click the [Next] button.

The [InstallShield Wizard Complete] screen appears.

13.Click the [Finish] button.

14.Remove the Setup DVD-ROM from the DVD-ROM drive.

If the installation is not successfully completed, select [Manuals] → [Troubleshooting 
(installation)] in the [ScanSnap Setup] dialog box and refer to Troubleshooting (installation).
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Installing in Windows
■ Evernote for Windows

Install Evernote for Windows in the following procedure.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap Setup] dialog box appears.

3. Click the [Install Products] button.

The [Install Products] dialog box appears.

If the [ScanSnap Setup] dialog box does not appear, double-click "ScanSnap.exe" in the 
Setup DVD-ROM via Windows Explorer.
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Installing in Windows
4. Click the [Evernote] button.

Installation starts.

5. Follow the instructions on the screen to complete the installation.

6. Click the [Finish] button when the installation complete notification is 
displayed.

7. Remove the Setup DVD-ROM from the DVD-ROM drive.
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Installing in Windows
■ SugarSync Manager for Windows

The procedure is as follows.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap Setup] dialog box appears.

3. Click the [Install Products] button.

The [Install Products] dialog box appears.

An Internet connection is required to install SugarSync Manager for Windows.

If the [ScanSnap Setup] dialog box does not appear, double-click "ScanSnap.exe" in the 
Setup DVD-ROM via Windows Explorer.
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Installing in Windows
4. Click the [SugarSync] button.

A web browser starts up and the SugarSync Manager for Windows download web 
page opens.
Download and install SugarSync Manager for Windows.

5. When the installation is complete, remove the Setup DVD-ROM from the 
DVD-ROM drive.
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Installing in Windows
■ Scan to Microsoft SharePoint

Install Scan to Microsoft SharePoint in the following procedure.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap Setup] dialog box appears.

3. Click the [Install Products] button.

The [Install Products] dialog box appears.

For details about system requirements and notes on installation, refer to "Readme" of Scan to 
Microsoft SharePoint. Click the [Readme] button in the [Scan to Microsoft SharePoint] dialog 
box to open the Readme file.

If the [ScanSnap Setup] dialog box does not appear, double-click "ScanSnap.exe" in the 
Setup DVD-ROM via Windows Explorer.
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Installing in Windows
4. Click the [Scan to Microsoft SharePoint] button.

Installation starts.

5. Follow the instructions on the screen to complete the installation.

6. Click the [Close] button when the installation complete notification is 
displayed.

7. Remove the Setup DVD-ROM from the DVD-ROM drive.

For details about how to use Scan to Microsoft SharePoint, refer to the Scan to Microsoft 
SharePoint User Guide. Click the [Scan to Microsoft SharePoint] button in the [Manuals] dialog 
box to open the Scan to Microsoft SharePoint User Guide.
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Installing in Windows
■ Trial Software

Install the trial versions of the software in the following procedure.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap Setup] dialog box appears.

3. Click the [Trial Software] button.

The [Trial Software] dialog box appears.

For details about system requirements and installation, refer to "Readme" of the trial version 
software. Click on the name of the software in the [Trial Software] dialog box, then click the 
[Readme] button to open the Readme file.

If the [ScanSnap Setup] dialog box does not appear, double-click "ScanSnap.exe" in the 
Setup DVD-ROM via Windows Explorer.
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Installing in Windows
4. Click the button of the trial software you want to install.

The setup dialog box of the trial software appears (e.g. [Rack2-Filer Setup]).

5. Click the [Install Product] button.

Installation starts.

6. Follow the instructions on the screen to complete the installation.

7. Click the [Finish] button when the installation complete notification is 
displayed.

8. Remove the Setup DVD-ROM from the DVD-ROM drive.

For details about how to use trial versions of the software, refer to the software manual. Click 
the [Manuals] button in the setup dialog box of the trial software to open the manual.
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Installing in Mac OS

This section explains how to install software in Mac OS.

■ How to Install the Software

When you insert the Setup DVD-ROM into the DVD-ROM drive on your computer, the 
[ScanSnap] window appears.

The functions of each icon in the [ScanSnap] window are as follows.

Icon Function

ScanSnap Installs the following software:
ScanSnap Manager
ABBYY FineReader for ScanSnap
Cardiris

Other Software Displays the [Other Software] window.
[Evernote] icon
Installs Evernote for Mac.
[SugarSync] icon
Opens the SugarSync Manager for Mac download web page.

Readme Displays the Readme file.

Troubleshooting (installation) Displays "Troubleshooting (installation)".

Operator's Guide Displays this manual.
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Installing in Mac OS
■ ScanSnap Software

Install the following software:
ScanSnap Manager
ABBYY FineReader for ScanSnap
Cardiris

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap] window appears.

3. Double-click the [ScanSnap] icon.

A confirmation message appears to proceed with the installation.
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Installing in Mac OS
4. Click the [Continue] button.

The [Install ScanSnap] window appears, displaying the [Welcome to the ScanSnap 
Installer] screen.

5. Click the [Continue] button.

The [Important Information] screen appears.

6. Read [Important Information], and then click the [Continue] button.

The [Software License Agreement] screen appears.

7. Read the "END-USER LICENSE AGREEMENT", and click the [Continue] 
button.

A confirmation about accepting the license agreement appears.

8. To accept the license agreement, click the [Agree] button.

The [Cardiris License] screen appears.

9. Scroll down and read the "I.R.I.S. License Agreement" to the end, and 
then click the [Continue] button.

A confirmation message appears.
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Installing in Mac OS
10.To accept the license agreement, click the [Agree] button.

The [Standard Install on "disk name"] screen appears.

11.Click the [Install] button.

An authentication window appears.

12.Enter the user name and password for a user with Administrator 
privileges, and click the [OK] button.

Installation starts. When the installation is complete, the [ScanSnap S1100 How to 
load a document 1] screen appears.

To install only ScanSnap Manager, clear the [ABBYY FineReader for ScanSnap] and 
[Cardiris] checkboxes in the [Custom install on "disk name"] screen which is displayed 
by clicking the [Customize] button.
ABBYY FineReader for ScanSnap or Cardiris cannot be installed on its own.
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Installing in Mac OS
13.Read the instructions and click the [Continue] button.

The [ScanSnap S1100 How to load a document 2] screen appears.

14.Read the instructions and click the [Continue] button.

The [The installation was completed successfully.] screen appears.

15.Click the [Close] button.

16.Remove the Setup DVD-ROM from the DVD-ROM drive.
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■ Evernote for Mac

Install Evernote for Mac in the following procedure.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap] window appears.

3. Double-click the [Other Software] icon.

The [Other Software] window appears.
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Installing in Mac OS
4. Double-click the [Evernote] icon.

A confirmation about accepting the license agreement appears.

5. To accept the license agreement, click the [Agree] button.

A window to start installing Evernote for Mac appears.
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Installing in Mac OS
6. Drag the [Evernote] icon onto the [Applications] icon.

Evernote for Mac is copied into the [Applications] folder.

7. When the copying is finished, drag the Evernote icon on the desktop into 
the Trash.

8. Remove the Setup DVD-ROM from the DVD-ROM drive.

9. Prepare for the linkage with Evernote.

Start up Evernote and create a new Notebook.

If the installation is not successfully completed, select [Troubleshooting (installation)] in the 
[ScanSnap] window and refer to Troubleshooting (installation).
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■ SugarSync Manager for Mac

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges. 

2. Insert the Setup DVD-ROM into the DVD-ROM drive.

The [ScanSnap] window appears.

3. Double-click the [Other Software] icon.

The [Other Software] window appears.

An Internet connection is required to install SugarSync Manager for Mac.
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4. Double-click the [SugarSync] icon.

A web browser starts up and the SugarSync Manager for Mac download web page 
opens.
Download and install SugarSync Manager for Mac.

5. When the installation is complete, remove the Setup DVD-ROM from the 
DVD-ROM drive.
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This chapter explains how to perform scanning, configure scan settings, add, change or 
delete profiles, as well as various scanner functions and uses.

ScanSnap Manager Icon and Operations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
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Using the ScanSnap in Various Ways . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 219
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ScanSnap Manager Icon and Operations

All operations on the ScanSnap are managed by ScanSnap Manager.
The ScanSnap Manager icon automatically appears on the taskbar when Windows starts up.
The ScanSnap Manager icon indicates whether or not ScanSnap Manager is successfully 
communicating with the ScanSnap. The appearance of the icon changes according to the 
communication status as shown below.

A menu is displayed when you click the ScanSnap Manager icon.

Status ScanSnap Manager icon

Communicating

Not communicating

In Windows 7, the ScanSnap Manager icon  is displayed in the menu which appears when 
you click  on the taskbar.
To have the ScanSnap Manager icon  always displayed on the taskbar, drag the icon  and 
drop it onto the taskbar. 
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■ Right-Click Menu

This menu appears when you right-click the ScanSnap Manager icon .

Item Function

Scan Starts scanning. Follows the settings configured in [Scan Button Settings].

Scan Button Settings Displays the ScanSnap setup dialog box.
You can configure the scan settings in this dialog box.

 "How to Configure Scan Settings" (page 82)

Profile Management Displays the [ScanSnap Manager - Profile Management] dialog box.
You cannot select [Profile Management] when the [Use Quick Menu] check 
box is selected in the ScanSnap setup dialog box.

 "Profile Management" (page 85)

Show scanning results After scanning is completed, a message appears to inform you whether blank 
pages are removed or the image is rotated.

Help Displays the following menu: 
Help
Opens the ScanSnap Manager Help.
Troubleshooting
Displays [Troubleshooting] in the ScanSnap Manager Help. 
ScanSnap Portal Site
Opens the ScanSnap global homepage (http://scansnap.fujitsu.com/).
About ScanSnap Manager
Displays the [Version Information] dialog box.
Preferences
Displays the [ScanSnap Manager - Preferences] dialog box.
Online Update
Displays the [ScanSnap Manager - Online Update] dialog box (page 428).

Exit Exits ScanSnap Manager.
 "Finishing ScanSnap Operation" (page 78)

Right-click
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■ Left-Click Menu

This menu appears when you click the ScanSnap Manager icon .
Available profiles are shown in the Left-Click Menu.

Select a profile in the Left-Click Menu before you perform scanning. Documents are scanned 
according to the scan settings of the profile you select.
For details about how to add, change or delete profiles, refer to "Profile Management" (page 
85).

To enable the Left-Click Menu, clear the [Use Quick Menu] check box in the ScanSnap setup 
dialog box. The Left-Click Menu does not appear when this check box is selected.
Profiles configured for the following scanner models will be carried over to ScanSnap S1100 
if the computer is the same:
- ScanSnap S1500
- ScanSnap S1500M
- ScanSnap S1300
- ScanSnap S510
- ScanSnap S500
- ScanSnap S300

Left-click

Left-Click Menu example
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How to Perform a Scan

This section explains how to perform scanning with the ScanSnap.

■ Preparation

1. Turn on the computer.

The ScanSnap Manager icon  appears on the taskbar when Windows starts up.

2. Open the feed guide of the ScanSnap to turn the power on.

The ScanSnap Manager icon changes from  to .

If the ScanSnap Manager icon  is not displayed, select [Start] menu → [All Pro-
grams] → [ScanSnap Manager] → [ScanSnap Manager] to start up ScanSnap Man-
ager. Normally, ScanSnap Manager is registered under [Startup] when installed so its 
icon  is displayed on the taskbar when Windows starts. 
When ScanSnap Manager is not registered under [Startup], register ScanSnap Man-
ager in the following procedure:
1. Select [Help] → [Preferences] in the Right-Click Menu. 

[ScanSnap Manager - Preferences] dialog box appears.
2. In the [Auto Startup] tab, select the [Start up ScanSnap Manager when you log on] 

check box.
In Windows 7, the ScanSnap Manager icon  is displayed in the menu which appears 
when you click  on the taskbar.
For details about how to display the ScanSnap Manager icon  on the taskbar, refer 
to "ScanSnap Manager Icon and Operations" (page 63).

There may be a slight delay before the ScanSnap Manager icon changes to  depending 
on your computer's performance, operating environment and load such as when multiple 
programs are running at the same time.

Feed guide
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There are two ways to perform scanning, either with the Quick Menu or without using the 
Quick Menu. For details, refer to the following:

Using the Quick Menu (→ page 67)

Without Using the Quick Menu (→ page 73)

■ Using the Quick Menu

The following explains the procedure for scanning by using the Quick Menu.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. Select the [Use Quick Menu] check box.

3. Click one of the profile buttons.

Profile Button Description

[Recommended] button Settings are [Automatic resolution] for [Image quality] in the [Scanning] 
tab in the ScanSnap setup dialog box and default for other settings.
It is recommended that you select this button when you want to scan 
documents in optimum quality suitable for the paper size of the 
document.

Profile Button
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4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

[Small File] button Settings are [Normal] (Color/Gray: 150 dpi, B&W: 300 dpi) for [Image 
quality] in the [Scanning] tab in the ScanSnap setup dialog box and 
default for other settings.
It is recommended that you select this button when you want to reduce 
the file size.

[High Quality] button Settings are [Best] (Color/Gray: 300 dpi, B&W: 600 dpi) for [Image 
quality] in the [Scanning] tab in the ScanSnap setup dialog box and 
default for other settings.
It is recommended that you select this button when you want to scan 
documents in high quality.

[Customize] button Default settings are the same as the [Recommended] settings.
Scan settings can be changed depending on your scanning purpose.

The [Recommended] button is selected in default.
For details about the default settings when using the Quick Menu, refer to the 
ScanSnap Manager Help.
You cannot change the settings for the [Recommended], [Small File], and [High Quality] 
buttons. If you change any of these settings, the profile automatically switches to [Cus-
tomize].
For details about how to change scan settings, refer to "How to Configure Scan 
Settings" (page 82).

Profile Button Description
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6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

The [ScanSnap Manager - Image scanning and file saving] dialog box appears.

After the scanning has completed, the [ScanSnap Manager - Image scanning and 
file saving] dialog box then shows a new message indicating that the ScanSnap is 
ready for the next scan. 

You can also start scanning from the Right-Click Menu.
For more details, refer to "Right-Click Menu" (page 64).

Do not connect or disconnect the ScanSnap and other USB devices during scanning.
Do not close the feed guide during scanning.
Do not switch users during scanning. Doing so will cancel scanning.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

8. In the Quick Menu, click the icon of the application to link with ScanSnap 
Manager.

The selected application is started.

You can also finish scanning by clicking the [Finish Scanning] button in the [ScanSnap 
Manager - Image scanning and file saving] dialog box.
The [Scan/Stop] button on the ScanSnap flashes in blue during the scan.

To specify which applications to display/hide in the Quick Menu, or change the display 
order of the applications, refer to  "Quick Menu Settings" (page 79).
To select an application to link with ScanSnap Manager before scanning, refer to "With-
out Using the Quick Menu" (page 73).

Application Description

Scan to ScanSnap 
Organizer (*1)

Displays the [ScanSnap Organizer] dialog box.
Scanned image is saved in a folder specified in ScanSnap Organizer.
For details about how to operate ScanSnap Organizer, refer to the 
ScanSnap Organizer User's Guide.

Scan to CardMinder (*2) Displays the [CardMinder] dialog box.
Scanned image is stored in CardMinder.
For details about how to continue the process after you select this 
item, refer to "Storing Business Cards in CardMinder" (page 144). 

Scan to Folder Displays the [Scan to Folder] dialog box.
You can specify the destination folder to save the scanned images.
For details about how to continue the process after you select this 
item, refer to "Saving Data in a Specified Folder" (page 103).
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Scan to E-mail Displays the [Scan to E-mail] dialog box.
Scanned image is attached to an e-mail message.
For details about how to continue the process after you select this 
item, refer to "Attaching Files to E-Mail" (page 110).

Scan to Print Displays the [Scan to Print] dialog box.
Scanned image can be printed.
For details about how to continue the process after you select this 
item, refer to "Using the ScanSnap as a Copy Machine" (page 122).

Scan to Rack2-Filer (*3) Scanned image is saved as a PDF file in a Rack2-Filer binder.
For details about how to continue the process after you select this 
item, refer to "Saving to Rack2-Filer" (page 160). 

Scan to Mobile (*4) Displays the [Scan to Mobile] dialog box.
Scanned image is saved to a mobile device.
For details about how to continue the process after you select this 
item, refer to  "Saving Data to a Mobile Device" (page 207)".

Scan to Evernote 
(Document) (*5)

Scanned image is saved as a PDF file in Evernote.
For details about how to continue the process after you select this 
item, refer to "Saving Documents to Evernote" (page 167).

Scan to Evernote (Note) 
(*5)

Scanned image is saved as a JPEG file in Evernote.
For details about how to continue the process after you select this 
item, refer to "Saving Handwritten Notes to Evernote" (page 175).

Scan to Google Docs(TM) 
(*4)

Scanned image is saved as a PDF file in Google Docs.
For details about how to continue the process after you select this 
item, refer to "Saving Documents to Google Docs" (page 180).

Scan to Salesforce 
Chatter (*4)

Scanned image is posted to Salesforce Chatter.
For details about how to continue the process after you select
this item, refer to  "Posting to Salesforce Chatter" (page 189)".

Scan to SugarSync (*6) You can save scanned images to your SugarSync folder.
For details about how to continue the process after you select this 
item, refer to  "Saving Data to Your SugarSync Folder" (page 200)

Scan to Word (*7) Creates a Word file by converting the scanned images into text data.
For details about how to continue the process after you select this 
item, refer to "Converting into Word/Excel/PowerPoint Documents" 
(page 136). 

Scan to Excel (*7) Creates an Excel file by converting the scanned images into text data.
For details about how to continue the process after you select this 
item, refer to "Converting into Word/Excel/PowerPoint Documents" 
(page 136). 

Scan to PowerPoint(R) 
(*7)

Creates a PowerPoint file by converting the scanned images into text 
data.
For details about how to continue the process after you select this 
item, refer to "Converting into Word/Excel/PowerPoint Documents" 
(page 136). 

Scan to SharePoint (*8) Scanned image is saved in SharePoint or Office Live.
For details about how to continue the process after you select this 
item, refer to "Saving Data in SharePoint" (page 151). 

Application Description
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*1: Displayed when ScanSnap Organizer is installed.
*2: Displayed when CardMinder is installed.
*3: Displayed when Rack2-Filer trial version (bundled with the ScanSnap) or Rack2-Filer (V5.0 or 

later recommended/bundled model or sold separately) is installed. 
*4: Displayed when .NET Framework 3.0 is installed.
      Note that .NET Framework 3.0 is also included in .NET Framework 3.5 (SP1 or later). It is 

recommended that you use .NET Framework 3.5 (SP1 or later) by updating Windows.
      If .NET Framework 4.0 or later is already installed, you need to install .NET Framework 3.0 

separately because .NET Framework 3.0 is not included in the .NET Framework 4.0 or later 
version.

*5: Displayed when Evernote for Windows 3.5 or later is installed.
*6: Displayed when SugarSync Manager for Windows 1.9.28 or later is installed.
*7: Displayed when ABBYY FineReader for ScanSnap is installed.
*8: Displayed when Scan to Microsoft SharePoint is installed.

Scan to Picture Folder Displays the [Scan to Picture Folder] dialog box.
Scanned image is saved as a JPEG file in the pictures folder.
For details about how to continue the process after you select this 
item, refer to "Saving Files to Picture Folder" (page 129).

The output image may slightly differ from the original document in size.
Performing a scan by pressing the [Scan/Stop] button on the ScanSnap while one of 
the following applications is active (with its window brought to front and selected on 
taskbar) automatically starts the linkage between ScanSnap Manager and the applica-
tion:
- ScanSnap Organizer
- CardMinder (links with ScanSnap Manager only when the document is of business 

card size)
- Rack2-Filer trial version (bundled with the ScanSnap) or Rack2-Filer (V5.0 or later 

recommended/bundled model or sold separately)
- Scan to Mobile

For details about automatic linkage, refer to  "Automatic Linkage with Applications" 
(page 94).

You cannot start scanning when the Quick Menu is displayed. Either select an icon from 
the Quick Menu and finish the process, or close the Quick Menu before you perform the 
next scan.
Do not move, delete, or rename the scanned image in other applications while the 
Quick Menu is displayed.

Application Description
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■ Without Using the Quick Menu

The following explains the procedure for scanning without using the Quick Menu.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. Clear the [Use Quick Menu] check box.
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3. Select a profile.

Select a profile from either of the following:

[Profile] drop-down list

Left-Click menu

4. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).
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5. Press the [Scan/Stop] button on the ScanSnap to start scanning.

The [ScanSnap Manager - Image scanning and file saving] dialog box appears.

The [ScanSnap Manager - Image scanning and file saving] dialog box then shows a 
new message indicating that the ScanSnap is ready for the next scan.

You can also start scanning from the Right-Click Menu.
For more details, refer to "Right-Click Menu" (page 64).

Do not connect and disconnect the ScanSnap and other USB devices during scanning.
Do not close the feed guide during scanning.
Do not switch users during scanning. Doing so will cancel scanning.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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6. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The application specified for the selected profile starts up.

You can also finish scanning by clicking the [Finish Scanning] button in the [ScanSnap 
Manager - Image scanning and file saving] dialog box.
The [Scan/Stop] button on the ScanSnap flashes in blue throughout the scan.
To select an application to link with ScanSnap Manager in the Quick Menu after scan-
ning is completed, refer to "Using the Quick Menu" (page 67). 
When the [Set the marked text as a keyword for the PDF file] or the [Convert to Search-
able PDF] check box is selected in the [File option] tab, the application starts after text 
recognition has been performed on the scanned image.
A dialog box showing the text recognition progress appears during text recognition 
process.
By default, documents are scanned with the following settings: [Image quality: Auto-
matic resolution] and [Color mode: Auto color detection].
For details about how to change scan settings, refer to  "How to Configure Scan 
Settings" (page 82).
The application that starts after scanning varies depending on what is selected in the 
[Application] tab in the ScanSnap setup dialog box. For details, refer to the ScanSnap 
Manager Help.
The output image may slightly differ from the original document in size.
Performing a scan by pressing the [Scan/Stop] button on the ScanSnap while one of 
the following applications is active (with its window brought to front and selected on 
taskbar) automatically starts the linkage between ScanSnap Manager and the applica-
tion:
- ScanSnap Organizer
- CardMinder (links with ScanSnap Manager only when the document is of business 

card size)
- Rack2-Filer trial version (bundled with the ScanSnap) or Rack2-Filer (V5.0 or later 

recommended/bundled model or sold separately)
- Scan to Mobile

For details about automatic linkage, refer to  "Automatic Linkage with Applications" 
(page 94).
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■ Stopping the Scan

You can stop a scan in progress in case you are scanning a wrong document or the wrong 
side of a document. 
Stop the scan in the following procedure:

1. Click the [Stop] button in the [ScanSnap Manager - Image scanning and 
file saving] dialog box which appears during scanning. 

The following message appears when the scanning stops.

2. Click the [Quit] button.

To continue scanning, click the [Continue Scanning] button or press the [Scan/Stop] 
button on the ScanSnap after loading another document in the ScanSnap. 

You can also stop the scan during scanning by pressing the [Scan/Stop] button on the 
ScanSnap.
 Remove the document from the ScanSnap after stopping the scan. For details about 
how to remove documents, refer to "Troubleshooting" in the ScanSnap Manager Help.
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■ Finishing ScanSnap Operation

Exiting ScanSnap Manager
Select [Exit] from the Right-Click Menu.
Normally, you do not have to exit ScanSnap Manager.

Disconnecting the ScanSnap

1. Close the feed guide to turn off the ScanSnap.

The ScanSnap Manager icon on the taskbar changes from  to .

2. Disconnect the USB cable from the computer.

You cannot use the ScanSnap after exiting ScanSnap Manager.
Select [Start] menu → [All Programs] → [ScanSnap Manager] → [ScanSnap Manager] to 
start up ScanSnap Manager when you want to use the ScanSnap.

The ScanSnap does not have a power switch and is turned ON/OFF in conjunction with the 
computer’s power. The ScanSnap can also be automatically turned ON/OFF by opening or 
closing the feed guide. 
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Configuring ScanSnap Manager

This section explains how to specify which applications to display in the Quick Menu, set scan 
settings, how to add, change and delete profiles, automatic linkage with applications, 
scanning progress status, and dialog boxes displayed during scanning.

■ Quick Menu Settings

You can specify which applications to display or hide in the Quick Menu, as well as change 
the display order of the applications in the following procedure.

1. Click [Applications to Show/Hide] in the Quick Menu.

For details about how to display the Quick Menu, refer to "Using the Quick Menu" (page 
67).

The [Applications to Show/Hide] dialog box appears.
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2. Specify which applications to display in the Quick Menu.

Showing or Hiding Application Icons
The icons of the applications listed under [Show] are displayed in the Quick Menu. 
When you select an application in [Show] and click the [Remove] button, the application 
is moved to [Hide]. Likewise, when you select an application in [Hide] and click the [Add] 
button, the application is moved to [Show].
To display all the applications in the Quick Menu, click the [Restore Default] button.

Display Order of Applications
Application icons are displayed in the Quick Menu in the same order as they are listed in 
[Show].
You can change the display order of an application by selecting an application in [Show] 
and clicking either the [Up] or [Down] button.
To restore the default display order of the applications displayed in the Quick Menu, 
click the [Restore Default] button.
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The applications are displayed in the order shown below in the Quick Menu and in 
[Show] of the [Applications to Show/Hide] dialog box.

3. Click the [OK] button to close the [Applications to Show/Hide] dialog 
box.

The applications to be displayed in the Quick Menu and their display order are set.
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■ How to Configure Scan Settings

You can configure scan settings in the ScanSnap setup dialog box depending on your 
intended use.
Configure the scan settings in the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. Click the [Detail] button to switch to the detail view mode.

Using the Quick Menu

Without Using the Quick Menu

You can open the ScanSnap setup dialog box by the following ways:
Double-click the ScanSnap Manager icon .
Press [Ctrl], [Shift], and [Space] keys simultaneously.

Outline view Detail view

Outline view Detail view
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3. Change the scan settings in each tab.

The following items can be configured in each tab:
For details, refer to the ScanSnap Manager Help.

[Application] tab
- Application to be used with the ScanSnap
[Save] tab
- Folder in which scanned image is saved
- File name used for saving the scanned image
[Scanning] tab
- Scanning

(Which image quality to scan with, use color, gray or black & white, enable or 
disable [Setting for text only document], [Allow automatic blank page removal], 
[Correct skewed character strings automatically], [Allow automatic image rotation] 
and [Continue scanning after current scan is finished].)

[File option] tab
- File format of the scanned image (*.pdf, *.jpg)
- Whether to perform text recognition on a marked character string in the scanned 

image and add the character string as a keyword for the PDF file
(Whether to perform text recognition only on the character strings in the first 
marked section or all marked sections to be added as keywords, and in which 
language to perform text recognition.)

- Whether to perform text recognition on character strings in the scanned image to 
convert the file to a searchable PDF file
(Whether to convert the first page only or all pages, and in which language to 
perform text recognition.)

- Whether to create separate PDF files
(Whether to include all scanned images in a single PDF file, or create PDF files, 
each of which including a preset number of pages)

The ScanSnap setup dialog box retains the display status from the last time the ScanSnap 
was used. For example, if it was closed in detail view mode, the dialog box is displayed in 
detail mode next time you open it.
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- Whether to password-protect the created PDF files
(Whether to set the same password for all PDF files, or set a different password 
per scan.)

[Paper] tab
- Paper size of documents (paper size selection, Carrier Sheet settings)
[Compression] tab
- File size of the scanned image (compression rate)

4. Click the [OK] or [Apply] button.

When you use the Quick Menu, scan settings for the [Customize] button are 
changed.
When you do not use the Quick Menu, scan settings for the currently selected profile 
are changed.

Scan settings vary depending on whether you use the Quick Menu or not.
For details about items that can be set, refer to "Setting Items With/Without the Quick 
Menu" (page 438).

If you press the [Scan/Stop] button on the ScanSnap while the ScanSnap setup dialog box 
is displayed, the ScanSnap setup dialog box closes and scanning starts. Scan setting 
changes made up to this point are saved and documents are scanned by these settings.
Note that when other dialog boxes are open, scanning does not start even if you press the 
[Scan/Stop] button on the ScanSnap unless open dialog boxes are closed. 
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■ Profile Management

You can manage up to 20 profiles.
You can select a profile in the [Profile] drop-down list in the ScanSnap setup dialog box or 
from the Left-Click Menu.

[Profile] drop-down list

Left-Click Menu

Once the frequently used scan settings are saved as profiles, you do not have to open the 
ScanSnap setup dialog box to change scan settings every time you perform scanning. You 
can easily switch to an appropriate profile you want by just selecting it.
For details about how to add, change or delete profiles, refer to the following:

To add new profiles (→ page 86)
To change scan settings for profiles (→ page 89)
To rename profiles (→ page 91)
To delete profiles (→ page 93)

To use a profile, you need to clear the [Use Quick Menu] check box in the ScanSnap setup 
dialog box.
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Adding Profiles

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. Configure the scan settings in each tab.

For details about each tab, refer to the ScanSnap Manager Help.

Clear the [Use Quick Menu] check box if it is selected.
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3. Select [Add Profile] from the [Profile] drop-down list.

The [Add new profile] dialog box appears.

4. Type in a new profile name and click the [OK] button.

The added profile appears in the [Profile] drop-down list in the ScanSnap setup 
dialog box.
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5. Click the [OK] button to close the ScanSnap setup dialog box.

Up to 20 profiles can be saved including the [Standard] profile.
You can change the display order of profiles except for the [Standard] profile.
1. Select [Profile Management] from the Right-Click Menu or the [Profile] drop-down list 

in the ScanSnap setup dialog box.
The [ScanSnap Manager - Profile Management] dialog box appears.

2. Select a profile from the list to arrange profiles in a different order.
3. Click the [Up] or [Down] button to move the profile to its desired position in the list.

4. Click the [Close] button to close the [ScanSnap Manager - Profile Management] 
dialog box.
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Changing Profile Settings

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2.  Select a profile from the [Profile] drop-down list.

3. Change the scan settings in each tab.

For details about each tab, refer to the ScanSnap Manager Help.

Clear the [Use Quick Menu] check box if it is selected.
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4. When you finish changing the settings for the selected profile, click the 
[OK] button.

A confirmation message appears asking if you want to overwrite the current profile 
settings.

5. To overwrite the profile, click the [Yes] button. To save the settings as 
"Standard", click the [No] button. 

If you select another profile from the [Profile] drop-down list before clicking the [OK] 
button, the following message appears.

When you click the [Yes] button, the modified settings are overwritten and the profile 
switches to the one you selected from the [Profile] drop-down list.
When you click the [No] button, the modified settings are canceled and the profile 
switches to the one you selected from the [Profile] drop-down list.

The confirmation message does not appear when the [Standard] profile is selected in step 
2.
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Renaming Profiles

1. Select [Profile Management] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The [ScanSnap Manager-Profile Management] dialog box appears.

2. Select a profile and click the [Rename] button.

The [Rename] dialog box appears.

If you cannot select [Profile Management] in the Right-Click Menu, clear the [Use 
Quick Menu] check box in the ScanSnap setup dialog box. 
You can also display the [Profile Management] dialog box by selecting [Profile Man-
agement] from the [Profile] drop-down list in the ScanSnap setup dialog box.

The [Standard] profile cannot be renamed.
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3. Type in a new name, and click the [OK] button.

The profile is renamed.

4. Click the [Close] button to close the [ScanSnap Manager - Profile 
Management] dialog box.
92



Configuring ScanSnap Manager (for Windows users)
Deleting Profiles

1. Select [Profile Management] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The [ScanSnap Manager-Profile Management] dialog box appears.

2. Select a profile and click the [Delete] button.

The [Delete Profile] dialog box appears.

3. Click the [Yes] button.

The selected profile is deleted.

4. Click the [Close] button to close the [ScanSnap Manager - Profile 
Management] dialog box.

If you cannot select [Profile Management] in the Right-Click Menu, clear the [Use 
Quick Menu] check box in the ScanSnap setup dialog box. 
You can also display the [ScanSnap Manager - Profile Management] dialog box by 
selecting [Profile Management] from the [Profile] drop-down list in the ScanSnap 
setup dialog box.

The [Standard] profile cannot be deleted.
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■ Automatic Linkage with Applications

When one of the applications which can automatically link with ScanSnap Manager is running 
and you perform scanning, ScanSnap Manager will automatically link with the corresponding 
application regardless of the current scan settings or whether you are using the Quick Menu.
Applications that can automatically link with ScanSnap Manager are as follows:

ScanSnap Organizer
Scanned image is displayed in ScanSnap Organizer.
CardMinder
Scanned image is displayed in CardMinder.
Rack2-Filer trial version (bundled with the ScanSnap) or Rack2-Filer (V5.0 or later 
recommended/bundled model or sold separately)
Scanned image is saved in a binder in Rack2-Filer.
Scan to Mobile (*)
Scanned image is sent to a mobile device.
*: Automatic linkage is available only when the application is active.

There are two modes for automatic linkage.

Link when one of the above applications is active (recommended)
When ScanSnap Organizer, CardMinder or Rack2-Filer becomes active (with the 
application’s dialog box brought to front and selected on taskbar), performing a scan by 
pressing the [Scan/Stop] button automatically starts the linkage between ScanSnap 
Manager and the active application.

The example above shows ScanSnap Manager automatically linking with ScanSnap 
Organizer when ScanSnap Organizer’s main window is in front (active).

Active

Not active
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Always link when one of the above applications is running
When ScanSnap Organizer, CardMinder, or Rack2-Filer is started, the application 
specified for [Application] in the [Application] tab in the ScanSnap dialog box 
automatically switches to the running application. The application will automatically link 
with ScanSnap Manager even when the application window is minimized or not 
displayed in the front. The linkage between the application and ScanSnap Manager 
automatically ends once you exit the application.
When more than one application is running at the same time, priority will be given in the 
following order:

- CardMinder
- ScanSnap Organizer
- Rack2-Filer trial version (bundled with the ScanSnap) or Rack 2-Filer (V5.0 or 

later recommended/bundled model or sold separately)
When the Quick Menu is disabled, the name of the interacting application on the Left- 
Click Menu is followed by "is interacting".

When ScanSnap Manager automatically links with CardMinder, business cards are 
scanned with the current settings. If there are some settings that are not supported by 
CardMinder, defaults settings are used. 
For details about CardMinder default settings, refer to the ScanSnap Manager Help.
ScanSnap Manager links with CardMinder only when the document is of business card 
size. 
When documents in other sizes are scanned, the following error message appears.

When ScanSnap Organizer is automatically interacting with ScanSnap Manager
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Changing Automatic Linkage Mode
Change automatic linkage mode options in the following procedure.

1. Select [Help] → [Preferences] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The [ScanSnap Manager - Preferences] dialog box appears.

2. Select the automatic linkage mode in the [Automatic Linkage] tab.

3. Click the [OK] button to close the [ScanSnap Manager - Preferences] 
dialog box.

Application will link with ScanSnap Manager using the linkage mode you selected.
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■ ScanSnap's Communication Status

If you turn the ScanSnap ON/OFF when ScanSnap Manager is running, the pop-up balloon 
appearing from the taskbar icon notifies you of the communication status of the ScanSnap.

When the ScanSnap is on

When the ScanSnap is off

To disable notifications of the ScanSnap’s communication status, click the pop-up balloon 
and clear the [Notify of the communication status] check box in the [ScanSnap Manager - 
Preferences] dialog box that appears.
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Receiving or hiding the ScanSnap's communication status notifi-
cations
You can specify whether or not to receive notifications of the ScanSnap’s communication 
status with a pop-up balloon.
Configure the setting in the following procedure.

1. Select [Help] → [Preferences] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The [ScanSnap Manager - Preferences] dialog box appears.

2. In the [Status Display] tab, either select or clear the [Notify of the 
communication status] check box.

If you select the [Notify of the communication status] check box, you will be notified of 
the communication status in conjunction with the ScanSnap being turned ON/OFF.
If you clear the [Notify of the communication status] check box, you will not be notified of 
the communication status.

3. Click the [OK] button to close the [ScanSnap Manager - Preferences] 
dialog box.
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■ Showing the Scanning Progress

When scanning starts, the [ScanSnap Manager - Image scanning and file saving] dialog box 
appears.
The [ScanSnap Manager - Image scanning and file saving] dialog box consists of the 
following:

Scan status
Scan settings
Save completed
Preview

 Also, note that you can stop scanning by clicking the [Stop] button in the [ScanSnap Manager 
- Image scanning and file saving] dialog box, or by pressing the [Scan/Stop] button on the 
ScanSnap.
For details about how to stop scanning, refer to "Stopping the Scan" (page 77).

The following message appears in the [ScanSnap Manager - Image scanning and file saving] 
dialog box after the document has been scanned. Load another document in the ScanSnap 
when you want to scan multiple sheets. Scanning starts automatically when a document is 
loaded.

The [ScanSnap Manager - Image scanning and file saving] dialog box closes when you press 
the [Scan/Stop] button on the ScanSnap or when you click the [Finish Scanning] button.

When the [Continue scanning after current scan is finished] check box in the [Scanning] tab of 
the ScanSnap setup dialog box is cleared, the [ScanSnap Manager - Image scanning and file 
saving] dialog box automatically closes after saving the scanned image.
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Hiding the Scanning Progress Status
You can hide the [ScanSnap Manager - Image scanning and file saving] dialog box in the 
following procedure.

1. Select [Help] → [Preferences] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The [ScanSnap Manager - Preferences] dialog box appears.

2. In the [Status Display] tab, clear the [Show the scan progress status 
(recommended)] check box.

3. Click the [OK] button to close the [ScanSnap Manager - Preferences] 
dialog box.

The [ScanSnap Manager - Image scanning and file saving] dialog box is hidden from 
next scanning on.

When the scanning progress status dialog box is hidden, the ScanSnap Manager icon 

alternates between  and .
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Actions

The ScanSnap has functions useful in your office work available as Actions.
Actions allow you to:

Share the scanned document files with others.
Save the scanned image directly in a shared folder on a network after scanning, share 
the scanned image with others and inform them of the destination folder path by an e-
mail message automatically created with the path stated.

Send document files to participants of a meeting via e-mail.
Send an e-mail message to others with the scanned image file attached.

Use a printer rather than a copy machine to make copies of documents.
Print the scanned image with a printer.

Convert catalogs and pamphlets into digital data and save them.
Save scanned images of catalogs and pamphlets directly into your pictures folder.

Quote text from your paper documents when you do not want to type it.
Have the scanned image text recognized and converted into a Word, Excel, or 
PowerPoint document.

File and organize a large number of business cards.
Store and manage business cards in CardMinder.

Share the scanned document files through linkage with SharePoint.
Save the scanned image in SharePoint and Office Live.

Convert your paper documents into digital data to conveniently 
organize them.
Save the scanned image directly in Rack2- Filer to manage and organize it.

Manage scanned documents through linkage with Evernote.
Save PDF files in Evernote and access them easily anytime, anywhere.

Manage handwritten notes through linkage with Evernote.
Save JPEG files in Evernote and access them easily anytime, anywhere.

Manage scanned documents through linkage with Google Docs.
Save PDF files in Google Docs and access them easily anytime, anywhere.

Manage scanned documents through linkage with Salesforce Chatter.
Post scanned image files to Salesforce Chatter and manage them with Salesforce 
CRM.
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Manage scanned documents through linkage with SugarSync.
Save scanned image files to your SugarSync folder and access them easily anytime, 
anywhere.

Save scanned documents to a mobile device.
Save scanned image files to a connected mobile device. You can access the saved files 
through linkage with an application that can view PDF or JPEG files.

The following are explanations on how to use Actions.
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■ Saving Data in a Specified Folder

This section explains how to save the scanned image file in a specified folder.
You can save the scanned image file in a shared folder on the network and share it with 
others. In addition, you can inform others of the destination folder path by an e-mail message 
automatically created with the path stated.

For details about the procedure to scan and save the scanned image in a specified folder 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 104)
Without Using the Quick Menu (→ page 107)

The default e-mail program is used as the e-mail program to link with.
The e-mail program may not properly link with ScanSnap Manager even if it is the default e-mail 
program. In this case, contact the manufacturer of the e-mail software.
Configure e-mail program settings in the following procedure.

Windows 7/Windows Vista
1. Select [Start] menu → [Default Programs] → [Set your default programs].

The [Set your default programs] dialog box appears.
2. Select an e-mail program to link with ScanSnap Manager from [Programs].
3. Select [Set this program as default] and click the [OK] button.

Windows XP
The e-mail program selected in Internet Explorer [Tools] menu → [Internet Options] → the 
[Programs] tab → [E-mail] drop-down list is used to link with ScanSnap Manager.
If no e-mail program is selected, select an e-mail program to link with ScanSnap Manager in 
the [E-mail] drop-down list. E-mail programs that cannot be selected here cannot be set to 
link with ScanSnap Manager.

Tested e-mail programs
- Windows Live Mail
- Windows Mail (Windows Vista)
- Outlook 2010 / 2007 / 2003
- Outlook Express 6
- Thunderbird version 3.1
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Using the Quick Menu

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Click the [Scan to Folder] icon.

The [Scan to Folder] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67).

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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5. Check the scanned image in the preview area.

In the [Scan to Folder] dialog box, you can change files names, destination folders, and 
specify whether to state a path to a destination folder in an e-mail message to notify 
others.
For details about the [Scan to Folder] dialog box, refer to the ScanSnap Manager Help.

Preview
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6. Click the [Save] button.

The scanned image file is saved in the specified folder.
When you select the [State a path to a destination folder in an E-mail message] 
check box in the [Scan to Folder] dialog box, a new message window appears listing 
the destination folder path where the file is saved.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Folder] dialog box is closed. Close the [Scan to Folder] dialog box before scanning the 
next document.
Do not move, delete, or rename scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to Folder] dialog box is closed.
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Without using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Folder].

3. Click the [OK] button to close the ScanSnap setup dialog box.

4. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 73).

ScanSnap Manager can also link with [Scan to Folder] when you select:
[Scan to Folder] from the [Profile] drop-down list of the ScanSnap setup dialog box
[Scan to Folder] from the Left-Click Menu.
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5. Press the [Scan/Stop] button on the ScanSnap to start scanning.

6. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [Scan to Folder] dialog box appears.

7. Check the scanned image in the preview area.

In the [Scan to Folder] dialog box, you can change files names, destination folders, and 
specify whether to state a path to a destination folder in an e-mail message to notify 
others.
For details about the [Scan to Folder] dialog box, refer to the ScanSnap Manager Help.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

Preview
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8. Click the [Save] button.

The scanned image file is saved in the specified folder.
When you select the [State a path to a destination folder in an E-mail message] 
check box in the [Scan to Folder] dialog box, a new message window appears listing 
the destination folder path where the file is saved.

You cannot start scanning when the [Scan to Folder] dialog box is displayed. Close the 
[Scan to Folder] dialog box before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the [Scan 
to Folder] dialog box is displayed.
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■ Attaching Files to E-Mail

This section explains how to attach the scanned image file to an e-mail message.

For details about the procedure to scan and attach the scanned image file to an e-mail 
message using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 111)
Without Using the Quick Menu (→ page 117)

The default e-mail program is used as the e-mail program to link with.
The e-mail program may not properly link with ScanSnap Manager even if it is the default e-mail 
program. In this case, contact the manufacturer of the e-mail software.
Configure e-mail program settings in the following procedure.

Windows 7/Windows Vista
1. Select [Start] menu → [Default Programs] → [Set your default programs].

The [Set your default programs] dialog box appears.
2. Select an e-mail program to link with ScanSnap Manager from [Programs].
3. Select [Set this program as default] and click the [OK] button.

Windows XP
The e-mail program selected in Internet Explorer [Tools] menu → [Internet Options] → the 
[Programs] tab → [E-mail] drop-down list is used to link with ScanSnap Manager.
If no e-mail program is selected, select an e-mail program to link with ScanSnap Manager in 
the [E-mail] drop-down list. E-mail programs that cannot be selected here cannot be set to 
link with ScanSnap Manager.

Tested e-mail programs
- Windows Live Mail
- Windows Mail (Windows Vista)
- Outlook 2010 / 2007 / 2003
- Outlook Express 6
- Thunderbird version 3.1
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Using the Quick Menu

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67).

Up to ten files can be attached to an e-mail message.
When you scan more than one document with the scan settings shown below, multiple 
files are created. Pay attention to the number of documents to scan:

File format: JPEG (*.jpg)
[Generate one PDF file per (n) page(s)] check box is selected

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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4. Change the settings for [Scan to E-mail] (If you do not want to change 
any settings, go to step 5.).

1. Move the mouse cursor to the  mark on the [Scan to E-mail] icon, and then select 
the [Settings] menu.

The [Scan to E-mail - Options] dialog box appears.
2. Change the settings.

For details about the [Scan to E-mail - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to E-mail - Options] dialog box.
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5. Click the [Scan to E-mail] icon.

The [Scan to E-mail] dialog box appears.
If you clear the [Show preview] check box of the [Scan to E-mail - Options] dialog box 
in step 4., the [Scan to E-mail] dialog box is not displayed. Instead, a new message 
window appears with the file(s) attached.
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6. Check the scanned image in the preview area.

In the [Scan to E-mail] dialog box, you can rename the file, specify whether to set a 
"Document Open Password", and save the scanned image in the folder specified for 
[Image saving folder] after sending it by e-mail.
For details about the [Scan to E-mail] dialog box, refer to the ScanSnap Manager Help.

Preview
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7. Click the [Attach] button.

When the [Set a "Document Open password" for PDF files] check box is selected in 
the [Scan to E-mail - Options] dialog box or the [Scan to E-mail] dialog box, the [Scan 
to E-mail - Set a password] dialog box appears.

Enter a password, and then click the [OK] button.

A new message dialog box appears with the file attached.

The following message appears if you click the [Cancel] button in the [Scan to E-mail - Set a 
password] dialog box.

If you do not want to set a document open password, click the [Yes] button.
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You cannot start scanning after the Quick Menu is displayed and before the [Scan to E-
mail] dialog box is closed. Close the [Scan to E-mail] dialog box before scanning the 
next document.
Do not move, delete, or rename scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to E-mail] dialog box is closed.
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Without using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to E-mail].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 73).

ScanSnap Manager can also link with [Scan to E-mail] when you select:
[Scan to E-mail] from the [Profile] drop-down list of the ScanSnap setup dialog box
[Scan to E-mail] from the Left-Click Menu.
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3. Change the settings for [Scan to E-mail] (If you do not want to change 
any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to E-mail - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to E-mail - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to E-mail - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

Up to ten files can be attached to an e-mail message.
When you scan more than one document with the scan settings shown below, multiple 
files are created. Pay attention to the number of documents to scan:

File format: JPEG (*.jpg)
[Generate one PDF file per (n) page(s)] check box is selected
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6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [Scan to E-mail] dialog box appears.
If you clear the [Show preview] check box of the [Scan to E-mail - Options] dialog box 
in step 3., the [Scan to E-mail] dialog box is not displayed. Instead, a new message 
window appears with the file(s) attached.

8. Check the scanned image in the preview area.

In the [Scan to E-mail] dialog box, you can rename the file, specify whether to set a 
"Document Open Password", and save the scanned image in the folder specified for 
[Image saving folder] after sending it by e-mail.
For details about the [Scan to E-mail] dialog box, refer to the ScanSnap Manager Help.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

Preview
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9. Click the [Attach] button.

When the [Set a "Document Open password" for PDF files] check box is selected in 
the [Scan to E-mail - Options] dialog box or the [Scan to E-mail] dialog box, the [Scan 
to E-mail - Set a password] dialog box appears.

Enter a password, and then click the [OK] button.

An e-mail message dialog box appears with the file attached.

The following message appears if you click the [Cancel] button in the [Scan to E-mail - Set a 
password] dialog box.

If you do not want to set a document open password, click the [Yes] button.
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You cannot start scanning when the [Scan to E-mail] dialog box is displayed. Close the 
[Scan to E-mail] dialog box before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the [Scan 
to E-mail] dialog box is displayed.
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■ Using the ScanSnap as a Copy Machine

This section explains how to print the scanned image with a printer.
When a printer links with ScanSnap Manager, the ScanSnap can be used as a copy machine.

For details about the procedure to scan and print the scanned image using or without using 
the Quick Menu, refer to the following:

Using the Quick Menu (→ page 123)
Without Using the Quick Menu (→ page 126)

Note that shadows around the edges of the document may appear as lines on the generated 
scanned image, depending on the scanning method and paper conditions. If you print such 
an image, the printed image will also have lines appearing in it.
The scanned image will be printed at a resolution of 150 dpi regardless of the setting 
specified for [Image quality] in the [Scanning] tab.
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Using the Quick Menu

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to Print] (If you do not want to change any 
settings, go to step 5.).

1. Move the mouse cursor to the  mark on the [Scan to Print] icon, and then select 
the [Settings] menu.

The [Scan to Print - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67). 

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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2. Change the settings.
For details about the [Scan to Print- Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Print- Options] dialog box.

5. Click the [Scan to Print] icon.

The [Scan to Print] dialog box appears.
If the [Show "Print" dialog] check box is cleared in step 4., printing is immediately 
performed.
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6. Check the scanned image in the preview area.

In the [Scan to Print] dialog box, you can specify the printer to be used, the number of 
copies and size of the scanned image to be printed, and whether to save the scanned 
image in the folder specified for [Image saving folder].
For details about the [Scan to Print] dialog box, refer to the ScanSnap Manager Help. 

7. Click the [Print] button.

The scanned image is printed.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Print] dialog box is closed. Close the [Scan to Print] dialog box before scanning the next 
document.
Do not move, delete, or rename the scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to Print] dialog box is closed.

Preview
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Without using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Print].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 73).

ScanSnap Manager can also link with [Scan to Print] when you select:
[Scan to Print] from the [Profile] drop-down list of the ScanSnap setup dialog box
[Scan to Print] from the Left-Click Menu
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3. Change the settings for [Scan to Print] (If you do not want to change any 
settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Print - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to Print - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Print - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [Scan to Print] dialog box appears.
If the [Show "Print" dialog] check box is cleared in step 3., printing is immediately 
performed.

8. Check the scanned image in the preview area.

In the [Scan to Print] dialog box, you can specify the printer to be used, the number of 
copies and size of the scanned image to be printed, and whether to save the scanned 
image in the folder specified for [Image saving folder].
For details about the [Scan to Print] dialog box, refer to the ScanSnap Manager Help. 

9. Click the [Print] button.

The scanned image is printed.

You cannot start scanning when the [Scan to Print] dialog box is displayed. Close the 
[Scan to Print] dialog box before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the [Scan 
to Print] dialog box is displayed.

Preview
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Actions (for Windows users)
■ Saving Files to Picture Folder

This section explains how to save the scanned image as a JPEG file in the "Pictures folder".

For details about the procedure to scan and save the scanned image in the "Pictures folder" 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 130)
Without Using the Quick Menu (→ page 133)

The following folder is set as the "Pictures folder" by default:
Windows 7/Windows Vista

Drive name (such as C)\Users\user name\Pictures\ScanSnap
Windows XP

Drive name (such as C):\Documents and Settings\user name\My Documents\
My Pictures\ScanSnap
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Actions (for Windows users)
130

Using the Quick Menu

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to Picture Folder] (If you do not want to 
change any settings, go to step 5.).

1. Move the mouse cursor to the  mark on the [Scan to Picture Folder] icon, and then 
select the [Settings] menu.

The [Scan to Picture Folder - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67).

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.



Actions (for Windows users)
2. Change the settings.
For details about the [Scan to Picture Folder - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Picture Folder - Options] dialog box.

5. Click the [Scan to Picture Folder] icon.

The [Scan to Picture Folder] dialog box appears.
If you clear the [Show preview] check box in step 4., the image data is directly saved 
in the pictures folder.
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Actions (for Windows users)
6. Check the scanned image in the preview area.

In the [Scan to Picture Folder] dialog box, you can rename the file, change the 
destination folder, and save the scanned image in the folder specified for [Image saving 
folder].
For details about the [Scan to Picture Folder] dialog box, refer to the ScanSnap 
Manager Help.

7. Click the [Save] button.

The scanned image is saved in the pictures folder.

In [Specify destination folder], you can change the destination folder for the image data to a 
folder other than the pictures folder.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Picture Folder] dialog box is closed. Close the [Scan to Picture Folder] dialog box before 
scanning the next document.
Do not move, delete, or rename scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to Picture Folder] dialog box is closed.

Preview
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Actions (for Windows users)
Without using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Picture Folder].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For more details about how to perform scanning without using the Quick Menu, refer to "Without 
Using the Quick Menu" (page 73).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected from the [Profile] drop-down list or Left-Click Menu next time you 
perform a scan.
For details about how to add a profile, refer to "Profile Management" (page 85).
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Actions (for Windows users)
3. Change the settings for [Scan to Picture Folder] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Picture Folder - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to Picture Folder - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Picture Folder - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Windows users)
7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [Scan to Picture Folder] dialog box appears.
If you clear the [Show preview] check box in step 3., the scanned image is directly 
saved in the pictures folder.

8. Check the scanned image in the preview area.

In the [Scan to Picture Folder] dialog box, you can rename the file, change the 
destination folder, and save the scanned images in the folder specified for [Image 
saving folder].
For details about the [Scan to Picture Folder] dialog box, refer to the ScanSnap 
Manager Help.

9. Click the [Save] button.

The scanned image is saved in the pictures folder.

In [Specify destination folder], you can change the destination folder for the scanned image 
to a folder other than the pictures folder.

You cannot start scanning when the [Scan to Picture Folder] dialog box is displayed. 
Close the [Scan to Picture Folder] dialog box before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the [Scan 
to Picture Folder] dialog box is displayed.

Preview
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Actions (for Windows users)
■ Converting into Word/Excel/PowerPoint Documents

This section explains how to convert the scanned image into Word/Excel/PowerPoint files 
using ABBYY FineReader for ScanSnap bundled with the ScanSnap.

The following applications must be installed in your computer in order to perform text-recogni-
tion:
- ABBYY FineReader for ScanSnap (bundled with the ScanSnap)
- Word
- Excel
- PowerPoint
- Visual Basic for Applications of Office Shared Features (installed at the same time when 

you perform a standard installation of Microsoft Office)
You cannot view the documents converted into Word, Excel and PowerPoint files unless 
these applications are installed and you completed the user registration to use them. Install 
these applications and complete the user registration to view the converted documents on 
your computer.
ABBYY FineReader for ScanSnap can be used with the following versions of Word, Excel 
and PowerPoint:
- Word: 2010 / 2007 / 2003 / 2002
- Excel: 2010 / 2007 / 2003 / 2002
- PowerPoint: 2010 / 2007 / 2003 / 2002

Do not use this function while you are working in Word, Excel or PowerPoint. In addition, do 
not use Word, Excel or PowerPoint while this function is being executed. Otherwise, a mes-
sage such as "Call is rejected by callee" may appear and the conversion result may not be 
displayed.

ABCD... A
B
C

4567

123

-1569
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Actions (for Windows users)
About the OCR function of ABBYY FineReader for ScanSnap
ABBYY FineReader for ScanSnap is an application used exclusively with the ScanSnap. This 
application can perform text recognition only for PDF files created by using the ScanSnap. It 
cannot perform text recognition for PDF files created using Adobe Acrobat or other applica-
tions.
The optical character recognition program has the following features. Before performing text 
recognition, check whether the documents you want to convert are suitable for conversion 
according to the following guidelines:

Application Suitable for conversion Not suitable for conversion

Scan to Word Documents with simple layouts 
consisting of single or double 
columns

Documents with complex layouts containing 
a mixture of diagrams, tables and text (e.g. 
brochures, magazines and newspapers)

Scan to Excel Documents containing simple 
tables with no cells merged

Documents containing:
- Tables with no solid border lines
- Tables with complicated cell formats
- Complex tables containing subtables
- Diagrams
- Graphs
- Photos
- Vertical text

Scan to 
PowerPoint(R)

Documents containing text and 
simple diagrams/tables on a 
white or light monocolor back-
ground

- Documents with complex layouts 
containing text mixed with diagrams or 
illustrations

- Documents containing photographs or 
patterns set as the background

- Documents with light colored text on a 
deep colored background
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Actions (for Windows users)
The following parameters may not be reproduced as they are in the original document. It is 
recommended that you check the conversion result in Word, Excel or PowerPoint and edit the 
data if necessary:
- Character font and size
- Character and line spacing
- Underlined, bold and italic characters
- Superscript/subscript

The following types of documents (characters) may not be recognized correctly.
Better results in text recognition may be achieved by changing the color mode or increasing 
the resolution:
- Documents including handwritten characters
- Documents containing small characters (smaller than 10 points)
- Skewed documents
- Documents written in languages other than the specified language
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders
- Documents with a complex layout and documents with image noise

(It may take extra time to process text recognition for these documents.)
The following message appears when you convert a long page document into a Word file, and 
the conversion result may be divided into more than one page.

When converting to Excel files, if the recognition result exceeds 65,536 lines, no more results 
are saved.
When converting to Excel files, information about the layout of the entire document, diagrams, 
and length/width of graphs and tables is not duplicated. Only tables and character strings are 
reproduced.
A converted PowerPoint document will not have the original background color and patterns.
Documents placed upside down or in landscape orientation cannot be recognized properly. 
Select the [Allow automatic image rotation] check box (page 227), or load documents face 
down in portrait orientation.
In the ScanSnap setup dialog box, even if the [Generate one PDF file per (n) page (s)] check 
box is selected in the [File option] tab → [Option], the conversion result is saved as one file.
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Actions (for Windows users)
For details about the procedure to scan and convert the scanned image into Word/Excel/
PowerPoint files using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 140)
Without Using the Quick Menu (→ page 142)

You can change the settings applied during conversion to Word, Excel or PowerPoint documents 
in the ABBYY FineReader for ScanSnap setup dialog box.

Select [Start] menu → [All Programs] → [ABBYY FineReader for ScanSnap (TM) 4.1] → [ABBYY 
FineReader for ScanSnap (TM) 4.1] to display the following dialog box.

For details about how to configure settings, refer to ABBYY FineReader for ScanSnap User's 
Guide.
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Actions (for Windows users)
Using the Quick Menu

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Click the [Scan to Word], [Scan to Excel] or [Scan to PowerPoint(R)] 
icon.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67).

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in 
the [Scanning] tab of the ScanSnap setup dialog box.
Load another document in the ScanSnap when you want to scan multiple sheets. Scan-
ning starts automatically when a document is loaded.
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Actions (for Windows users)
The following dialog box appears, and image data conversion to Word, Excel or 
PowerPoint files starts.

When the conversion is completed, Word, Excel or PowerPoint starts up and the 
conversion result is displayed.

When you perform a scan with [JPEG(*.jpg)] selected for [File format] in the [File option] 
tab of the ScanSnap setup dialog box, scanned data cannot be converted into a Word, 
Excel or PowerPoint file.
You cannot start scanning when the Quick Menu is displayed. Wait until the conversion 
is over to scan another document.
Do not move, delete or rename the scanned image in other applications when the Quick 
Menu is displayed.

In a computer environment where Word, Excel or PowerPoint is not installed, the scanned 
image is saved in one of the following formats when the conversion is completed:

Scan to Word: RTF format (.rtf)
Scan to Excel: XLS format (.xls)
Scan to PowerPoint: PPT format (.ppt)
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Actions (for Windows users)
Without using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select 
[ABBYY Scan to Word], [ABBYY Scan to Excel], or [ABBYY Scan to 
PowerPoint(R)].

3. Click the [OK] button to close the ScanSnap setup dialog box.

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 73).

It is recommended to select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab of the ScanSnap setup dialog box.
ScanSnap Manager can also link with [ABBYY Scan to Word], [ABBYY Scan to Excel] 
or [ABBYY Scan to PowerPoint(R) when you select:
- [ABBYY Scan to Word], [ABBYY Scan to Excel] or [ABBYY Scan to PowerPoint(R)] 

from the [Profile] drop-down list of the ScanSnap setup dialog box
- [ABBYY Scan to Word], [ABBYY Scan to Excel] or [ABBYY Scan to PowerPoint(R)] 

from the Left-Click Menu
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Actions (for Windows users)
4. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

5. Press the [Scan/Stop] button on the ScanSnap to start scanning.

6. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The following dialog box appears, and image data conversion to Word, Excel or 
PowerPoint files starts.

When the conversion is completed, Word, Excel or PowerPoint starts up and the 
conversion result is displayed.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

In a computer environment where Word, Excel or PowerPoint is not installed, the image 
data is saved in one of the following formats when the conversion is completed:

Scan to Word: RTF format (.rtf)
Scan to Excel: XLS format (.xls)
Scan to PowerPoint: PPT format (.ppt)
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Actions (for Windows users)
■ Storing Business Cards in CardMinder

This section explains how to store business card images and the related information in 
CardMinder.

For details about the procedure to scan and manage business cards in CardMinder using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 145)
Without Using the Quick Menu (→ page 148)

Blank pages are not removed even if the [Allow automatic blank page removal] is selected 
when you store scanned images of business cards in CardMinder.
Data of up to 1,000 pages, including blank pages, can be stored in CardMinder at once.
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Actions (for Windows users)
Using the Quick Menu

1. Insert the business card straight into the feeding section of the 
ScanSnap, with the scanning side facing up.

Business card is pulled in until it is set inside the ScanSnap.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67).

When [Business card] is specified for [Paper size] in the [Paper] tab of the ScanSnap 
setup dialog box, insert the business card by aligning it with the left edge of the feeding 
section.

If you perform a scan with the output guide open, a 
paper jam may occur and damage business cards. 
Make sure to close the output guide when you scan 
business cards.

Output guide
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Actions (for Windows users)
2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Click the [Scan to CardMinder] icon.

The CardMinder window appears.

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab of the ScanSnap setup dialog box. ScanSnap Manager cannot link with 
CardMinder when [Image quality] is set to [Excellent].

Load another business card in the ScanSnap when you want to scan multiple business 
cards. Scanning starts automatically when a business card is loaded.

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap 
Manager links with CardMinder before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Windows users)
5. Check the scanned card image and the text recognition result.

For details about the functions of CardMinder and how to use it, refer to CardMinder 
User's Guide and CardMinder Help.
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Actions (for Windows users)
Without using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select 
[CardMinder].

3. Click the [OK] button to close the ScanSnap setup dialog box.

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 73).

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab of the ScanSnap setup dialog box. ScanSnap Manager cannot link with 
CardMinder when [Image quality] is set to [Excellent].

ScanSnap Manager can also link with [CardMinder] when you select:
[CardMinder] from the [Profile] drop-down list of the ScanSnap setup dialog box
[CardMinder] from the Left-Click Menu
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Actions (for Windows users)
4. Insert the business card straight into the feeding section of the 
ScanSnap, with the scanning side facing up.

Business card is pulled in until it is set inside the ScanSnap.

5. Press the [Scan/Stop] button on the ScanSnap to start scanning.

6. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The CardMinder window appears.

When [Business card] is specified for [Paper size] in the [Paper] tab of the ScanSnap 
setup dialog box, insert the business card by aligning it with the left edge of the feeding 
section.

If you perform a scan with the output guide open, a 
paper jam may occur and damage business cards. 
Make sure to close the output guide when you scan 
business cards.

Load another business card in the ScanSnap when you want to scan multiple business 
cards. Scanning starts automatically when a business card is loaded.

Output guide
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Actions (for Windows users)
7. Check the scanned card image and the text recognition result.

For details about the functions of CardMinder and how to use it, refer to CardMinder 
User's Guide and CardMinder Help.
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Actions (for Windows users)
■ Saving Data in SharePoint

This section explains how to save the scanned image in SharePoint or Office Live.

For details about the procedure to scan and save the scanned image in SharePoint/Office 
Live using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 152)
Without Using the Quick Menu (→ page 156)

To save a large file to SharePoint or Office Live, you may need to have the system adminis-
trator change the SharePoint or Office Live setting.
When you start up Scan to Microsoft SharePoint for the first time, you need to register a 
SharePoint site. Once you register the SharePoint site, ScanSnap Manager automatically 
connects to that site from the next startup.
For more details, refer to the Scan to Microsoft SharePoint User Guide.
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Actions (for Windows users)
Using the Quick Menu

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to SharePoint] (If you do not want to 
change any settings, go to step 5.).

1. Move the mouse cursor to the  mark on the [Scan to SharePoint] icon, and then 
select the [Settings] menu.

The [Scan to SharePoint - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67).

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Windows users)
2. Change the setting.
For details about the [Scan to SharePoint - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to SharePoint - Options] dialog box.

5. Click the [Scan to SharePoint] icon.

Scan to Microsoft SharePoint starts up.

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap Man-
ager links with Microsoft SharePoint before scanning another document.
Do not move, delete or rename the scanned image in other applications when the Quick 
Menu is displayed.
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Actions (for Windows users)
6. Save the image data.

Saving to SharePoint
1. Select a folder in which you want to save the scanned image.
2. In the Scan to Microsoft SharePoint Index Pane, enter information, such as the title, 

and click the [Accept] button.

The scanned image is saved in the specified folder.

Saving to Office Live

1. Select [Connect to Office Live] from the menu.

The Office Live logon dialog box appears.

Support for Office Live varies depending on the country. For more details, refer to the 
Office Live Web site.
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Actions (for Windows users)
2. Enter the ID and the password in the Office Live logon dialog box, and then click the 
[Sign In] button.

The [Scan to Microsoft SharePoint] dialog box appears after the ScanSnap is 
connected to Office Live.

3. Select a folder in which you want to save the scanned image.
4. In the Scan to Microsoft SharePoint Index Pane, enter information, such as the title, 

and click the [Accept] button.

The scanned image is saved in the specified folder.

For details, refer to the Scan to Microsoft SharePoint User Guide.
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Actions (for Windows users)
Without using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to SharePoint].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 73).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected in the [Profile] drop-down list or Left-Click Menu next time you 
perform a scan. 
For details about how to add a profile, refer to "Profile Management" (page 85).
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Actions (for Windows users)
3. Change the settings for [Scan to SharePoint] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to SharePoint - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to SharePoint - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to SharePoint - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Windows users)
7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Scan to Microsoft SharePoint starts up.

8. Save the scanned image.

Saving to SharePoint
1. Select a folder in which you want to save the scanned image.
2. In the Scan to Microsoft SharePoint Index Pane, enter information, such as the title, 

and click the [Accept] button.

The scanned image is saved in the specified folder.

Saving to Office Live

1. Select [Connect to Office Live] from the menu.

The Office Live logon dialog box appears.

Support for Office Live varies depending on the country. For more details, refer to the 
Office Live Web site.
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Actions (for Windows users)
2. Enter the ID and the password in the Office Live logon dialog box, and then click the 
[Sign In] button.

The [Scan to Microsoft SharePoint] dialog box appears after the ScanSnap is 
connected to Office Live.

3. Select a folder in which you want to save the scanned image.
4. In the Scan to Microsoft SharePoint Index Pane, enter information, such as the title, 

and click the [Accept] button.

The scanned image is saved in the specified folder.

For more details, refer to the Scan to Microsoft SharePoint User Guide.
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Actions (for Windows users)
■ Saving to Rack2-Filer

This section explains how to save the scanned image as a PDF file in Rack2-Filer trial version 
(bundled with the ScanSnap) or Rack2-Filer (V5.0 or later recommended/bundled model or 
sold separately).

For details about the procedure to scan and save the scanned image in Rack2-Filer using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 161)
Without Using the Quick Menu (→ page 164)

Rack2-Filer trial version (bundled with the ScanSnap) or Rack2-Filer (V5.0 or later recom-
mended/bundled model or sold separately) is required to use this function.
Rack2-Filer is an application that converts paper documents and electronic documents into 
PDF files and manages them in a computer. You can manage the documents as if you bind 
them, store them on a cabinet shelf, and browse them as if you flip through a book.
The following settings in ScanSnap Manager are disabled when the scanned image is saved 
to Rack2-Filer:
- Rename file after scanning
- Color high compression
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Actions (for Windows users)
Using the Quick Menu

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to Rack2-Filer] (If you do not want to 
change any settings, go to step 5.).

1. Move the mouse cursor to the  mark on the [Scan to Rack2-Filer] icon, and then 
select the [Settings] menu.

The [ScanSnap - > Rack2] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67) 

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Windows users)
2. Change the settings.
In this dialog box, specify the destination to save the scanned image.
For details about the [ScanSnap - > Rack2] dialog box, refer to Rack2-Filer Help. 
Click the [Help] button in the [ScanSnap - > Rack2] dialog box to display Rack2-Filer 
Help.

3. Click the [OK] button to close the [ScanSnap - > Rack2] dialog box.

5. Click the [Scan to Rack2-Filer] icon.

Rack2-Filer starts up, and the PDF file created by the ScanSnap is saved in Rack2-
Filer in accordance with the settings specified in step 4.

When you perform a scan with [JPEG(*.jpg)] selected for [File format] in the [File option] 
tab of the ScanSnap setup dialog box, you cannot save the image in Rack2-Filer.
You cannot start scanning when the Quick Menu is displayed. Save the scanned image 
to Rack2-Filer before scanning another document.
Do not move, delete or rename the scanned image in other applications when the Quick 
Menu is displayed.
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Actions (for Windows users)
For details about how to use Rack2-Filer, refer to the Rack2-Filer User's Guide.
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Actions (for Windows users)
Without using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Rack2-
Filer].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 73).

ScanSnap Manager can also link with [Rack2-Filer] when you select:
[Rack2-Filer] from the [Profile] drop-down list of the ScanSnap setup dialog box
[Rack2-Filer] from the Left-Click Menu
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Actions (for Windows users)
3. Change the settings for [Scan to Rack2-Filer] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Setting] button.

The [ScanSnap - > Rack2] dialog box appears.

2. Change the settings.
In this dialog box, specify the destination to save the scanned image.
For details about the [ScanSnap -> Rack2] dialog box, refer to Rack2-Filer Help.Click 
the [Help] button in the [ScanSnap -> Rack2] dialog box to display Rack2-Filer Help.

3. Click the [OK] button to close the [ScanSnap -> Rack2] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).
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Actions (for Windows users)
6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Rack2-Filer starts up, and the PDF file created by the ScanSnap is saved in Rack2-
Filer in accordance with the settings specified in step 3.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

For details about how to use Rack2-Filer, refer to the Rack2-Filer User's Guide.
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Actions (for Windows users)
■ Saving Documents to Evernote

This section explains how to save the scanned image as a PDF file to Evernote.
When you save a scanned image to Evernote after converting it into a searchable PDF, the 
PDF file becomes searchable in Evernote.

For details about the procedure to scan and save the scanned image to Evernote using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 168)
Without Using the Quick Menu (→ page 172)

You need to create an Evernote account (free or premium).
You first need to sign in to Evernote for Windows to save a file to Evernote.

PDF
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Actions (for Windows users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67).

Load another document in the ScanSnap when you want to scan multiple sheets.
Scanning starts automatically when a document is loaded.
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Actions (for Windows users)
4. Change the settings for [Scan to Evernote (Document)] (If you do not 
want to change any settings, go to step 5.).

1. Move the mouse cursor to the  mark on the [Scan to Evernote (Document)] icon, 
and then select the [Settings] menu.

The [Scan to Evernote - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to Evernote- Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Evernote - Options] dialog box.
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Actions (for Windows users)
5. Click the [Scan to Evernote (Document)] icon.

When you perform a scan with [JPEG(*.jpg)] selected for [File format] in the [File 
option] tab of the ScanSnap setup dialog box, a PDF file is created from the JPEG 
file. A separate PDF file is created for each JPEG file.

     The following dialog box is displayed when the PDF file is being created.

You cannot start scanning when the Quick Menu is displayed. Save the PDF file to Ever-
note before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Windows users)
If the [Convert to Searchable PDF] check box is selected in step 4., text recognition 
is performed according to the [OCR options] settings in the [Scan to Evernote - 
Options] dialog box. 

     The following dialog box is displayed during text recognition.

Evernote for Windows starts up, and the PDF file is saved to Evernote.

Text recognition will be performed if there are any pages containing text which is not 
yet recognized. Note that text recognition will be performed on those pages only.

The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup dialog box even after the scanned 
image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Windows users)
Without using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Evernote (Document)].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 73).

ScanSnap Manager can also link with [Scan to Evernote (Document)] when you select:
[Scan to Evernote (Document)] from the [Profile] drop-down list of the ScanSnap setup 
dialog box
[Scan to Evernote (Document)] from the Left-Click Menu
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Actions (for Windows users)
3. Change the settings for [Scan to Evernote (Document)] (If you do not 
want to change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Evernote - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to Evernote - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Evernote - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

Load another document in the ScanSnap when you want to scan multiple sheets. 
Scanning starts automatically when a document is loaded.
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Actions (for Windows users)
7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

When you perform a scan with [JPEG(*.jpg)] selected for [File format] in the [File 
option] tab of the ScanSnap setup dialog box, a PDF file is created from the JPEG 
file. A separate PDF file is created for each JPEG file.

     The following dialog box is displayed when the PDF file is being created.

If the [Convert to Searchable PDF] check box is selected in step 3., text recognition 
is performed according to the [OCR options] settings in the [Scan to Evernote - 
Options] dialog box. 

     The following dialog box is displayed during text recognition.

 

Evernote for Windows starts up, and the PDF file is saved to Evernote.

Text recognition will be performed if there are any pages containing text which is not 
yet recognized. Note that text recognition will be performed on those pages only.

The file in which the scanned image is saved remains in the folder specified for 
[Imagesaving folder] in the [Save] tab of the ScanSnap setup dialog box even after the 
scanned image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Windows users)
■ Saving Handwritten Notes to Evernote

This section explains how to save the scanned image as a JPEG file to Evernote.
When you save a JPEG file to Evernote, text recognition is performed on all text, including 
handwritten characters, and the file becomes searchable in Evernote.

For details about the procedure to scan and save the scanned image to Evernote using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 176)
Without Using the Quick Menu (→ page 178)

You need to create an Evernote account (free or premium).
You first need to sign in to Evernote for Windows to save a file to Evernote.

JPEG
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Actions (for Windows users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67).

Load another document in the ScanSnap when you want to scan multiple sheets.
Scanning starts automatically when a document is loaded.
176



Actions (for Windows users)
4. Click the [Scan to Evernote (Note)] icon.

If [PDF(*.pdf)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup dialog box, a separate JPEG file will be created from each page of the PDF 
file.

     The following dialog box is displayed when the JPEG file is being created.

Evernote for Windows starts up, and the JPEG file is saved to Evernote.

You cannot start scanning when the Quick Menu is displayed. Save the JPEG file to 
Evernote before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

When you select [PDF (*.pdf)] for [File format] in the [File option] tab of the ScanSnap 
setup dialog box, a four-digit serial number is automatically added to the name of the 
file which is saved to Evernote.
e.g. When the file name is [ScanSnap], the file is saved as:

ScanSnap_0001, ScanSnap_0002, ScanSnap_0003...
The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup dialog box even after the 
scanned image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Windows users)
Without using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Evernote (Note)].

3. Click the [OK] button to close the ScanSnap setup dialog box.

4. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 73).

ScanSnap Manager can also link with [Scan to Evernote (Note)] when you select:
[Scan to Evernote (Note)] from the [Profile] drop-down list of the ScanSnap setup dialog 
box
[Scan to Evernote (Note)] from the Left-Click Menu
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Actions (for Windows users)
5. Press the [Scan/Stop] button on the ScanSnap to start scanning.

6. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

If [PDF(*.pdf)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup dialog box, a separate JPEG file will be created from each page of the PDF 
file.

     The following dialog box is displayed when the JPEG file is being created.

Evernote for Windows starts up, and the JPEG file is saved to Evernote.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

When you select [PDF (*.pdf)] for [File format] in the [File option] tab of the ScanSnap 
setup dialog box, a four-digit serial number is automatically added to the name of the 
file which is saved to Evernote.
e.g. When the file name is [ScanSnap], the file is saved as:
      ScanSnap_0001, ScanSnap_0002, ScanSnap_0003...
The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup dialog box even after the 
scanned image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Windows users)
■ Saving Documents to Google Docs

This section explains how to save the scanned image as a PDF file to Google Docs.

For details about the procedure to scan and save the scanned image to Google Docs using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 181)
Without Using the Quick Menu (→ page 185)

You need to create a Google account (free).
You need to have .NET Framework 3.0 installed in order to use this function. 
Note that .NET Framework 3.0 is also included in .NET Framework 3.5 (SP1 or later). It is 
recommended that you use .NET Framework 3.5 (SP1 or later) by updating Windows. 
You need to install .NET Framework 3.0 separately even if .NET Framework 4.0 or later is 
already installed because .NET Framework 3.0 is not included in the .NET Framework 4.0 or 
later version.

PDF
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Actions (for Windows users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to Google Docs(TM)] (If you do not want to 
change any settings, go to step 5.).

1. Move the mouse cursor to the  mark on the [Scan to Google Docs(TM)] icon, and 
then select the [Settings] menu.

The [Scan to Google Docs(TM) - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67).

Load another document in the ScanSnap when you want to scan multiple sheets. 
Scanning starts automatically when a document is loaded.
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Actions (for Windows users)
2. Change the settings.
For details about the [Scan to Google Docs(TM) - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Google Docs(TM) - Options] dialog box.

5. Click the [Scan to Google Docs(TM)] icon.

If the computer is shared with other users, do not enter your information in [Email] and 
[Password] in this dialog box. Otherwise, other users will be able to log into Google 
Docs automatically.
It is recommended to set only [Email] in this dialog box, and type in the password every 
time.

You cannot start scanning when the Quick Menu is displayed. Save the PDF file to 
Google Docs before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
182



Actions (for Windows users)
If you did not specify a Google account in the [Scan to Google Docs(TM) - Options] 
dialog box in step 4., the [Scan to Google Docs(TM)] dialog box appears. To 
continue, enter your e-mail address and password, and click the [OK] button.

When you perform a scan with [JPEG(*.jpg)] selected for [File format] in the [File 
option] tab of the ScanSnap setup dialog box, a PDF file is created from the JPEG 
file. A separate PDF file is created for each JPEG file.

     The following dialog box is displayed when the PDF file is being created.

If the [Convert to Searchable PDF] check box is selected in the [Scan to Google 
Docs(TM) - Options] dialog box in step 4., text recognition is performed according to 
the [OCR options] settings in the [Scan to Google Docs(TM) - Options] dialog box. 

     The following dialog box is displayed during text recognition.

If the computer is shared with other users, do not select the [Save your account 
information.] check box in this dialog box. Otherwise, other users will be able to 
log into Google Docs automatically.
Scan to Google Docs is not available in a proxy environment that requires 
authentication upon connecting to the Internet.

Text recognition will be performed if there are any pages containing text which is not 
yet recognized. Note that text recognition will be performed on those pages only.
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Actions (for Windows users)
Saving to Google Docs starts. Click the [Close] button to close the [Scan to Google 
Docs(TM)] dialog box when the saving is completed.

If you select the [Close this window when save completes] check box above, the 
[Scan to Google Docs(TM)] dialog box will automatically close from next scanning on 
when the saving is completed.

Google Docs does not start up after the saving has completed. To check the saved PDF file, 
start a web browser and log in to Google Docs.
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Actions (for Windows users)
Without using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Google Docs(TM)].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 73).

ScanSnap Manager can also link with [Scan to Google Docs(TM)] when you select:
[Scan to Google Docs(TM)] from the [Profile] drop-down list of the ScanSnap setup dia-
log box
[Scan to Google Docs (TM)] from the Left-Click Menu
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Actions (for Windows users)
3. Change the settings for [Scan to Google Docs(TM)] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Google Docs(TM)- Options] dialog box appears.

2. Change the settings.
For details about the [Scan to Google Docs(TM) - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Google Docs(TM) - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

If the computer is shared with other users, do not enter your information in [Email] 
and [Password] in this dialog box. Otherwise, other users will be able to log into 
Google Docs automatically.
It is recommended to set only [Email] in this dialog box, and type in the password 
every time.
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Actions (for Windows users)
6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

If you did not specify a Google account in the [Scan to Google Docs(TM) - Options] 
dialog box in step 3., the [Scan to Google Docs(TM)] dialog box appears. To 
continue, enter your e-mail address and password, and click the [OK] button.

When you perform a scan with [JPEG(*.jpg)] selected for [File format] in the [File 
option] tab of the ScanSnap setup dialog box, a PDF file is created from the JPEG 
file. A separate PDF file is created for each JPEG file.

     The following dialog box is displayed when the PDF file is being created.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

If the computer is shared with other users, do not select the [Save account infor-
mation] check box in this dialog box. Otherwise, other users will be able to log into 
Google Docs automatically.
Scan to Google Docs is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Windows users)
If the [Convert to Searchable PDF] check box is selected in the [Scan to Google 
Docs(TM) - Options] dialog box in step 3., text recognition is performed according to 
the [OCR options] settings in the [Scan to Google Docs(TM) - Options] dialog box. 

     The following dialog box is displayed during text recognition.

Saving to Google Docs starts. Click the [Close] button to close the [Scan to Google 
Docs(TM)] dialog box when the saving is completed.

If you select the [Close this window when save completes] check box above, the 
[Scan to Google Docs(TM)] dialog box will automatically close from next scanning on 
when the saving is completed.

Text recognition will be performed if there are any pages containing text which is not 
yet recognized. Note that text recognition will be performed on those pages only.

Google Docs does not start up after the saving has completed. To check the saved PDF file, 
start a web browser and log in to Google Docs.
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Actions (for Windows users)
■ Posting to Salesforce Chatter

This section explains how to post the scanned image as a PDF or a JPEG file to Salesforce 
Chatter.

For details about the procedure to scan and post the scanned image to Salesforce Chatter 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 190)
Without Using the Quick Menu (→ page 195)

A Salesforce CRM lisence is required separately.
ScanSnap Manager can link with the following Salesforce editions:
- Unlimited
- Enterprise

You need to have .NET Framework 3.0 installed in order to use this function.
Note that .NET Framework 3.0 is also included in .NET Framework 3.5 (SP1 or later).
It is recommended that you use .NET Framework 3.5 (SP1 or later) by updating Windows.
If .NET Framework 4.0 or later is already installed, you need to install .NET Framework 3.0 
separately because .NET Framework 3.0 is not included in the .NET Framework 4.0 or later 
version.
A maximum of 100 scanned image files can be posted to Salesforce Chatter at once.

JPEG
PDF
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Actions (for Windows users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to Salesforce Chatter] (If you do not want 
to change any settings, go to step 5.).

1. Move the mouse cursor to the  mark on the [Scan to Salesforce Chatter] icon, and 
then select the [Settings] menu.

The [Scan to Salesforce Chatter - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 67).

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Windows users)
2. Change the settings.
For details about the [Scan to Salesforce Chatter - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Salesforce Chatter - Options] dialog box.

5. Click the [Scan to Salesforce Chatter] icon.

If the computer is shared with other users, do not set your information in [User 
Name], [Password] and [Security Token]. Otherwise, other users will be able to log 
into Salesforce automatically.
It is recommended to set only [User Name] and [Security Token] in this dialog box, 
and type in the password every time. 
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Actions (for Windows users)
If you did not specify a Salesforce account in the [Scan to Salesforce Chatter - 
Options] dialog box in step 4., the [Scan to Salesforce Chatter - Login] dialog box 
appears. To continue, enter your user name and password, and click the [OK] 
button. Enter a security token if needed.

The [Scan to Salesforce Chatter] dialog box appears.

If the computer is shared with other users, do not select the [Save user account 
information.] check box in this dialog box.
Otherwise, other users will be able to log into Salesforce automatically.
Scan to Salesforce Chatter is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Windows users)
6. Check the scanned image in the preview area.

In the [Scan to Salesforce Chatter] dialog box, you can set the posting destination and 
method, the message to post, the name and description of the image file that will be 
posted to Salesforce Chatter, and save the scanned image in the folder specified for 
[Image saving folder].
For details about the [Scan to Salesforce Chatter] dialog box, refer to the ScanSnap 
Manager Help.

Preview
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Actions (for Windows users)
7. Click the [Post] button.

Posting to Salesforce Chatter starts. Click the [Close] button to close the [Scan to 
Salesforce Chatter] dialog box when the posting is completed.

If you select the [Close this window when posting completes] check box above, the 
[Scan to Salesforce Chatter] dialog box will automatically close from next scanning 
on when the posting is completed.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Salesforce Chatter] dialog box is closed. Close the [Scan to Salesforce Chatter] dialog 
box before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

Salesforce does not start up after the posting has completed. To check the saved scanned 
image file, start a web browser and log in to Salesforce.
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Actions (for Windows users)
Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to  "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Salesforce Chatter].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to  "Without Using 
the Quick Menu" (page 73).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected from the [Profile] drop-down list or Left-Click Menu next time you 
perform a scan.
For details about how to add a profile, refer to  "Profile Management" (page 85).
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Actions (for Windows users)
3. Change the settings for [Scan to Salesforce Chatter] (If you do not want 
to change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Salesforce Chatter - Options] dialog box appears.

2. Change the settings.
For details about the [Scan to Salesforce Chatter - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Salesforce Chatter - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

If the computer is shared with other users, do not set your information in [User 
Name], [Password] and [Security Token]. Otherwise, other users will be able to log 
into Salesforce automatically.
It is recommended to set only [User Name] and [Security Token] in this dialog box, 
and type in the password every time. 
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Actions (for Windows users)
6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

If you did not specify a Salesforce account in the [Scan to Salesforce Chatter - 
Options] dialog box in step 3., the [Scan to Salesforce Chatter - Login] dialog box 
appears. To continue, enter your user name and password, and click the [OK] 
button. Enter a security token if needed.

The [Scan to Salesforce Chatter] dialog box appears.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

If the computer is shared with other users, do not select the [Save user account 
information.] check box in this dialog box.
Otherwise, other users will be able to log into Salesforce automatically. 
Scan to Salesforce Chatter is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Windows users)
8. Check the scanned image in the preview area.

In the [Scan to Salesforce Chatter] dialog box, you can set the posting destination and 
method, the message to post, the name and description of the image file that will be 
posted to Salesforce Chatter, and save the scanned image in the folder specified for 
[Image saving folder].
For details about the [Scan to Salesforce Chatter] dialog box, refer to the ScanSnap 
Manager Help.

Preview
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Actions (for Windows users)
9. Click the [Post] button.

Posting to Salesforce Chatter starts. Click the [Close] button to close the [Scan to 
Salesforce Chatter] dialog box when the posting is completed.

If you select the [Close this window when posting completes] check box above, the 
[Scan to Salesforce Chatter] dialog box will automatically close from next scanning 
on when the posting is completed.

You cannot start scanning when the [Scan to Salesforce Chatter] dialog box is 
displayed. Close the dialog box before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
[Scan to Salesforce Chatter] dialog box is displayed.

Salesforce does not start up after the posting has completed. To check the saved scanned 
image file, start a web browser and log in to Salesforce.
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Actions (for Windows users)
■ Saving Data to Your SugarSync Folder

This section explains how to save the scanned image as a PDF or a JPEG file to your 
SugarSync folder.

For details about the procedure to scan and save the scanned image to your SugarSync 
folder using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 201)
Without Using the Quick Menu (→ page 204)

You need to have a SugarSync account.
You need to have SugarSync Manager for Windows 1.9.28 or later installed in order to use 
this function. 
You can save up to 100 files to your SugarSync folder at once.

When you first log into SugarSync after installing SugarSync Manager for Windows, the Magic 
Briefcase, which is a sync folder used for SugarSync, is automatically created.

JPEG
PDF
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Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to SugarSync] (If you do not want to 
change any settings, go to step 5.

1. Move the mouse cursor to the  mark on the [Scan to SugarSync] icon, and then 
select the [Settings] menu.

The [Scan to SugarSync - Options] dialog box appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to  "Using the Quick 
Menu" (page 67).

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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2. Change the setting.
For details about the [Scan to SugarSync - Options] dialog box, refer to ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to SugarSync - Options] dialog box.

5. Click the [Scan to SugarSync] icon.

The [Scan to SugarSync] dialog box appears.
If you clear the [Show preview] check box in step 4., scanned image is directly saved 
to your SugarSync folder.
202



Actions (for Windows users)
6. Check the scanned image in the preview area.

In the [Scan to SugarSync] dialog box, you can rename the file and specify your 
SugarSync folder.
For details about the [Scan to SugarSync] dialog box, refer to the ScanSnap Manager 
Help.

7. Click the [Save] button.

The scanned image is saved to your SugarSync folder.

The file will not be synced with SugarSync unless you select a SugarSync folder as the 
destination folder.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
SugarSync] dialog box is closed. Close the [Scan to SugarSync] dialog box before 
scanning the next document.
Do not move, delete or rename the scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to SugarSync] dialog box is closed.

Preview
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Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to  "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to SugarSync].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to  "Without Using 
the Quick Menu" (page 73).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected from the [Profile] drop-down list or the Left-Click Menu next time 
you perform a scan.
For details about how to add a profile, refer to  "Profile Management" (page 85).
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3. Change the settings for [Scan to SugarSync] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to SugarSync - Options] dialog box appears.
2. Change the settings.

For details about the [Scan to SugarSync - Options] dialog box, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to SugarSync - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [Scan to SugarSync] dialog box appears when the scanning is completed.
If you clear the [Show preview] check box in step 3., scanned image is directly saved 
to your SugarSync folder.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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8. Check the scanned image in the preview area.

In the [Scan to SugarSync] dialog box, you can rename the file and specify your 
SugarSync folder.
For details about the [Scan to SugarSync] dialog box, refer to the ScanSnap Manager 
Help.

9. Click the [Save] button.

The scanned image is saved to your SugarSync folder.

The file will not be synced with SugarSync unless you select a SugarSync folder as the 
destination folder.

You cannot start scanning when the [Scan to SugarSync] dialog box is displayed. Close 
the dialog box before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the 
[Scan to SugarSync] dialog box is displayed.

Preview
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Actions (for Windows users)
■ Saving Data to a Mobile Device

This section explains how to save the scanned image as a PDF or a JPEG file to a mobile 
device.

Only one mobile device can be connected to the computer.
You need to have .NET Framework 3.0 installed in order to use this function.
Note that .NET Framework 3.0 is also included in .NET Framework 3.5 (SP1 or later).
It is recommended that you use .NET Framework 3.5 (SP1 or later) by updating Windows.
If .NET Framework 4.0 or later is already installed, you need to install .NET Framework 3.0 
separately because .NET Framework 3.0 is not included in the .NET Framework 4.0 or later 
version.
You need to have ScanSnap Connect Application installed in the mobile device in order to 
use this function. Download ScanSnap Connect Application for mobile devices from 
application stores such as App Store. 
ScanSnap Connect Application for mobile devices operate on the following operating 
systems:
- iOS 4.2.1 or later

The number of scanned image files and the maximum file size that can be saved on a mobile 
device at once are as follows:
- Number of files: Up to 100
- File size: 2048 MB

A firewall alert may be displayed when you first launch [Scan to Mobile]. When the alert is 
displayed, select [Allow access] or [Unblock].
207



Actions (for Windows users)
For details about the procedure to save scanned images to mobile devices through automatic 
linkage, and using or without using the Quick Menu, refer to the following:

Automatic Linkage (→ page 209)
Using the Quick Menu (→ page 211)
Without Using the Quick Menu (→ page 215)

The following message appears when you first launch [Scan to Mobile]. Click the [OK] button 
to open the [Scan to Mobile - Basic] dialog box. 

In the [Scan to Mobile - Basic] dialog box, enter a password to connect to the mobile device. 
For details about other setting items, refer to the Scan to Mobile Help. 

The Scan to Mobile icon appears on the taskbar when the file is saved to the mobile device.
In Windows 7, the Scan to Mobile icon is displayed in the menu that appears when you click 

 on the taskbar.
The Scan to Mobile icon shows the communication status between the computer and the 
mobile device. The appearance of the icon changes according to the communication status 
as shown below.

Status Scan to Mobile icon

Waiting

Standby

Sending

Sending error

Rejected
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Actions (for Windows users)
Automatic Linkage

1. Select [Start] menu → [All Programs] → [ScanSnap Manager] → [Scan to 
Mobile].

The Scan to Mobile icon  appears on the taskbar.

2.  Connect to the computer from your mobile device.

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User's Guide (iOS).

When the connection is established, the [Scan to Mobile] dialog box appears on the 
computer, showing the mobile device that is currently connected to the computer.

3. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

For details about the features of ScanSnap Connect Application for mobile devices and how 
to use it, refer to the ScanSnap Connect Application User's Guide (iOS).
For details about automatic linkage with active applications, refer to  "Automatic Linkage with 
Applications" (page 94).
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4. Press the [Scan/Stop] button on the ScanSnap to start scanning.

5. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Scanned images will be sent to the mobile device from the computer.

6. Click the [Close] button to close the [Scan to Mobile] dialog box when 
sending of the scanned image is completed.

To enable automatic linkage with Scan to Mobile, press the [Scan/Stop] button on the 
ScanSnap and start scanning while Scan to Mobile is active (when this application is 
currently selected on the taskbar and the [Scan to Mobile] dialog box is brought to front).

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

When you select the [Wait until the [Send] button is clicked] check box in the [Scan to Mobile - 
Basic] dialog box, the [Send] button appears in the [Scan to Mobile] dialog box. Click the [Send] 
button to send the image to the mobile device.

The [Scan to Mobile] dialog box closes automatically when the mobile device is disconnected 
from the computer.
210



Actions (for Windows users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

To use the Quick Menu, you need to select the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning by using the Quick Menu, refer to  "Using the Quick 
Menu" (page 67).

When [Scan to Mobile] has already started and is active (with the application selected on 
the taskbar and the [Scan to Mobile] dialog box brought to front), ScanSnap Manager links 
with [Scan to Mobile] automatically and the Quick Menu does not appear.
To display the Quick Menu, minimize the [Scan to Mobile] dialog box first, and then try 
scanning again.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Windows users)
4. Change the settings for [Scan to Mobile] (If you do not want to change 
any settings, go to step 5.)

1. Move the mouse cursor to the  mark on the [Scan to Mobile] icon, and then select 
the [Settings] menu.

The [Scan to Mobile - Options] dialog box appears.
2. Change the setting.

For details about the [Scan to Mobile - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Mobile - Options] dialog box.
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Actions (for Windows users)
5. Click the [Scan to Mobile] icon.

The [Scan to Mobile] dialog box appears.

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap 
Manager links with Scan to Mobile before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Windows users)
6. Connect to the computer from your mobile device.

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User's Guide (iOS).

When the connection is established, the [Scan to Mobile] dialog box appears, 
showing the mobile device that is currently connected to the computer. Then, the 
scanned image is sent to the mobile device.

7. Click the [Close] button to close the [Scan to Mobile] dialog box when 
the sending of the scanned image is completed.

When you select the [Wait until the [Send] button is clicked] check box in the [Scan to 
Mobile - Basic] dialog box, the [Send] button appears in the [Scan to Mobile] dialog box. 
Click the [Send] button to send the image to the mobile device.
For details about the features of ScanSnap Connect Application for mobile devices and 
how to use it, refer to the ScanSnap Connect Application User's Guide (iOS).

The [Scan to Mobile] dialog box closes automatically when the mobile device is 
disconnected from the computer.
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Actions (for Windows users)
Without Using the Quick Menu

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to  "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Application] drop-down list in the [Application] tab, select [Scan 
to Mobile].

To disable the Quick Menu, you need to clear the [Use Quick Menu] check box in the ScanSnap 
setup dialog box.
For details about how to perform scanning without using the Quick Menu, refer to  "Without Using 
the Quick Menu" (page 73).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected from the [Profile] drop-down list or Left-Click Menu next time you 
perform a scan.
For details about how to add a profile, refer to  "Profile Management" (page 85).
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Actions (for Windows users)
3. Change the settings for [Scan to Mobile] (If you do not want to change 
any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Mobile - Options] dialog box appears.

2. Change the setting.
For details about the [Scan to Mobile - Options] dialog box, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Mobile - Options] dialog box.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Windows users)
7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [Scan to Mobile] dialog box appears on the computer.

8. Connect to the computer from your mobile device.

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User's Guide (iOS).

When the connection is established, the [Scan to Mobile] dialog box appears, 
showing the mobile device that is currently connected to the computer. Then, the 
scanned image is sent to the mobile device.

When you select the [Wait until the [Send] button is clicked] check box in the [Scan to 
Mobile - Basic] dialog box, the [Send] button appears in the [Scan to Mobile] dialog box. 
Click the [Send] button to send the image to the mobile device.
For details about the features of ScanSnap Connect Application for mobile devices and 
how to use it, refer to the ScanSnap Connect Application User's Guide (iOS).
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Actions (for Windows users)
9. Click the [Close] button to close the [Scan to Mobile] dialog box when 
the sending of the scanned image is completed.

The [Scan to Mobile] dialog box closes automatically when the mobile device is 
disconnected from the computer.
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Using the ScanSnap in Various Ways (for Windows users)
Using the ScanSnap in Various Ways

This section explains about various ways of using the ScanSnap.

■ Scanning Color Documents in Gray or Black & White 
Mode

When [Auto color detection] is specified for [Color mode] in the [Scanning] tab of the 
ScanSnap setup dialog box, the ScanSnap automatically recognizes whether the scanned 
document is color, gray or black & white, and saves the documents in their respective color 
modes.
If you want to scan and save color documents in gray or black & white, change the settings in 
the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Color mode] drop-down list in the [Scanning] tab, select [Gray] or 
[B&W].
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Using the ScanSnap in Various Ways (for Windows users)
3. Click the [OK] button to close the ScanSnap setup dialog box.

4. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

5. Press the [Scan/Stop] button on the ScanSnap to start scanning.

6. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Image data is saved in gray or black & white.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Using the ScanSnap in Various Ways (for Windows users)
■ Scanning Color Documents in High Compression 
Mode

The ScanSnap can save image data of color documents in high compression mode. You can 
scan large quantities of color documents in high compression mode and save them as a 
compact PDF file.
To scan color documents in high compression mode, perform the following steps to change 
the setting.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Color mode] drop-down list in the [Scanning] tab, select [Color 
high compression].

3. Click the [OK] button to close the ScanSnap setup dialog box.

In [Color high compression] mode, different compression rates are applied to characters and 
backgrounds. Therefore, the file size of a document with mostly text characters is reduced, while 
the quality of the characters is kept high. However, high compression is applied to photographs 
and figures since they are regarded as backgrounds, resulting in deteriorated image data. For 
this reason, this mode is not appropriate for scanning photographs, images and such.
221



Using the ScanSnap in Various Ways (for Windows users)
4. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

5. Press the [Scan/Stop] button on the ScanSnap to start scanning.

6. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The scanned document is saved as highly compressed color image data.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Using the ScanSnap in Various Ways (for Windows users)
■ Correcting Skewed Character Strings

When documents with skewed character strings are scanned, the ScanSnap is able to detect 
the skewed character strings and correct them.
To correct skewed character strings, change the settings in the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

Up to +/-5 degrees of skew can be corrected.
Since this option is performed assuming that the document contains a certain amount of text, 
character strings may be adjusted at a wrong angle when scanning the following types of 
documents. In that case, clear the [Correct skewed character strings automatically] check 
box: 
- Documents on which pitches between lines or characters are extremely narrow, or 

characters are overlapped
- Documents with many outlined or decorated characters
- Documents with many photographs or figures and few characters
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with characters printed in various directions such as drawings
- Documents with long diagonal lines
- Documents including handwritten characters.

This setting is disabled when you perform a scan using the Carrier Sheet. 

You do not have to enable [Correct skewed character strings automatically] when [Automatic 
detection] is specified for [Paper size] in the [Paper] tab of the ScanSnap setup dialog box 
because the skewed image is always corrected when documents are scanned by this setting.
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Using the ScanSnap in Various Ways (for Windows users)
2. Click the [Option] button in the [Scanning] tab.

The [Scanning mode option] dialog box appears.

3. Select the [Correct skewed character strings automatically] check box.

4. Click the [OK] button to close all open dialog boxes.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).
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Using the ScanSnap in Various Ways (for Windows users)
6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Image data is saved with skewed character strings corrected.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Using the ScanSnap in Various Ways (for Windows users)
■ Correcting the Orientation of Scanned Images

In an office environment, it is often the case that a single batch contains same size documents 
of different page orientations.
The ScanSnap is able to automatically rotate each scanned image to its correct orientation for 
such document batches.
To rotate scanned images to their correct orientations, change the settings in the following 
procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

Since this option determines the document’s page orientation based on the character strings 
printed on the document, the following types of documents may be rotated to the wrong 
orientation. In that case, clear the [Allow automatic image rotation] check box.

Documents with many extremely large or small characters
Documents on which pitches between lines or characters are extremely narrow, or characters 
are overlapped
Documents with many characters contacting underlines or borders
Documents with many photographs or figures and few characters
Documents with characters on an unevenly colored background
e.g. Shaded characters
Documents with many decorated characters
e.g. Decorated characters (embossed/outlined)
Documents with characters on a patterned background
e.g. Characters overlapping illustrations and diagrams
Documents with characters printed in various directions such as drawings
Documents written using only capital letters
Documents including handwritten characters
Skewed documents
Documents written in an unsupported language (language other than Japanese/English/
French/German/Italian/Spanish/Chinese (simplified)/Chinese (traditional)/Korean/Russian/
Portuguese)
Documents with complex layouts
Documents with a large amount of image noise
Documents with faint characters
Documents with faded characters
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Using the ScanSnap in Various Ways (for Windows users)
2. Click the [Option] button in the [Scanning] tab.

The [Scanning mode option] dialog box appears.

3. Select the [Allow automatic image rotation] check box.

4. Click the [OK] button to close all open dialog boxes.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).
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6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The scanned image is saved in the correct orientation.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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■ Scanning Documents Larger Than A4/Letter Size 

You can scan documents larger than A4/Letter size such as A3, 11 × 17 in. and B4 using the 
Carrier Sheet (sold separately). By folding the document in half and scanning both sides 
consecutively in simplex mode, the two sides are merged into a single image and saved.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then 
click the [Carrier Sheet Settings] button.

The [Carrier Sheet Settings] dialog box appears.

In the [Scanning mode option] dialog box ([Scanning] tab → [Option] button in the ScanSnap 
setup dialog box), the [Correct skewed character strings automatically] check box is disabled.

You can also scan documents smaller than A4/Letter size and have both sides saved as a single 
image.
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Using the ScanSnap in Various Ways (for Windows users)
3. Select [one double-page spread image] in [Save as].

For details about the Carrier Sheet settings, refer to the ScanSnap Manager Help.

4. Click the [OK] button to close all the dialog boxes.

5. Place the document inside the Carrier Sheet.

1. Fold the document in half so that the sides to be scanned are facing out.
Fold it tightly and smooth out any creases.
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2. Open the Carrier Sheet and place the document inside.
Align the fold line with the right edge of the 
Carrier Sheet so that the document fits in 
the upper right-hand corner of the Carrier 
Sheet.

6. Insert the part with the black and white pattern straight into the feeding 
section of the ScanSnap, with the front side of the Carrier Sheet facing 
up. 

                   
The Carrier Sheet is pulled in until it is set inside the ScanSnap.

Note that the front side of the Carrier Sheet has a thick vertical line in 
the upper right-hand corner.

If you perform a scan using the Carrier Sheet with the 
output guide open, a paper jam may occur and damage the 
documents. Make sure to close the output guide when you 
perform a scan using the Carrier Sheet.

Output guide
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7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

Scanning starts and the [ScanSnap Manager - Image scanning and file saving] 
dialog box appears. When the front side of the Carrier Sheet is scanned, the image 
data is displayed in the preview area.

8. Turn over the Carrier Sheet and insert it as explained in step 6.

Scanning starts automatically and the [ScanSnap Manager - Image scanning and file 
saving] dialog box appears. When the back side of the Carrier Sheet is scanned, 
scanned images of the front and back side of the document inside the Carrier Sheet 
are displayed as a double-page spread image in the preview area.

Make sure to scan the front and back side of the Carrier Sheet consecutively.

Repeat steps 5. to 8. to scan more documents larger than A4/Letter size.
You can continue with scanning documents that can be set directly in the ScanSnap. For 
details about how to load documents, refer to  "How to Load Documents" (page 31).
Scanning starts automatically when a document is loaded in the ScanSnap.
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9. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The scanned images of the front and back side of 
the document inside the Carrier Sheet are saved as 
a double-page spread image.

There may be a line or a gap appearing between the front and back side images. Also when 
you scan thick papers, images on both left and right may skew towards each other from the 
top.
The degree of these symptoms varies depending on how the document was set or folded.
In that case, try the following for possible resolutions:
- Fold the document properly
- Neatly align the edges of the document with the edges of the Carrier Sheet when placing 

the document inside the Carrier Sheet
When [Automatic detection] is selected from the [Paper size] drop-down list in the [Carrier 
Sheet Settings] dialog box, the image is output in an optimal size selected automatically from 
the available standard sizes (A3, B4 or 11 × 17 in.) in the [Paper size] dialog box. However, 
depending on the document, the size of the saved image data may be smaller than the origi-
nal document or some parts of the image may be missing.
Example: When you scan an A3 size document with an A4 size image printed in the center, 

image data is saved in B4 size.
To save an image data in the actual size of the document, specify the document size in the 
[Paper size] drop-down list.
Part of the image data around where the document is folded may appear missing. In that 
case, place the document so that its edge is about 1 mm inside from the edge of the Carrier 
Sheet.
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■ Scanning Documents Such as Photographs and 
Clippings

Using the Carrier Sheet allows you to scan documents that can be damaged quite easily such 
as photographs, or non-standard size documents that are difficult to load directly such as 
clippings.
Change the settings to scan documents such as photographs and clippings in the following 
procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then 
click the [Carrier Sheet Settings] button.

The [Carrier Sheet Settings] dialog box appears.

In the [Scanning mode option] dialog box ([Scanning] tab → [Option] button in the ScanSnap 
setup dialog box), the [Correct skewed character strings automatically] check box is disabled.
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3. Select [two separate images (front and back)] in [Save as].

For details about the Carrier Sheet settings, refer to the ScanSnap Manager Help.

4. Click the [OK] button to close all open dialog boxes.

5. Place the document inside the Carrier Sheet.

Open the Carrier Sheet and place the top of the 
document against the top center of the Carrier Sheet. 
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6. Insert the part with the black and white pattern straight into the feeding 
section of the ScanSnap, with the scanning side of the document inside 
the Carrier Sheet facing up.

                     

The Carrier Sheet is pulled in until it is set inside the ScanSnap.

7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

When scanning is completed, the scanned image of the document inside the Carrier 
Sheet is displayed in the preview area.

If you perform a scan using the Carrier Sheet with the 
output guide open, a paper jam may occur and damage the 
documents. Make sure to close the output guide when you 
perform a scan using the Carrier Sheet.

Repeat step 5. to 6. to scan more documents such as photographs and clippings.
You can continue with scanning documents that can be set directly in the ScanSnap. For 
details about how to load documents, refer to "How to Load Documents" (page 31).
Scanning starts automatically when documents are loaded in the ScanSnap.

Output guide
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8. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Scanned image is saved.

The scanned image is output at the center of the page in the size specified in the 
[Paper size] drop-down list of the [Carrier Sheet Settings] dialog box.
When [Automatic detection] is specified in the [Paper size] drop-down list of the [Car-
rier Sheet Settings] dialog box, the image is output in an optimal size selected auto-
matically from the available standard sizes in the [Paper size] drop-down list. 
However, depending on the document, the size of the saved image data may be 
smaller than the original document or part of the image may be missing.
Example: When you scan an A5 size image printed in the middle of an A4 size 

document, the scanned image is saved in A5 size.
To save the scanned image in its original size, specify the document size in the [Paper 
size] drop-down list.

Place the document over a blank sheet if the following is observed:
Scanned image is not saved in the same size as the document (when [Automatic 
detection] is specified in the [Paper size] drop-down list of the [Carrier Sheet Settings] 
dialog box)
There are shadows around the edges of the scanned image
There are black lines around the scanned image of a uniquely shaped cutting

Blank sheet
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■ Long Page Scanning

Documents up to 863 mm (34 in.) in length can be scanned.
The following explains how to scan long pages.

1. Insert the document straight into the feeding section of the ScanSnap, 
with the scanning side facing up.

 

The document is pulled in until it is set inside the ScanSnap.

Secure enough space where the 
document exits the ScanSnap, and pick 
up the document with your hands to 
prevent it from falling off the unit where 
the ScanSnap is placed on.
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2. Press the [Scan/Stop] button on the ScanSnap for three seconds or 
longer until it flashes in blue.

Scanning starts.

When you scan the first page as a long page and continue scanning, the next document 
is also scanned as long page.

The error message below appears and long page scanning is disabled when 
[Excellent] is selected in the [Image quality] drop-down list of the [Scanning] tab in the 
ScanSnap setup dialog box.

When you perform a long page scan, the setting for [Paper size] in the [Paper] tab of 
the ScanSnap setup dialog box automatically switches to [Automatic detection]. The 
current settings are used for other scan settings.
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■ Saving Scanned Images in Multiple PDF Files

The ScanSnap is able to save scanned image in separate PDF files based on the specified 
number of pages. For example, you can scan a batch of slips, and save each slip as a PDF 
file.
To save image data in multiple PDF files, change the settings in the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears. 

2. From the [File format] drop-down list in the [File option] tab, select [PDF 
(*.pdf)], and then click the [Option] button.

The [PDF file format option] dialog box appears.
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3. Select [Generate one PDF file per (n) page(s)] and enter the number of 
pages to split.

One PDF is created every time the number of pages specified here has been saved.

4. Click the [OK] button to close all open dialog boxes.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

One PDF file is created every time the number of pages specified in step 3. has been 
scanned.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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■ Creating Searchable PDF Files

The ScanSnap is able to perform text recognition on a scanned image automatically and 
create a searchable PDF file.
To create searchable PDF files, change the settings in the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. From the [File format] drop-down list in the [File option] tab, select [PDF 
(*.pdf)].

It is recommended that you select [Better] or [Best] for [Image quality] in the [Scanning] tab 
of the ScanSnap setup dialog box.
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3. Select the [Convert to Searchable PDF] check box.

The following message appears.

Click the [OK] button to close the dialog box.

Language
Select the language. Japanese, English, French, German, Italian, Spanish, Chinese 
(simplified), Chinese (traditional), Korean, Russian, and Portuguese can be selected.
Target pages
Select [All pages] to perform text recognition for all pages and [First page] for just the 
first page.

4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Text recognition is performed on the scanned image and a searchable PDF file is 
created.

It may take extra time to process text recognition depending on your computer system 
environment when you enable this setting in step 3. 
Scanned images of the following types of documents (characters) may not be recog-
nized correctly.
In that case, better results in text recognition may be achieved by changing the setting 
for [Color mode] or specifying a higher resolution in [Image quality].
- Documents including handwritten characters
- Documents with small characters scanned at a low resolution
- Skewed documents
- Documents written in languages other than the specified language
- Documents including texts written in italic characters
- Documents containing characters with superscripts/subscripts and complicated 

mathematical expressions 
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders

It may take extra time to perform text recognition on the following documents: 
- Documents with complex layouts 
- Documents with information other than text

e.g. Text on a shaded background
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■ Automatically Setting Keywords for PDF Files

If the document is black & white, character strings (e.g. page heading, title) can be set as 
keywords and used for a PDF file search. 
Mark a character string to be set as a keyword with a water-based highlight pen so that the 
character string is completely covered. 
When you perform a scan, the marked character strings are recognized and set as keywords 
for the PDF file.

Mark black & white documents in the following way:
Any regular highlight pen can be used. 
The following shows the colors and thickness recommended for highlight pens:

Mark a straight line over a single character string.
The supported range of a marked section is as follows: 
Minimum : 3 mm (short side) × 10 mm (long side) 
Maximum : 20 mm (short side) × 150 mm (long side) 
Use only one color per page for marking.

Pink Yellow Blue Green

Scan

Scan

Scan Scan

Sets text as a keyword for 
the PDF file

Searchable PDF file

ImageConverts a character string in 
a marked section into text

Keyword

You can search for the file through 
the set keyword
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Make sure to cover the entire character string when marking it. 
Mark sections so that the entire section is evenly colored.

Do not mark more than ten sections per page.

Good example: Bad example 1:
(does not cover the entire section)

Bad example 2:
(unevenly colored)

It is recommended that you use a blue or a green highlight pen for marking. When you use 
colors such as pink or yellow for marking, the marked sections may not be recognized as 
keywords.
Use a blue highlight pen for documents with dark background colors such as newspapers. 
Marked sections may not be detected when a color other than blue is used.
For the following document types, marked sections cannot be recognized and set as key-
words:
- Color documents such as catalogues or pamphlets 
- Documents in which two or more colors are used for marking 
- Documents containing colors other than for marking (pens other than highlight pens are 

used or the document is stained) 
- Documents with too many marked sections on a single page

The following types of marked character strings cannot be set as keywords:
- The size of marked section is outside the supported range 
- The marking is irregular (e.g. skewed) 
- Multiple marked sections are too close to each other 
- The color of the highlight pen is too pale or the color has faded 

When you mark more than one character string, make sure to leave a gap of at least 5 mm 
between the marked sections.Marked sections that are too close to each other may be 
detected as one marked section.
In the following case, character strings surrounding marked sections may be set as key-
words: 
- Marked section overlaps the line above and below 

In the following cases, unmarked character strings may be set as keywords:
- Color documents such as catalogues or pamphlets 
- Documents with color text, diagrams, pictures, tables and lines
- Documents containing sections framed by a highlight pen
- Stained documents

Increase the resolution when you have trouble setting the keywords correctly.
Keywords set for a PDF file can be checked in the ScanSnap Organizer Main Window 
(thumbnail view), or in [Document Properties] of Adobe Acrobat / Adobe Reader.
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Change the settings in the following procedure to automatically set keywords for PDF files. 

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. From the [File format] drop-down list in the [File option] tab, select [PDF 
(*.pdf)].

It is recommended that you select [Better] or [Best] for [Image quality] in the [Scanning] tab 
of the ScanSnap setup dialog box.
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3. Select the [Set the marked text as a keyword for the PDF file] check box.

Target marked sections
Select [First marked section] to perform text recognition and set a keyword for the 
PDF file only for the character strings in the first marked section, and [All marked 
sections] for all marked sections.

Language
Select the language. Japanese, English, French, German, Italian, Spanish, Chinese 
(simplified), Chinese (traditional), Korean, Russian, and Portuguese can be selected.
Target pages
Select [First page] to perform text recognition and set a keyword for the PDF file only 
for the first page, and [All pages] for all pages.

Do not select [First marked section] when the text orientation of your document is 
vertical.

The following explanation is for when you select [First marked section]:
Select this button to set a character string such as a title of a document as a key-
word for the PDF file.
Example: When only the title of a document is marked, the marked character 

string is set as a keyword for the PDF file, and the PDF file becomes 
searchable by the title character string.

When multiple marked sections exist in line, the marked character string closest to 
the top of the document is set as a keyword. 
Example: In the following case, the character string in marked section B, which is 

higher than marked section A, is set as a keyword.

Marked section A Marked section B
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4. Click the [OK] button to close the ScanSnap setup dialog box.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Text recognition is performed on marked character strings and a PDF file is created 
with the keywords added.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

It may take extra time to process text recognition depending on your computer system 
environment when you enable this setting in step 3. 
Scanned images of the following types of documents (characters) may not be recog-
nized correctly. 
In that case, better results in text recognition may be achieved by specifying a higher 
resolution in [Image quality].
- Documents including handwritten characters
- Documents with small characters scanned at a low resolution
- Skewed documents
- Documents written in languages other than the specified language
- Documents including texts written in italic characters
- Documents containing characters with superscripts/subscripts and complicated 

mathematical expressions 
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders

It may take extra time to perform text recognition on the following documents: 
- Documents with complex layouts 
- Documents with information other than text

e.g. Text on a shaded background
If the same character string is marked several times in the document, the same keyword 
is added multiple times in the PDF file.
Total length of all the keywords can be up to 255 characters, including punctuation 
marks in between keywords.
When you check keywords in Adobe Acrobat or Adobe Reader, the added keywords 
may be displayed with a set of quotation marks (e.g. "ABC").
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■ Setting Document Open Passwords for PDF Files

You can set Document Open passwords for PDF files when saving the image data as PDF 
files.
Once you set a password for a PDF file, the password-protected PDF files cannot be opened 
by anyone except the person who knows the password. You can protect important information 
by setting a password for private or confidential documents.
Change the settings to set passwords for PDF files in the following procedure.

1. Select [Scan Button Settings] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).
The ScanSnap setup dialog box appears.

2. In the [File format] drop-down list in the [File option] tab, select [PDF 
(*.pdf)], and then click the [Option] button.

The [PDF file format option] dialog box appears.

When you use the Quick Menu, you cannot set passwords to scanned documents.
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3. Select the [Set a password for PDF file] check box.

To set a different password per scan
Clear the [Use a fixed password] check box.
You can set a different password per scan.
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To use a preset password
1. Select the [Use a fixed password] check box.

The same password is set for all PDF files. You do not have to set a password every 
time a document is scanned.

2. Type in the same password in the [Password] and [Confirm] fields.

4. Click the [OK] button to close all open dialog boxes.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

The following characters can be used to set passwords:
Up to 16 characters
Alphanumeric characters: A-Z, a-z, 0-9
Symbols: ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~
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6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

When the [Use a fixed password] check box is cleared in step 3., the following dialog 
box appears after scanning is completed.

Type in the same password in the [Password] and [Confirm] fields, and then click the 
[OK] button.

The scanned image is saved as a password-protected PDF file.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

The following characters can be used to set passwords:
Up to 16 characters
Alphanumeric characters: A-Z, a-z, 0-9
Symbols: ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~
If you click the [Cancel] button, the PDF file is saved without a password.

It is not possible to open a PDF file if you forget the password.
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This chapter explains how to perform scanning, configure scan settings, add, change or 
delete profiles, as well as various scanner functions and uses.

ScanSnap Manager Icon and Operations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 255

How to Perform a Scan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259

Configuring ScanSnap Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270
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Using the ScanSnap in Various Ways . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 388
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ScanSnap Manager Icon and Operations

All operations on the ScanSnap are managed in ScanSnap Manager.
The ScanSnap Manager icon appears in the Dock to indicate that ScanSnap Manager is 
running. The icon automatically appears in the Dock when Mac OS starts up.
The ScanSnap Manager icon indicates whether or not ScanSnap Manager is successfully 
communicating with the ScanSnap. The appearance of the icon changes according to the 
communication status as shown below.

A menu is displayed when you click the ScanSnap Manager icon while pressing the [control] 
key on the keyboard.

Status ScanSnap Manager icon

Communicating

Not communicating

When you add the ScanSnap Manager icon to the Dock, normally  appears. 
A blue light appears under the ScanSnap Manager icon when ScanSnap 
Manager is running.
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■ ScanSnap Manager Menu

This menu appears when you click the ScanSnap Manager icon  while pressing the 
[control] key on the keyboard.

Item Function

Scan Starts scanning. Follows the settings configured in [Settings].

Settings Displays the ScanSnap setup window.
You can configure the scan settings in this window.

 "How to Configure Scan Settings" (page 273)

Profile Displays the Profile menu.
You cannot select [Profile] when the [Use Quick Menu] checkbox is selected in 
the ScanSnap setup window.

 "Profile Menu" (page 258)

Profile Management Displays the [ScanSnap Manager - Profile Management] window.
You cannot select [Profile Management] when the [Use Quick Menu] checkbox is 
selected in the ScanSnap setup window.

 "Profile Management" (page 276)

Help Displays the following menu: 
Help
Opens the ScanSnap Manager Help.
Troubleshooting
Displays [Troubleshooting] in the ScanSnap Manager Help. 
ScanSnap Portal Site 
Opens the ScanSnap global homepage (http://scansnap.fujitsu.com)
About ScanSnap Manager 
Displays the [Version Information] window.
Preferences
Displays the [ScanSnap Manager - Preferences] window.
Online Update
Displays the [ScanSnap Manager - Online Update] window (page 430) 
windows.

Keep in Dock (*) Adds the ScanSnap Manager icon  to the Dock.

Click while pressing the [control] 
key on the keyboard
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* : Select the [Options] sub-menu to display these items. 

Open at Login (*) Automatically launches ScanSnap Manager when Mac OS is started up.

Show in the Finder (*) Displays the contents of the [ScanSnap] folder by using the Finder.

Hide/Show Hides or redisplays all windows of ScanSnap Manager that are being displayed.

Quit Exits ScanSnap Manager.
 "Finishing ScanSnap Operation" (page 269)

Item Function
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■ Profile Menu

This menu appears when you click the ScanSnap Manager icon .
Available profiles are displayed in the Profile menu.

Select a profile in the Profile menu before you perform scanning. Documents are scanned 
according to the scan settings of the profile you select.
For details about how to add, change or delete profiles, refer to  "Profile Management" (page 
276).

To enable the Profile menu, clear the [Use Quick Menu] checkbox in the ScanSnap setup 
window. The Profile menu does not appear when this checkbox is selected.
You can also display the Profile menu by selecting [Profile] from ScanSnap Manager menu.
Profiles configured for the following scanner models will be carried over to ScanSnap S1100 
if the connected computer is the same:
- ScanSnap S1500
- ScanSnap S1500M
- ScanSnap S1300
- ScanSnap S510M
- ScanSnap S500M
- ScanSnap S300M

Click

Profile menu example
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How to Perform a Scan

This section explains how to perform scanning with the ScanSnap.

■ Preparation

1. Turn on the computer.

The ScanSnap Manager icon  appears in the Dock when Mac OS starts up.

2. Open the feed guide to turn on the ScanSnap.

The ScanSnap Manager icon in the Dock changes from  to .

There are two ways to perform scanning, either with the Quick Menu or without using the 
Quick Menu. For details, refer to the following:

Using the Quick Menu (→ page 260)

Without Using the Quick Menu (→ page 265)

If the ScanSnap Manager icon  is not displayed, select [Applications] and double-
click [ScanSnap] → [ScanSnap Manager] from Finder to start up ScanSnap Manager.
If ScanSnap Manager does not start automatically when Mac OS starts up, select 
[Accounts] → [My Account] → [Login Items] → [ ] → [ScanSnap Manager] in the 
[System Preferences] window to start up ScanSnap Manager.

There may be a slight delay before the ScanSnap Manager icon changes to  depending 
on your computer's performance, operating environment and load such as when there are 
many programs running at the same time.

       Feed guide
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■ Using the Quick Menu

The following explains the procedure for scanning by using the Quick Menu.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. Select the [Use Quick Menu] checkbox.

3. Click one of the profile buttons.

Profile Button Description

[Recommended] 
button

Settings are [Automatic resolution] for [Image quality] in the [Scanning] tab in 
the ScanSnap setup window and default for other settings.
It is recommended that you select this button when you want to scan 
documents in optimum quality suitable for the paper size of the document.

[Small File] 
button

Settings are [Normal] (Color/Gray: 150 dpi, B&W: 300 dpi) for [Image quality] in 
the [Scanning] tab in the ScanSnap setup window and default for other settings.
It is recommended that you select this button when you want to reduce the file 
size.

[High Quality] 
button

Settings are [Best] (Color/Gray: 300 dpi, B&W: 600 dpi) for [Image quality] in 
the [Scanning] tab in the ScanSnap setup window and default for other settings.
It is recommended that you select this button when you want to scan 
documents in high quality.

[Customize] 
button

Default settings are the same as the [Recommended] settings.
Settings can be changed depending on your scanning purpose.

Profile Button
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4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

6. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

The [ScanSnap Manager - Image scanning and file saving] window appears.

The [Recommended] button is selected in default.
For details about the default settings when using the Quick Menu, refer to the 
ScanSnap Manager Help.
You cannot change the settings for the [Recommended], [Small File], and [High Quality] 
buttons. If you change any of these settings, the profile automatically switches to 
[Customize].
For details about how to change scan settings, refer to "How to Configure Scan 
Settings" (page 273).

You can also start scanning from the ScanSnap Manager menu.
For more details, refer to "ScanSnap Manager Menu" (page 256).

Do not connect and disconnect the ScanSnap and other USB devices during scanning.
Do not close the feed guide during scanning.
Do not switch users during scanning. 
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After the scanning has completed, the [ScanSnap Manager - Image scanning and 
file saving] window shows a new message indicating that the ScanSnap is ready for 
the next scan. 

8. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

You can also finish scanning by clicking the [Finish Scanning] button in the [ScanSnap 
Manager - Image scanning and file saving] window.
The [Scan/Stop] button on the ScanSnap flashes in blue throughout the scan.
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9. In the Quick Menu, click the icon of the application to link with ScanSnap 
Manager.

The selected application is started.

To specify which applications to display/hide in the Quick Menu, or change the display 
order of the applications, refer to  "Quick Menu Settings" (page 270).
To select an application to link with ScanSnap Manager before scanning, refer to 
"Without Using the Quick Menu" (page 265).

Application Description

Scan to Folder Displays the [Scan to Folder] window.
You can specify the destination folder to save the scanned 
images.
For details about how to continue the process after you select 
this item, refer to "Saving Data in a Specified Folder" (page 
290).

Scan to E-mail Displays the [Scan to E-mail] window.
Scanned image is attached to an e-mail message.
For details about how to continue the process after you select 
this item, refer to "Attaching Files to E-Mail" (page 297).

Scan to Print Displays the [Print] window.
Scanned image can be printed. 
For details about how to continue the process after you select 
this item, refer to "Using the ScanSnap as a Copy Machine" 
(page 307).

Scan to Mobile Displays the [Scan to Mobile] window.
Scanned image is saved to a mobile device.
For details about how to continue the process after you select 
this item, refer to  "Saving Data to a Mobile Device" (page 373).

Scan to Evernote 
(Document)
(*1) (*2)

Scanned image is saved as a PDF file in Evernote.
For details about how to continue the process after you select 
this item, refer to "Saving Documents to Evernote" (page 335).

Scan to Evernote (Note) 
(*1) (*2)

Scanned image is saved as a JPEG file in Evernote.
For details about how to continue the process after you select 
this item, refer to "Saving Handwritten Notes to Evernote" (page 
342).

Scan to Google Docs(TM) 
(*1) 

Scanned image is saved as a PDF file in Google Docs.
For details about how to continue the process after you select 
this item, refer to "Saving Documents to Google Docs" (page 
347).
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*1 : Displayed when Mac OS X v10.5.8 or later is installed.
*2 : Displayed when Evernote for Mac 1.10 or later is installed. 
*3 : Displayed when SugarSync Manager for Mac 1.9.29 or later is installed.
*4 : Displayed when ABBYY FineReader for ScanSnap is installed.
*5 : Displayed when Cardiris is installed.
*6 : Displayed when iPhoto 5 or later is installed.

Scan to Salesforce 
Chatter

Scanned image is posted to Salesforce Chatter.
For details about how to continue the process after you select 
this item, refer to  "Posting to Salesforce Chatter" (page 356).

Scan to SugarSync (*1) 
(*3)

You can save scanned images to your SugarSync folder.
For details about how to continue the process after you select 
this item, refer to  "Saving Data to Your SugarSync Folder" 
(page 366)

Scan to Word (*4) Creates a Word file by converting the scanned images into text 
data.
For details about how to continue the process after you select 
this item, refer to  "Converting into Word/Excel Documents" 
(page 313).

Scan to Excel (*4) Creates an Excel file by converting the scanned images into text 
data.
For details about how to continue the process after you select 
this item, refer to  "Converting into Word/Excel Documents" 
(page 313).

Cardiris (*5) Displays the Cardiris window.
Scanned image is stored in Cardiris.
For details about how to continue the process after you select 
this item, refer to "Storing Business Cards in Cardiris" (page 
321).

iPhoto (*6) Displays the [iPhoto] window.
Scanned image is saved in iPhoto.
For details about how to continue the process after you select 
this item, refer to "Storing Scanned Images in iPhoto" (page 
330).

The output image may slightly differ from the original document in size.
When one of the below applications is active (application menu appears in the menu 
bar), scanning documents by pressing the [Scan/Stop] button on the ScanSnap 
automatically starts the linkage between ScanSnap Manager and the application.
- Cardiris (links with ScanSnap Manager only when the document is of business card 

size)
- Scan to Mobile

For details about automatic linkage, refer to "Automatic Linkage with Applications" 
(page 286).

You cannot start scanning when the Quick Menu is displayed. Either select an icon from 
the Quick Menu and finish the process, or close the Quick Menu before you perform the 
next scan.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

Application Description
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■ Without Using the Quick Menu

The following explains the procedure for scanning without using the Quick Menu.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. Clear the [Use Quick Menu] checkbox.

3. Select a profile.

Select a profile from either of the following:

[Profile] pop-up menu in the ScanSnap setup window

Profile menu
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4. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

5. Press the [Scan/Stop] button on the ScanSnap to start scanning.

The [ScanSnap Manager - Image scanning and file saving] window appears.

The [ScanSnap Manager - Image scanning and file saving] window then shows a 
new message indicating that the ScanSnap is ready for the next scan. 

You can also start scanning from the ScanSnap Manager menu.
For details, refer to  "ScanSnap Manager Menu" (page 256).

Do not connect and disconnect the ScanSnap and other USB devices during scanning.
Do not close the feed guide during scanning.
Do not switch users during scanning. 

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
266



How to Perform a Scan (for Mac OS users)
6. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The application specified for the selected profile starts up.

You can also finish scanning by clicking the [Finish Scanning] button in the [ScanSnap 
Manager - Image scanning and file saving] window.
The [Scan/Stop] button on the ScanSnap flashes in blue throughout the scan.
To select an application to link with ScanSnap Manager in the Quick Menu after 
scanning is completed, refer to "Using the Quick Menu" (page 260).
When the [Set the marked text as a keyword for the PDF file] checkbox or the [Convert 
to Searchable PDF] checkbox is selected in the [File option] tab, the application starts 
after text recognition has been performed on the scanned image.
A window showing the text recognition progress appears during text recognition 
process.
By default, documents are scanned with the following settings: [Image quality: 
Automatic resolution] and [Color mode: Auto color detection].
For details about how to change scan settings, refer to "How to Configure Scan 
Settings" (page 273).
The application that starts up after scanning varies depending on what is selected in the 
[Application] tab in the ScanSnap setup window. For details, refer to the ScanSnap 
Manager Help.
The output image may slightly differ from the original document in size.
When one of the below applications is active (application menu appears in the menu 
bar), scanning documents by pressing the [Scan/Stop] button on the ScanSnap 
automatically starts the linkage between ScanSnap Manager and the application.
- Cardiris (links with ScanSnap Manager only when the document is of business card 

size)
- Scan to Mobile

For details about automatic linkage, refer to  "Automatic Linkage with Applications" 
(page 286).
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■ Stopping the Scan

You can stop a scan in progress in case you are scanning a wrong document or the wrong 
side of a document. 
Stop the scan in the following procedure:

1. Click the [Stop] button in the [ScanSnap Manager - Image scanning and 
file saving] window which appears during scanning.

The following message appears when the scanning stops.

2. Click the [Quit] button.

To continue scanning, click the [Continue Scanning] button or press the [Scan/Stop] 
button on the ScanSnap after loading another document in the ScanSnap.

You can also stop the scan during scanning by pressing the [Scan/Stop] button on the 
ScanSnap.
Remove the document from the ScanSnap after stopping the scan. For details about how 
to remove documents, refer to "Troubleshooting" in the ScanSnap Manager Help.
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■ Finishing ScanSnap Operation

Exiting ScanSnap Manager
Select [Quit] from the ScanSnap Manager menu.
Normally, you do not have to exit ScanSnap Manager.

Disconnecting the ScanSnap

1. Close the feed guide to turn off the ScanSnap.

The ScanSnap Manager icon in the Dock changes from  to . 

2. Disconnect the USB cable from your computer.

You cannot use the ScanSnap after exiting ScanSnap Manager.
From Finder, select [Applications] and double-click [ScanSnap] → [ScanSnap Manager] to 
start up ScanSnap Manager when you want to use the ScanSnap.

The ScanSnap does not have a power switch and is turned ON/OFF in conjunction with the 
computer’s power. The ScanSnap can also be automatically turned ON/OFF by opening or 
closing the feed guide. 
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Configuring ScanSnap Manager

This section explains how to set scan settings, how to add, change and delete profiles, 
automatic linkage with applications and windows displayed during scanning.

■ Quick Menu Settings

You can specify which applications to display or hide in the Quick Menu, as well as change 
the display order of the applications in the following procedure.

1. Click [ ] in the Quick Menu.

For details about how to display the Quick Menu, refer to "Using the Quick Menu" (page 
260).

The [Applications to Show/Hide] window appears.
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2. Specify which applications to display in the Quick Menu.

Showing or Hiding Application Icons
Select the checkbox to display the application in the Quick Menu.
To display all the applications in the Quick Menu, click the [Restore Default] button.

Display Order of Applications
Application icons are displayed in the Quick Menu in the same order as they are listed in 
the [Applications to Show/Hide] window.
Drag an application to change its order.
To restore the default display order of the applications displayed in the Quick Menu, 
click the [Restore Default] button.
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The applications are displayed in the order shown below in the Quick Menu and in the 
[Applications to Show/Hide] window.

3. Click the [OK] button to close the [Applications to Hide/Show] window.

The applications to be displayed in the Quick Menu and their display order are set.
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■ How to Configure Scan Settings
You can configure scan settings in the ScanSnap setup window depending on your intended 
use. 
Configure the scan settings in the following procedure.

1. Select [Settings] from the ScanSnap setup window.
Select [Settings] from the ScanSnap Manager menu.
For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. Click the [Detail] button to switch to the detail view mode.

Using the Quick Menu

Without Using the Quick Menu

You can also open the ScanSnap setup window by pressing simultaneously the [command 
( )] and [S] keys on the keyboard. This operation is only enabled when ScanSnap 
Manager is active (when "ScanSnap Manager" is displayed in the menu bar).

Outline view Detail view

Outline view Detail view
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3. Set the scan settings in each tab.

The following items can be configured in each tab:
For details, refer to the ScanSnap Manager Help.

[Application] tab
- Application to be used with the ScanSnap
[Save] tab
- Folder in which scanned image is saved
- File name used for saving the scanned image
[Scanning] tab
- Scanning

(Which image quality to scan with, use color, gray or black & white, enable or 
disable [Setting for text only document], [Allow automatic blank page removal], 
[Correct skewed character strings automatically], [Allow automatic image 
rotation], and [Continue scanning after current scan is finished].)

[File option] tab
- File format of the scanned image (*.pdf, *.jpg)
- Whether to perform text recognition on a marked character string in the scanned 

image and add the character string as a keyword for the PDF file
(Whether to perform text recognition only on the character strings in the first 
marked section or all marked sections to be added as keywords, and in which 
language to perform text recognition.)

- Whether to perform text recognition on character strings in the scanned image to 
convert the file to a searchable PDF file
(Whether to convert the first page only or all pages, and in which language to 
perform text recognition.)

The ScanSnap setup window retains the display status from the last time the ScanSnap 
was used. For example, if it was closed in detail view mode, the window is displayed in 
detail view mode next time you open it.
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- Whether to create separate PDF files
(Whether to include all scanned images in a single PDF file, or create PDF files, 
each of which including a preset number of pages)

[Paper] tab
- Paper size of documents (paper size selection, Carrier Sheet settings)
[Compression] tab
- File size of the scanned image (compression rate)

4. Click the [Apply] button.

When you use the Quick Menu, scan settings for the [Customize] button are 
changed.
When you do not use the Quick Menu, scan settings for the currently selected profile 
are changed.

Scan settings vary depending on whether or not you use the Quick Menu.
For details about items that can be set, refer to "Setting Items With/Without the Quick 
Menu" (page 438).

If you press the [Scan/Stop] button on the ScanSnap while the ScanSnap setup window is 
displayed, the ScanSnap setup window closes and scanning starts. Scan setting changes 
made up to this point are saved and documents are scanned by these settings.
Note that when other windows are open, scanning does not start even if you press the 
[Scan/Stop] button on the ScanSnap unless open windows are closed. 
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■ Profile Management

You can manage up to 20 profiles.
You can select a profile in the [Profile] pop-up menu in the ScanSnap setup window or from 
the Profile menu.

[Profile] pop-up menu

Profile menu

Once the frequently used scan settings are saved as profiles, you do not have to open the 
ScanSnap setup window to change scan settings every time you perform scanning. You can 
easily switch to an appropriate profile you want by just selecting it.
For details about how to add, change or delete profiles, refer to the following:

To add new profiles (→ page 277)
To change scan settings for profiles (→ page 280)
To rename profiles (→ page 282)
To delete profiles (→ page 284)

To use a profile, you need to clear the [Use Quick Menu] checkbox in the ScanSnap setup 
window.
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Adding Profiles

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. Configure the scan settings in each tab.

For details about each tab, refer to the ScanSnap Manager Help.

Clear the [Use Quick Menu] checkbox if it is selected.
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3. Select [Add Profile] from the [Profile] pop-up menu.

The [Add new profile] window appears.

4. Type in a new profile name and click the [OK] button.

The added profile appears in the [Profile] pop-up menu in the ScanSnap setup 
window.

5. Click the [Apply] button.
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6. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

Up to 20 profiles can be saved including the [Standard] profile.
You can change the display order of profiles except for the [Standard] profile.
1. Select [Profile Management] from the ScanSnap Manager menu or from the [Profile] 

pop-up menu in the ScanSnap setup window.
The [ScanSnap Manager - Profile Management] window appears.

2. Drag the profile to move it to its desired position in the list.

3. Click the [ ] button to close the [ScanSnap Manager - Profile Management] 
window.
279



Configuring ScanSnap Manager (for Mac OS users)
Changing Profile Settings

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to  "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. Select a profile from the [Profile] pop-up menu.

3. Change the scan settings in each tab.

For details about each tab, refer to the ScanSnap Manager Help.

Clear the [Use Quick Menu] checkbox if it is selected.
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4. When you finish changing the settings for the selected profile, click the 
[Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.
281



Configuring ScanSnap Manager (for Mac OS users)
Renaming Profiles

1. Select [Profile Management] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The [ScanSnap Manager - Profile Management] window appears.

2. Select a profile, click the [ ] button in the lower left corner, and select 
[Rename].

The name field of the profile becomes editable.

If you cannot select [Profile Management] in the ScanSnap Manager menu, clear the 
[Use Quick Menu] checkbox in the ScanSnap setup window.
You can also display the [ScanSnap Manager - Profile Management] window by 
selecting [Profile Management] from the [Profile] pop-up menu in the ScanSnap setup 
window.

The [Standard] profile cannot be renamed.
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3. Type in a new name.

The profile is renamed. 

4. Click the [ ] button to close the [ScanSnap Manager - Profile 
Management] window. 

A message window appears.

5. Click the [Apply] button.
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Deleting Profiles

1. Select [Profile Management] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The [ScanSnap Manager - Profile Management] window appears.

2. Select a profile and click the [ ] button.

The selected profile is deleted.

3. Click the [ ] button to close the [ScanSnap Manager - Profile 
Management] window. 

A message window appears.

If you cannot select [Profile Management] in the ScanSnap Manager menu, clear the 
[Use Quick Menu] checkbox in the ScanSnap setup window.
You can also display the [ScanSnap Manager - Profile Management] window by 
selecting [Profile Management] from the [Profile] pop-up menu in the ScanSnap setup 
window.

The [Standard] profile cannot be deleted.
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4. Click the [Apply] button.
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■ Automatic Linkage with Applications

When one of the following applications is active (application menu appears in the menu bar), 
scanning documents by pressing the [Scan/Stop] button on the ScanSnap automatically starts 
the linkage between ScanSnap Manager and the application even when the Quick Menu is 
enabled.
Applications that can automatically link with ScanSnap Manager are as follows:

Cardiris
Scanned image is displayed in Cardiris.
Scan to Mobile
Scanned image is sent to a mobile device.

The example above shows ScanSnap Manager automatically linking with Scan to Mobile 
when Scan to Mobile window is in front (active).

ActiveNot active
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■ Showing the Scanning Progress

When scanning starts, the [ScanSnap Manager - Image scanning and file saving] window 
appears.
The [ScanSnap Manager - Image scanning and file saving] window consists of the following:

Scan status
Scan settings
Save completed
Preview

Also, note that you can stop scanning by clicking the [Stop] button in the [ScanSnap Manager 
- Image scanning and file saving] window, or by pressing the [Scan/Stop] button on the 
ScanSnap.
For details about how to stop scanning, refer to "Stopping the Scan" (page 268).

The following message appears in the [ScanSnap Manager - Image scanning and file saving] 
window after the document has been scanned. Load another document in the ScanSnap 
when you want to scan multiple sheets. Scanning starts automatically when a document is 
loaded.

The [ScanSnap Manager - Image scanning and file saving] window closes when you press the 
[Scan/Stop] button on the ScanSnap or when you click the [Finish Scanning] button.

When the [Continue scanning after current scan is finished] checkbox in the [Scanning] tab in the 
ScanSnap setup window is cleared, the [ScanSnap Manager - Image scanning and file saving] 
window automatically closes after saving the scanned image.
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Hiding the Scanning Progress Status
You can hide the [ScanSnap Manager - Image scanning and file saving] window in the 
following procedure.

1. Select [Help] → [Preferences] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The [ScanSnap Manager - Preferences] window appears.

2. Clear the [Show the scan progress status (recommended)] checkbox.

3. Click the [ ] button in the upper left corner to close the [ScanSnap 
Manager - Preferences] window.

The [ScanSnap Manager - Image scanning and file saving] window is hidden from 
next scanning on.

When the scanning progress status window is not displayed, the current 

number of pages saved is indicated on the ScanSnap Manager icon  in 
the Dock.
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Actions

The ScanSnap keeps the functions useful in your office work available as Actions.
Actions allow you to:

Share the scanned document files with others.
You can save the scanned image directly in a shared folder on a network upon 
scanning, share the scanned image with others and inform them of the destination 
folder path by an e-mail message automatically created with the path stated.

Send document files to participants of a meeting via e-mail.
Send an e-mail message to others with the scanned image file attached.

Use a printer rather than a copy machine to make copies of documents.
Print the scanned image with a printer.

Quote text from your paper documents when you do not want to type it.
Have the scanned image text recognized and converted into a Word or Excel document.

File and organize a large number of business cards.
Store and manage business cards in Cardiris. The card data can be output in either text 
or vCard format.

Convert catalogs and pamphlets into digital data and save them.
Store and manage scanned images of catalogs and pamphlets directly in iPhoto.

Manage scanned documents through linkage with Evernote.
Save PDF files in Evernote and access them easily anytime, anywhere.

Manage handwritten notes through linkage with Evernote.
Save JPEG files in Evernote and access them easily anytime, anywhere.

Manage scanned documents through linkage with Google Docs.
Save PDF files in Google Docs and access them easily anytime, anywhere.

Manage scanned documents through linkage with Salesforce Chatter.
Post scanned image files to Salesforce Chatter and manage them with Salesforce 
CRM.

Manage scanned documents through linkage with SugarSync.
Save scanned image files to your SugarSync folder and access them easily anytime, 
anywhere.

Save scanned documents to a mobile device.
Scanned image file is saved to a connected mobile device. You can access the saved 
files through linkage with an application that can view PDF or JPEG files.

The following are explanations on how to use Actions.
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■ Saving Data in a Specified Folder

This section explains how to save the scanned image file in a specified folder.                               
You can save the scanned image file in a shared folder on the network and share it with 
others. In addition, you can inform others of the destination folder path by an e-mail message 
automatically created with the path stated.

For details about the procedure to scan and save the scanned image in a specified folder 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 291)
Without Using the Quick Menu (→ page 294)

The e-mail program configured in Mail when you select [Mail] menu → [Preferences] → 
[General] button → [Default email reader] is used as the e-mail program to link with ScanSnap 
Manager.
The following e-mail programs are supported:

Mail
Outlook for Mac 2011
Entourage 2008 for Mac
Entourage 2004 for Mac
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Using the Quick Menu

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Click the [Scan to Folder] icon.

The [Scan to Folder] window appears.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 260) 

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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5. Check the scanned image in the preview area.

In the [Scan to Folder] window, you can change files names, destination folders, and 
specify whether to state a path to a destination folder in an e-mail message to notify 
others.
For details about the [Scan to Folder] window, refer to the ScanSnap Manager Help.

Preview
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6. Click the [Save] button.

The scanned image file is saved in the specified folder.
When you select the [State a path to a destination folder in an E-mail message] 
checkbox in the [Scan to Folder] window, a new message window appears listing the 
destination folder path where the file is saved.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Folder] window is closed. Close the [Scan to Folder] window before scanning the next 
document.
Do not move, delete, or rename scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to Folder] window is closed.
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Without using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Folder].

3. Click the [Apply] button.

4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 265).

ScanSnap Manager can also link with [Scan to Folder] when you select:
[Scan to Folder] from the [Profile] pop-up menu of the ScanSnap setup window
[Scan to Folder] from the Profile menu
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5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [Scan to Folder] window appears.

8. Check the scanned image in the preview area.

In the [Scan to Folder] window, you can change files names, destination folders, and 
specify whether to state a path to a destination folder in an e-mail message to notify 
others.
For details about the [Scan to Folder] window, refer to the ScanSnap Manager Help.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

Preview
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9. Click the [Save] button.

The scanned image file is saved in the specified folder.
When you select the [State a path to a destination folder in an E-mail message] 
checkbox in the [Scan to Folder] window, a new message window appears listing the 
destination folder path where the file is saved.

You cannot start scanning when the [Scan to Folder] window is displayed. Close the 
[Scan to Folder] window before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the [Scan 
to Folder] window is displayed.
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■ Attaching Files to E-Mail

This section explains how to attach the scanned image file to an e-mail message.

For details about the procedure to scan and attach the scanned image to an e-mail message 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 298)
Without Using the Quick Menu (→ page 302)

The e-mail program configured in Mail when you select [Mail] menu → [Preferences] → 
[General] button → [Default email reader] is used as the e-mail program to link with ScanSnap 
Manager.
The following e-mail programs are supported:

Mail
Outlook for Mac 2011
Entourage 2008 for Mac
Entourage 2004 for Mac
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Using the Quick Menu

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to E-mail] (If you do not want to change 
any settings, go to step 5.).

1. Click [Settings] under the [Scan to E-mail] icon.

The [Scan to E-mail - Options] window appears.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning using the Quick Menu, refer to "Using the Quick 
Menu" (page 260).

Up to ten files can be attached to an e-mail message.
When you scan more than one document with the scan settings shown below, multiple 
files are created. Pay attention to the number of documents to scan:

File format: JPEG (*.jpg)
[Generate one PDF file per (n) page(s)] checkbox is selected

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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2. Change the settings.
For details about the [Scan to E-mail - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to E-mail - Options] window.

5. Click the [Scan to E-mail] icon.

The [Scan to E-mail] window appears.
If you clear the [Show preview] checkbox of the [Scan to E-mail - Options] window in 
step 4., the [Scan to E-mail] window is not displayed. Instead, a new message 
window appears with the file(s) attached.
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6. Check the scanned image in the preview area.

In the [Scan to E-mail] window, you can rename the file and decide whether to save the 
scanned image in the folder specified for [Image saving folder] after sending it by e-mail.
For details about the [Scan to E-mail] window, refer to the ScanSnap Manager Help.

Preview
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7. Click the [Attach to E-mail] button.

An e-mail message window appears with the file attached.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to E-
mail] window is closed. Close the [Scan to E-mail] window before scanning the next 
document.
Do not move, delete, or rename scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to E-mail] window is closed.
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Without using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
E-mail].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 265).

ScanSnap Manager can also link with [Scan to E-mail] when you select:
[Scan to E-mail] from the [Profile] pop-up menu of the ScanSnap setup window
[Scan to E-mail] from the Profile menu
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3. Change the settings for [Scan to E-mail] (If you do not want to change 
any settings, go to step 4.).

1. Click the [Application Setting] button.

The [Scan to E-mail - Options] window appears.

2. Change the settings.
For details about the [Scan to E-mail - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to E-mail - Options] window.

4. Click the [Apply] button in the ScanSnap setup window.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 
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Actions (for Mac OS users)
6. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

8. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [Scan to E-mail] window appears.
If you clear the [Show preview] checkbox of the [Scan to E-mail - Options] window in 
step 3., the [Scan to E-mail] window is not displayed. Instead, a new message 
window appears with the file(s) attached.

Up to ten files can be attached to an e-mail message.
When you scan more than one document with the scan settings shown below, multiple 
files are created. Pay attention to the number of documents to scan:

File format: JPEG (*.jpg)
[Generate one PDF file per (n) page(s)] checkbox is selected

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Mac OS users)
9. Check the scanned image in the preview area.

In the [Scan to E-mail] window, you can rename the file and decide whether to save the 
scanned image in the folder specified for [Image saving folder] after sending it by e-mail.
For details about the [Scan to E-mail] window, refer to the ScanSnap Manager Help.

Preview
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Actions (for Mac OS users)
10.Click the [Attach to E-mail] button.

An e-mail message window appears with the file attached.

You cannot start scanning when the [Scan to E-mail] window is displayed. Close the 
[Scan to E-mail] window before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the [Scan 
to E-mail] window is displayed.
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Actions (for Mac OS users)
■ Using the ScanSnap as a Copy Machine

This section explains how to print the scanned image with a printer.
When a printer links with ScanSnap Manager, the ScanSnap can be used as a copy machine.

For details about the procedure to scan and print the scanned image using or without using 
the Quick Menu, refer to the following:

Using the Quick Menu (→ page 308)
Without Using the Quick Menu (→ page 310)

Note that shadows around the edges of the document may appear as lines on the generated 
scanned image, depending on the scanning method and paper conditions. If you print such 
an image, the printed image will also have lines appearing in it.
The scanned image will be printed at a resolution of 150 dpi regardless of the setting 
specified for [Image quality] in the [Scanning] tab.
When you perform a borderless printing, save the image data to file first, and then print it by 
using Preview, Adobe Acrobat or Adobe Reader.
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Actions (for Mac OS users)
Using the Quick Menu

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to Print] (If you do not want to change any 
settings, go to step 5.).

1. Click [Settings] under the [Scan to Print] icon.

The [Scan to Print - Options] window appears.

2. Change the settings.
For details about the [Scan to Print - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Print - Options] window.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 260) 

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Mac OS users)
5. Click the [Scan to Print] icon.

The [Print] window appears.

6. Configure print setup options in the [Print] window.

In the [Print] window, you can specify the printer to be used, the number of copies, and 
size and position of the scanned image to be printed, and whether to save the scanned 
image in the folder specified for [Image saving folder]. 
For details about the [Print] window, refer to the ScanSnap Manager Help. 

7. Click the [Print] button.

The scanned image is printed.

You cannot start scanning after the Quick Menu is displayed and before the [Print] 
window is closed. Close the [Print] window before scanning the next document.
Do not move, delete, or rename the scanned image in other applications after the Quick 
Menu is displayed and before the [Print] window is closed.
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Actions (for Mac OS users)
Without using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. From the [Application] pop-up menu in the [Application] tab, select [Scan 
to Print].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 265).

ScanSnap Manager can also link with [Scan to Print] when you select:
[Scan to Print] from the [Profile] pop-up menu of the ScanSnap setup window
[Scan to Print] from the Profile menu
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Actions (for Mac OS users)
3. Change the settings for [Scan to Print] (If you do not want to change any 
settings, go to step 4.).

1. Click the [Application Setting] button.

The [Scan to Print - Options] window appears.

2. Change the settings.
For details about the [Scan to Print - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Print - Options] window.

4. Click the [Apply] button in the ScanSnap setup window.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

6. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).
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Actions (for Mac OS users)
7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

8. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [Print] window appears.

9. Configure print setup options in the [Print] window.

In the [Print] window, you can specify the printer to be used, the number of copies, and 
size and position of the scanned image to be printed, and whether to save the scanned 
image in the folder specified for [Image saving folder]. 
For details about the [Print] window, refer to the ScanSnap Manager Help. 

10.Click the [Print] button.

The scanned image is printed.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

You cannot start scanning when the [Print] window is displayed. Close the [Print] window 
before scanning the next document.
Do not move, delete, or rename the scanned image in other applications while the [Print] 
window is displayed.
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Actions (for Mac OS users)
■ Converting into Word/Excel Documents

This section explains how to convert the scanned image into Word/Excel files using ABBYY 
FineReader for ScanSnap bundled with the ScanSnap.

The following applications must be installed in your computer in order to perform text-
recognition:
- ABBYY FineReader for ScanSnap (bundled with the ScanSnap)
- Word
- Excel

You cannot view the documents converted into Word and Excel files unless these 
applications are installed and you completed the user registration to use them. Install these 
applications and complete the user registration to view the converted documents on your 
computer.
If Word is not installed in your computer, text-only results of converted documents to Word 
will be displayed in TextEdit. If Excel is not installed in your computer, you cannot view 
documents converted to Excel. 
ABBYY FineReader for ScanSnap can be used with the following versions of Word and 
Excel:
- Word: 2011 / 2008 / 2004
- Excel: 2011 / 2008 / 2004

Do not use this function while you are working in Word or Excel. In addition, do not use Word 
or Excel while this function is being executed. If you use either Word or Excel together with 
this function, the conversion result is saved to a file, but the conversion result may not be 
displayed even if the [Open file after recognition] checkbox is selected on the [FineReader for 
ScanSnap Preferences] window.
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Actions (for Mac OS users)
About the OCR function of ABBYY FineReader for ScanSnap
ABBYY FineReader for ScanSnap is an application used exclusively with the ScanSnap. This 
program can perform text recognition only for PDF files created by using the ScanSnap. It 
cannot perform text recognition for files created using Adobe Acrobat or other applications.
The optical character recognition program has the following features. Before performing text 
recognition, check whether the documents you want to convert are suitable for conversion 
according to the following guidelines:

Application Suitable for conversion Not suitable for conversion

Scan to Word Documents with simple lay-
outs consisting of single or 
double columns

Documents with complex layouts con-
taining a mixture of diagrams, tables, 
and text (e.g. brochures, magazines, and 
newspapers)

Scan to Excel Documents containing simple 
tables with no cells merged

Documents containing:
- Tables with no solid border lines
- Tables with complicated cell formats
- Complex tables containing sub-tables
- Diagrams
- Graphs
- Photos
- Vertical text
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Actions (for Mac OS users)
The following parameters may not be reproduced as they are in the original document. It is 
recommended that the converted documents be opened with Word or Excel to correct or edit 
misrecognized characters:
- Character font and size
- Character and line spacing
- Underlined, bold and italic characters
- Superscript/subscript

The following types of documents (characters) may not be recognized correctly.
Better results in text recognition may be achieved by changing the color mode or increasing 
the resolution:
- Documents including handwritten characters
- Documents containing small characters (smaller than 10 points)
- Skewed documents
- Documents written in languages other than the specified language
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders
- Documents of complex layouts as well as documents including unreadable characters

(It may take extra time to process text recognition for these documents.)
When converting to Excel files, if the recognition result exceeds 65,536 lines, no more results 
are saved.
When converting to Excel files, information about the layout of the entire document, 
diagrams, and length/width of graphs and tables is not duplicated. Only tables and character 
strings are reproduced.

You can change the settings applied during conversion to Word or Excel documents in the 
ABBYY FineReader for ScanSnap setup window.

Select the [Applications] → [ABBYY FineReader for ScanSnap] → [FineReader for ScanSnap 
Preferences]. Then, select [FineReader for ScanSnap] menu → [Preferences] to display the 
following window.

For details about how to configure settings, refer to the ABBYY FineReader for ScanSnap Help.
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Actions (for Mac OS users)
For details about the procedure to scan and convert the scanned image into Word/Excel files 
using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 317)
Without Using the Quick Menu (→ page 319)
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Actions (for Mac OS users)
Using the Quick Menu 

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Click the [Scan to Word] or [Scan to Excel] icon.

The following window appears and conversion is started.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 260).

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in 
the [Scanning] tab of the ScanSnap setup window.
Load another document in the ScanSnap when you want to scan multiple sheets. 
Scanning starts automatically when a document is loaded.

When you perform a scan with [JPEG(*.jpg)] selected for [File format] in the [File 
option] tab in the ScanSnap setup window, scanned data cannot be converted into a 
Word or Excel file.
You cannot start scanning when the Quick Menu is displayed. Wait until the 
conversion is over to scan another document.
Do not move, delete or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Mac OS users)
When the conversion is completed, Word or Excel starts up, displaying the converted 
document in the applicable format.

The Word or Excel file is saved in one of the following formats:
Scan to Word: RTF format (.rtf)
Scan to Excel: XLS format (.xls)
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Actions (for Mac OS users)
Without using the Quick Menu 

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Word] or [Scan to Excel].

3. Click the [Apply] button in the ScanSnap setup window.

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 265).

It is recommended to select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab in the ScanSnap setup window.
ScanSnap Manager can also link with [Scan to Word] or [Scan to Excel] when you 
select:
- [Scan to Word] or [Scan to Excel] from the [Profile] pop-up menu of the ScanSnap 

setup window
- [Scan to Word] or [Scan to Excel] from the Profile menu
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Actions (for Mac OS users)
4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The following window appears and image data conversion to Word or Excel files 
starts.

When the conversion is completed, Word or Excel starts up and the conversion 
result is displayed.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

The Word or Excel file is saved in one of the following formats:
Scan to Word: RTF format (.rtf)
Scan to Excel: XLS format (.xls)
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Actions (for Mac OS users)
■ Storing Business Cards in Cardiris

This section explains how to store business card images and the related information in 
Cardiris.

For details about the procedure to scan and manage business cards in Cardiris using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 322)
Without Using the Quick Menu (→ page 325)
Using the Address Book in Cardiris (→ page 328)
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Actions (for Mac OS users)
Using the Quick Menu

1. Insert the business card straight into the feeding section of the 
ScanSnap, with the scanning side facing up.

Business card is pulled in until it is set inside the ScanSnap.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 260).

When [Business card] is specified for [Paper size] in the [Paper] tab of the ScanSnap 
setup window, insert the business card by aligning it with the left edge of the feeding 
section.

If you perform a scan with the output guide open, a 
paper jam may occur and damage business cards. 
Make sure to close the output guide when you scan 
business cards.

Output guide
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Actions (for Mac OS users)
2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Click the [Cardiris] button.

The Cardiris window appears.

It is recommended to select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab in the ScanSnap setup window.

Load another business card in the ScanSnap when you want to scan multiple business 
cards. Scanning starts automatically when a business card is loaded.

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap 
Manager links with Cardiris before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Mac OS users)
5. Check the scanned card image and the text recognition result.

The current card image is displayed on the top-right.
A list of already scanned business cards is displayed in the card toolbar.

The recognition result is displayed under the card image.

Do not exit Cardiris while setup or message window is open.

To recognize a business card of a different language from the one currently set in 
Cardiris, click the card style button and change the country setting.
For details about the functions of Cardiris and how to use it, refer to Cardiris™ 4 User 
Guide and Cardiris Help.

Card Style 
button

[Export] button

Output Format 
button

Card Toolbar

Card image

Recognition 
result
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Actions (for Mac OS users)
Without using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select 
[Cardiris].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 265).

It is recommended that you select [Automatic resolution] or [Best] for [Image quality] in the 
[Scanning] tab of the ScanSnap setup window.

ScanSnap Manager can also link with [Cardiris] when you select:
[Cardiris] from the [Profile] pop-up menu of the ScanSnap setup window
[Cardiris] from the Profile menu
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Actions (for Mac OS users)
3. Click the [Apply] button.

4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

5. Insert the business card straight into the feeding section of the 
ScanSnap, with the scanning side facing up.

Business card is pulled in until it is set inside the ScanSnap.

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

When [Business card] is specified for [Paper size] in the [Paper] tab in the ScanSnap 
setup window, insert the business card by aligning it with the left edge of the feeding 
section.

If you perform a scan with the output guide open, a 
paper jam may occur and damage business cards. 
Make sure to close the output guide when you scan 
business cards.

Load another business card in the ScanSnap when you want to scan multiple business 
cards. Scanning starts automatically when a business card is loaded.

Output guide
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Actions (for Mac OS users)
7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Cardiris window appears.

8. Check the scanned card image and the text recognition result.

The current card image is displayed on the top-right.
A list of already scanned business cards is displayed in the card toolbar.
The recognition result is displayed under the card image.

Do not exit Cardiris while setup or message window is open.

To recognize a business card of a different language from the one currently set in 
Cardiris, click the card style button and change the country setting.
For details about functions of Cardiris and how to use it, refer to Cardiris™ 4 User 
Guide and Cardiris Help.
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Actions (for Mac OS users)
Using the Address Book in Cardiris
To register the recognized characters of a scanned business card in the Address Book, 
perform the following procedure.

1. Click the Output Format button or select [Settings] → [Output Format] on 
the menu bar.

The [Business Cards] window appears.

2. Select [Address Book] in the [Format] pop-up menu.

3. Click the [OK] button.

Do not exit Cardiris when setup or message window is open.
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Actions (for Mac OS users)
4. Click the [Export] button or select [Process] → [Export All Cards] on the 
menu bar.

The text recognition result of all scanned business cards in the card toolbar are 
registered in the Address Book.

5. Select [Cardiris for ScanSnap] → [Quit Cardiris for ScanSnap] on the 
menu bar to quit Cardiris.

The recognition result of scanned business cards can be output in text or vCard format. For more 
details, refer to Cardiris™ 4 User Guide and Cardiris Help.
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Actions (for Mac OS users)
■ Storing Scanned Images in iPhoto

This section explains how to store the scanned image in iPhoto.

For details about the procedure to scan and store the scanned image in iPhoto using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 331)
Without Using the Quick Menu (→ page 333)
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Actions (for Mac OS users)
Using the Quick Menu

1. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Click the [iPhoto] button.

The [iPhoto] window appears.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For more details about how to perform scanning by using the Quick Menu, refer to "Using the 
Quick Menu" (page 260).

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap 
Manager links with iPhoto before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Mac OS users)
5. Check the scanned image stored in iPhoto.

The scanned image is also saved in the folder specified for [Image saving folder] in the 
[Save] tab of the ScanSnap setup window at the same time when it is saved to iPhoto. 
Delete this file if unnecessary.
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Actions (for Mac OS users)
Without using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. From the [Application] pop-up menu in the [Application] tab, select 
[iPhoto].

3. Click the [Apply] button.

4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For more details about how to perform scanning without using the Quick Menu, refer to "Without 
Using the Quick Menu" (page 265).

ScanSnap Manager can also link with [iPhoto] when you select:
[iPhoto] from the [Profile] pop-up menu of the ScanSnap setup window
[iPhoto] from the Profile menu
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Actions (for Mac OS users)
5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [iPhoto] window appears.

8. Check the scanned image stored in iPhoto.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

The scanned image is also saved in the folder specified for [Image saving folder] in the 
[Save] tab of the ScanSnap setup window at the same time when it is saved to iPhoto. 
Delete this file if unnecessary.
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Actions (for Mac OS users)
■ Saving Documents to Evernote

This section explains how to save the scanned image as a PDF file to Evernote.
When you save the scanned image to Evernote after converting it into a searchable PDF, the 
PDF file becomes searchable in Evernote.

For details about the procedure to scan and save the scanned image to Evernote using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 336)
Without Using the Quick Menu (→ page 339)

You need to create an Evernote account (free or premium).
You first need to create a notebook in Evernote for Mac to save a file to Evernote.
Disable [Bring the new note to the front] 
in Evernote [Preferences] window 
beforehand to prevent new notes 
appearing on the screen when you 
scan documents consecutively.
The screenshot on the right is from 
Evernote for Mac 2.0.4. Clear the [Bring 
the new note to the front] checkbox in 
this window.
The actual window and the contents 
may differ depending on the Evernote 
version you are using.

PDF
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Actions (for Mac OS users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to Evernote (Document)] (If you do not 
want to change any settings, go to step 5.).

1. Click [Settings] under the [Scan to Evernote (Document)] icon.

The [Scan to Evernote (Document) - Options] window appears.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 260).

Load another document in the ScanSnap when you want to scan multiple sheets.
Scanning starts automatically when a document is loaded.
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Actions (for Mac OS users)
2. Change the settings.
For details about the [Scan to Evernote (Document) - Options] window, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Evernote (Document) - Options] window.

5. Click the [Scan to Evernote (Document)] icon.

If [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup window, a separate PDF file will be created from each JPEG file.                                                               
The following window is displayed when the PDF file is being created.

You cannot start scanning when the Quick Menu is displayed. Save the PDF file to Ever-
note before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Mac OS users)
If the [Convert to Searchable PDF] checkbox is selected in step 4., text recognition is 
performed according to the [OCR options] settings in the [Scan to Evernote - 
Options] window.                                                                                                                 
The following window is displayed during text recognition.

Evernote for Mac starts up, and the PDF file is saved to Evernote.

Text recognition will be performed if there are any pages containing text which is not yet 
recognized. Note that text recognition will be performed on all pages, including pages 
containing text on which text recognition has already been performed. 

The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup window even after the scanned 
image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Mac OS users)
Without using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Evernote (Document)].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 265).

ScanSnap Manager can also link with [Scan to Evernote (Document)] when you select:
[Scan to Evernote (Document)] from the [Profile] pop-up menu of the ScanSnap setup 
window
[Scan to Evernote (Document)] from the Profile menu
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Actions (for Mac OS users)
3. Change the settings for [Scan to Evernote (Document)] (If you do not 
want to change any settings, go to step 4.).

1. Click the [Application Setting] button.

The [Scan to Evernote (Document) - Options] window appears.

2. Change the settings.
For details about the [Scan to Evernote (Document) - Options] window, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Evernote (Document) - Options] window.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).
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Actions (for Mac OS users)
7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

8. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

If [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup window, a separate PDF file will be created from each JPEG file.                                                      
The following window is displayed when the PDF file is being created.

If the [Convert to Searchable PDF] checkbox is selected in step 3., text recognition is 
performed according to the [OCR options] settings in the [Scan to Evernote 
(Document) - Options] window.                                                                                                                                
The following window is displayed during text recognition.

Evernote for Mac starts up, and the PDF file is saved to Evernote.

Load another document in the ScanSnap when you want to scan multiple sheets. 
Scanning starts automatically when a document is loaded.

Text recognition will be performed if there are any pages containing text which is not yet 
recognized. Note that text recognition will be performed on all pages, including pages 
containing text on which text recognition has already been performed. 

The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup window even after the scanned 
image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Mac OS users)
■ Saving Handwritten Notes to Evernote

This section explains how to save the scanned image as a JPEG file to Evernote.
When you save a JPEG file to Evernote, text recognition is performed on all text, including 
handwritten characters, and the file becomes searchable in Evernote.

For details about the procedure to scan and send the scanned image to Evernote using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 343)
Without Using the Quick Menu (→ page 345)

You need to create an Evernote account (free or premium).
You first need to create a notebook in Evernote for Mac to save a file to Evernote.
Disable [Bring the new note to the front] 
in Evernote [Preferences] window 
beforehand to prevent new notes 
appearing on the screen when you 
scan more documents consecutively.                                       
The screenshot on the right is from 
Evernote for Mac 2.0.4. Clear the 
[Bring the new note to the front] 
checkbox in this window.                     
The actual window and the contents 
may differ depending on the Evernote 
version you are using.

JPEG
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Actions (for Mac OS users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Click the [Scan to Evernote (Note)] icon.

If [PDF(*.pdf)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup window, a separate JPEG file will be created from each page of the PDF file.                                  
The following window is displayed when the JPEG file is being created.

Evernote for Mac starts up, and the JPEG file is saved to Evernote.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 260).

Load another document in the ScanSnap when you want to scan multiple sheets.
Scanning starts automatically when a document is loaded.

You cannot start scanning when the Quick Menu is displayed. Save the JPEG file to 
Evernote before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Mac OS users)
When you select [PDF (*.pdf)] for [File format] in the [File option] tab of the ScanSnap setup 
window, a four-digit serial number is automatically added to the name of the file which is 
saved to Evernote.
e.g. When the file name is [ScanSnap], the file is saved as:

ScanSnap_0001, ScanSnap_0002, ScanSnap_0003...
The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup window even after the scanned 
image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Mac OS users)
Without using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Evernote (Note)].

3. Click the [Apply] button.

4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 265).

ScanSnap Manager can also link with [Scan to Evernote (Note)] when you select:
[Scan to Evernote (Note)] from the [Profile] pop-up menu of the ScanSnap setup window
[Scan to Evernote (Note)] from the Profile menu
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Actions (for Mac OS users)
5. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

If [PDF(*.pdf)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup window, a separate JPEG file will be created from each page of the PDF file.                                   
The following window is displayed when the JPEG file is being created.

Evernote for Mac starts up, and the JPEG file is saved to Evernote.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

When you select [PDF (*.pdf)] for [File format] in the [File option] tab of the ScanSnap 
setup window, a four-digit serial number is automatically added to the name of the file 
which is saved to Evernote.
e.g. When the file name is [ScanSnap], the file is saved as:

ScanSnap_0001, ScanSnap_0002, ScanSnap_0003...
The file in which the scanned image is saved remains in the folder specified for [Image 
saving folder] in the [Save] tab of the ScanSnap setup window even after the scanned 
image is saved to Evernote. Delete this file if unnecessary.
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Actions (for Mac OS users)
■ Saving Documents to Google Docs

This section explains how to save the scanned image as a PDF file to Google Docs.

For details about the procedure to scan and save the scanned image to Google Docs using or 
without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 348)
Without Using the Quick Menu (→ page 352)

You need to create a Google account (free).

PDF
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Actions (for Mac OS users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to Google Docs(TM)] (If you do not want to 
change any settings, go to step 5.).

1. Click [Settings] under the [Scan to Google Docs(TM)] icon.

The [Scan to Google Docs(TM) - Options] window appears.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to "Using the Quick 
Menu" (page 260).

Load another document in the ScanSnap when you want to scan multiple sheets. 
Scanning starts automatically when a document is loaded.
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Actions (for Mac OS users)
2. Change the settings.
For details about the [Scan to Google Docs(TM) - Options] window, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Google Docs(TM) - Options] window.

5. Click the [Scan to Google Docs(TM)] icon.

If the computer is shared with other users, do not enter your information in [Email] and 
[Password] in this window. Otherwise, other users will be able to log into Google Docs 
automatically.
It is recommended to set only [Email] in this window, and type in the password every 
time.

You cannot start scanning when the Quick Menu is displayed. Save the scanned image 
to Google Docs before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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Actions (for Mac OS users)
If you did not specify a Google account in the [Scan to Google Docs(TM) - Options] 
window in step 4., the [Scan to Google Docs(TM) window appears. To continue, 
enter your e-mail address and password, and click the [OK] button.

If [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup window, a separate PDF file will be created from each JPEG file.                                                        
The following window is displayed when the PDF file is being created.

If the [Convert to Searchable PDF] checkbox is selected in the [Scan to Google 
Docs(TM) - Options] window in step 4., text recognition is performed according to the 
[OCR options] settings in the [Scan to Google Docs(TM) - Options] window. The 
following window is displayed during text recognition.

If the computer is shared with other users, do not select the [Remember the 
password in the keychain] checkbox in this window. Otherwise, other users will be 
able to log into Google Docs automatically.
Scan to Google Docs is not available in a proxy environment that requires 
authentication upon connecting to the Internet.

Text recognition will be performed if there are any pages containing text which is not 
yet recognized. Note that text recognition will be performed on all pages, including 
pages containing text on which text recognition has already been performed. 
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Actions (for Mac OS users)
Saving to Google Docs starts. Click the [Close] button to close the [Scan to Google 
Docs(TM)] window when the saving is completed.

If you select the [Close this window when save completes] checkbox above, the 
[Scan to Google Docs(TM)] window will automatically close from next scanning on 
when the saving is completed.

Google Docs does not start up after the saving has completed. To check the saved PDF file, 
start a web browser and log in to Google Docs.
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Actions (for Mac OS users)
Without using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Google Docs(TM)].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to "Without Using 
the Quick Menu" (page 265).

ScanSnap Manager can also link with [Scan to Google Docs(TM)] when you select:
[Scan to Google Docs(TM)] from the [Profile] pop-up menu of the ScanSnap setup 
window
[Scan to Google Docs(TM)] from the Profile menu
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Actions (for Mac OS users)
3. Change the settings for [Scan to Google Docs(TM)] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Google Docs(TM) - Options] window appears.

2. Change the settings.
For details about the [Scan to Google Docs(TM) - Options] window, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Google Docs(TM) - Options] window.

If the computer is shared with other users, do not enter your information in [Email] and 
[Password] in this window. Otherwise, other users will be able to log into Google Docs 
automatically.
It is recommended to set only [Email] in this window, and type in the password every 
time.
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Actions (for Mac OS users)
4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

6. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

8. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

If you did not specify a Google account in the [Scan to Google Docs(TM) - Options] 
window in step 3., the [Scan to Google Docs(TM)] window appears. To continue, 
enter your e-mail address and password, and click the [OK] button.

If [JPEG(*.jpg)] is selected for [File format] in the [File option] tab of the ScanSnap 
setup window, a separate PDF file will be created from each JPEG file.                                                        
The following window is displayed when the PDF file is being created.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

If the computer is shared with other users, do not select the [Remember the 
password in the keychain] checkbox in this window. Otherwise, other users will be 
able to log into Google Docs automatically.
Scan to Google Docs is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Mac OS users)
If the [Convert to Searchable PDF] checkbox is selected in the [Scan to Google 
Docs(TM) - Options] window in step 3., text recognition is performed according to the 
[OCR options] settings in the [Scan to Google Docs(TM) - Options] window. The 
following window is displayed during text recognition.

Saving to Google Docs starts. Click the [Close] button to close the [Scan to Google 
Docs(TM)] window when the saving is completed.

If you select the [Close this window when save completes] checkbox above, the 
Scan to Google Docs(TM)] window will automatically close from next scanning on 
when the saving is completed.

Text recognition will be performed if there are any pages containing text which is not 
yet recognized. Note that text recognition will be performed on all pages, including 
pages containing text on which text recognition has already been performed. 

Google Docs does not start up after the saving has completed. To check the saved PDF file, 
start a web browser and log in to Google Docs.
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Actions (for Mac OS users)
■ Posting to Salesforce Chatter

This section explains how to post the scanned image as a PDF or a JPEG file to Salesforce 
Chatter.

For details about the procedure to post to Salesforce Chatter using or without using the Quick 
Menu, refer to the following:

Using the Quick Menu (→ page 357)
Without Using the Quick Menu (→ page 361)

A Saledforce CRM license is required separately.
ScanSnap Manager can link with the following Salesforce editions:
- Unlimited
- Enterprise

JPEG
PDF
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Actions (for Mac OS users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to Salesforce Chatter] (If you do not want 
to change any settings, go to step 5.).

1. Click [Settings] under the [Scan to Salesforce Chatter] icon.

The [Scan to Salesforce Chatter - Options] window appears.

2. Change the settings.
For details about the [Scan to Salesforce Chatter - Options] window, refer to the 
ScanSnap Manager Help.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to  "Using the Quick 
Menu" (page 260).

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Mac OS users)
3. Click the [OK] button to close the [Scan to Salesforce Chatter - Options] window.

5. Click the [Scan to Salesforce Chatter] icon.

If you did not specify a Salesforce account in the [Scan to Salesforce Chatter - 
Options] window in step 4., the [Scan to Salesforce Chatter - Login] window appears. 
To continue, enter your user name and password, and click the [OK] button. Enter a 
security token if needed.

The [Scan to Salesforce Chatter] window appears.

If the computer is shared with other users, do not set your information in [User 
Name], [Password] and [Security Token]. Otherwise, other users will be able to log 
into Salesforce automatically.
It is recommended to set only [User Name] and [Security Token] in this window, and 
type in the password every time.

If the computer is shared with other users, do not select the [Remember the 
password in the keychain] checkbox in this window. Otherwise, other users will be 
able to log into Salesforce automatically.
Scan to Salesforce Chatter is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Mac OS users)
6. Check the scanned image in the preview area.

In the [Scan to Salesforce Chatter] window, you can set the posting destination and 
method, the message to post, the name and description of the image file that will be 
posted to Salesforce Chatter, and save the scanned image in the folder specified for 
[Image saving folder].
For details about the [Scan to Salesforce Chatter] window, refer to the ScanSnap 
Manager Help.

Preview
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Actions (for Mac OS users)
7. Click the [Post] button.

Posting to Salesforce Chatter starts. Click the [Close] button to close the [Scan to 
Salesforce Chatter] window when the posting is completed.

If you select the [Close this window when posting completes] checkbox above, the 
[Scan to Salesforce Chatter] window will automatically close from next scanning on 
when the posting is completed.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
Salesforce Chatter] window is closed. Close the [Scan to Salesforce Chatter] window 
before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.

Salesforce does not start up after the posting is completed. To check the saved scanned 
image file, start a web browser and log in to Salesforce.
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Actions (for Mac OS users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to  "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Salesforce Chatter].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to  "Without Using 
the Quick Menu" (page 265).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected in the [Profile] pop-up menu or from the Profile menu next time 
you perform a scan.
For details about how to add a profile, refer to  "Profile Management" (page 276).
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Actions (for Mac OS users)
3. Change the settings for [Scan to Salesforce Chatter] (If you do not want 
to change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Salesforce Chatter - Options] window appears.

2. Change the setting.
For details about the [Scan to Salesforce Chatter - Options] window, refer to the 
ScanSnap Manager Help.

3. Click the [OK] button to close the [Scan to Salesforce Chatter - Options] window.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

If the computer is shared with other users, do not set your information in [User 
Name], [Password] and [Security Token]. Otherwise, other users will be able to log 
into Salesforce automatically.
It is recommended to set only [User Name] and [Security Token] in this window, and 
type in the password every time.
362



Actions (for Mac OS users)
6. Load a document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

8. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

If you did not specify a Salesforce account in the [Scan to Salesforce Chatter - 
Options] window in step 3., the [Scan to Salesforce Chatter - Login] window appears 
when the scanning is completed. To continue, enter your user name and password, 
and click the [OK] button. Enter a security token if needed.

The [Scan to Salesforce Chatter] window appears.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

If the computer is shared with other users, do not select the [Remember the 
password in the keychain] checkbox in this window.
Otherwise, other users will be able to log into Salesforce automatically.
Scan to Salesforce Chatter is not available in a proxy environment that requires 
authentication upon connecting to the Internet.
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Actions (for Mac OS users)
9. Check the scanned image in the preview area.

In the [Scan to Salesforce Chatter] window, you can set the posting destination and 
method, the message to post, the name and description of the image file that will be 
posted to Salesforce Chatter, and save the scanned image in the folder specified for 
[Image saving folder].
For details about the [Scan to Salesforce Chatter] window, refer to the ScanSnap 
Manager Help.

Preview
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Actions (for Mac OS users)
10.Click the [Post] button.

Posting to Salesforce Chatter starts. Click the [Close] button to close the [Scan to 
Salesforce Chatter] window when the posting is completed.

If you select the [Close this window when posting completes] checkbox above, the 
[Scan to Salesforce Chatter] window will automatically close from next scanning on 
when the posting is completed.

You cannot start scanning when the [Scan to Salesforce Chatter] window is displayed. 
Close the window before scanning the next document.
Do not move, delete, or rename the scanned image in other applications when the 
[Scan to Salesforce Chatter] window is displayed.

Salesforce does not start up after the posting is completed. To check the saved scanned 
image file, start a web browser and log in to Salesforce.
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Actions (for Mac OS users)
■ Saving Data to Your SugarSync Folder

This section explains how to save the scanned image as a PDF or a JPEG file to your 
SugarSync folder.

For details about the procedure to scan and save the scanned image to your SugarSync 
folder using or without using the Quick Menu, refer to the following:

Using the Quick Menu (→ page 367)
Without Using the Quick Menu (→ page 370)

You need to have a SugarSync account.
You need to have SugarSync Manager for Mac 1.9.29 or later installed in order to use this 
function.

When you first log into SugarSync after installing SugarSync Manager for Mac, the Magic 
Briefcase, which is a folder used for SugarSync, is automatically created.

JPEG
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Actions (for Mac OS users)
Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to SugarSync] (If you do not want to 
change any settings, go to step 5.).

1. Click [Settings] under the [Scan to SugarSync] icon.

The [Scan to SugarSync - Options] window appears.
2. Change the setting.

For details about the [Scan to SugarSync - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to SugarSync - Options] window.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to  "Using the Quick 
Menu" (page 260).

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Mac OS users)
5. Click the [Scan to SugarSync] icon.

The [Scan to SugarSync] window appears.
If you clear the [Show preview] checkbox in step 4., scanned image is directly saved 
to your SugarSync folder.

6. Check the scanned image in the preview area.

In the [Scan to SugarSync] window, you can rename the file and specify your 
SugarSync folder.
For details about the [Scan to SugarSync] window, refer to the ScanSnap Manager 
Help.

The file will not be synced with SugarSync unless you select a SugarSync folder as the 
destination folder.

Preview
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Actions (for Mac OS users)
7. Click the [Save] button.

The scanned image is saved to your SugarSync folder.

You cannot start scanning after the Quick Menu is displayed and before the [Scan to 
SugarSync] window is closed. Close the [Scan to SugarSync] window before scanning 
the next document.
Do not move, delete or rename the scanned image in other applications after the Quick 
Menu is displayed and before the [Scan to SugarSync] window is closed.
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Actions (for Mac OS users)
Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to  "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
SugarSync].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to  "Without Using 
the Quick Menu" (page 265).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected in the [Profile] pop-up menu or from the Profile menu next time 
you perform a scan.
For details about how to add a profile, refer to  "Profile Management" (page 276).
370



Actions (for Mac OS users)
3. Change the settings for [Scan to SugarSync] (If you do not want to 
change any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to SugarSync - Options] window appears.
2. Change the setting.

For details about the [Scan to SugarSync - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to SugarSync - Options] window.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Actions (for Mac OS users)
8. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [Scan to SugarSync] window appears when the scanning is completed.
If you clear the [Show preview] checkbox in step3., scanned image is directly saved 
to your SugarSync folder.

9. Check the scanned image in the preview area.

In the [Scan to SugarSync] window, you can rename the file and specify your 
SugarSync folder.
For details about the [Scan to SugarSync] window, refer to the ScanSnap Manager 
Help.

10.Click the [Save] button.

The scanned image is saved to your SugarSync folder.

The file will not be synced with SugarSync unless you select a SugarSync folder as the 
destination folder.

You cannot start scanning when the [Scan to SugarSync] window is displayed. Close 
thie window before scanning the next document.
Do not move, delete or rename the scanned image in other applications when the 
[Scan to SugarSync] window is displyed.

Preview
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Actions (for Mac OS users)
■ Saving Data to a Mobile Device

This section explains how to save the scanned image as a PDF or a JPEG file to a mobile 
device.

Only one mobile device can be connected to the computer.
You need to have ScanSnap Connect Application installed in the mobile device in order to 
use this function. Download ScanSnap Connect Application for mobile devices from 
application stores such as App Store.
ScanSnap Connect Application for mobile devices operate on the following operating 
systems:
- iOS 4.2.1 or later

The number of scanned image files and the maximum file size that can be saved on a mobile 
device at once are as follows:
- Number of files: Up to 100
- File size: 1024 MB

A firewall alert may be displayed when you first launch [Scan to Mobile]. When the alert is 
displayed, select [Allow].
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Actions (for Mac OS users)
For details about the procedure to perform scanning and saving scanned images to a mobile 
device through automatic linkage, using or without using the Quick Menu, and how to save 
existing files to a mobile device, refer to the following:

Automatic Linkage (→ page 375)
Using the Quick Menu (→ page 378)
Without Using the Quick Menu (→ page 381)
Saving an Existing File to a Mobile Device (→ page 385)

The following message appears when you first launch [Scan to Mobile]. Click the [OK] button 
to open the [Scan to Mobile - Basic] window.

In the [Scan to Mobile - Basic] window, enter a password to connect to the mobile device.
For details about other setting items, refer to the ScanSnap Manager Help.

When Scan to Mobile is running, the Scan to Mobile icon is displayed on the menu bar. The 
Scan to Mobile icon shows the communication status between the computer and the mobile 
device. The appearance of the icon changes according to the communication status as 
shown below.

Status Scan to Mobile icon

Waiting

Standby
Sending

Sending error

Rejected
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Actions (for Mac OS users)
Automatic Linkage

1. From Finder, select [Applications] and double-click [ScanSnap] → [Scan 
to Mobile].

The [Scan to Mobile] window appears.

For details about the features of ScanSnap Connect Application for mobile devices and how 
to use it, refer to the ScanSnap Connect Application User's Guide (iOS).
For details about automatic linkage with active applications, refer to  "Automatic Linkage with 
Applications" (page 286).
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2. Connect to the computer from your mobile device.

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User's Guide (iOS).

When the connection is established, the [Scan to Mobile] window appears on the 
computer, showing the mobile device that is currently connected to the computer.

3. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

4. Press the [Scan/Stop] button on the ScanSnap to start scanning.

To enable automatic linkage with Scan to Mobile, press the [Scan/Stop] button on the 
ScanSnap and start scanning while Scan to Mobile is active (the Scan to Mobile menu 
appears on the menu bar).

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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5. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Scanned images will be sent to the mobile device from the computer.

6. Click the [Close] button to close the [Scan to Mobile] window when the 
sending of the scanned image is completed.

When you select the [Wait until the [Send] button is clicked] checkbox in the [Scan to 
Mobile - Basic] window, the [Send] button appears in the [Scan to Mobile] window. Click 
the [Send] button to send the image to the mobile device.

The [Scan to Mobile] window closes automatically when the mobile device is disconnected 
from the computer.
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Using the Quick Menu

1. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

2. Press the [Scan/Stop] button on the ScanSnap to start scanning.

3. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The Quick Menu appears.

4. Change the settings for [Scan to Mobile] (If you do not want to change 
any settings, go to step 5.).

1. Click [Settings] under the [Scan to Mobile] icon.

The [Scan to Mobile - Options] window appears.

To use the Quick Menu, you need to select the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning by using the Quick Menu, refer to  "Using the Quick 
Menu" (page 260).

When [Scan to Mobile] has already started and is active (with the Scan to Mobile menu 
appearing in the menu bar), ScanSnap Manager links with [Scan to Mobile] automatically 
and the Quick Menu does not appear.
To display the Quick Menu, change the menu bar menu to an application other than Scan 
to Mobile, and then try scanning again.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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2. Change the setting.
For details about the [Scan to Mobile - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Mobile - Options] window.

5. Click the [Scan to Mobile] icon. 

The [Scan to Mobile] window appears.

You cannot start scanning when the Quick Menu is displayed. Wait until ScanSnap 
Manager links with [Scan to Mobile] before scanning another document.
Do not move, delete, or rename the scanned image in other applications when the 
Quick Menu is displayed.
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6. Connect to the computer from your mobile device.

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User's Guide (iOS).

When the connection is established, the [Scan to Mobile] window appears showing 
the mobile device that is currently connected to the computer. Then, the scanned 
image is sent to the mobile device.

7. Click the [Close] button to close the [Scan to Mobile] window when the 
sending of the scanned image is completed.

When you select the [Wait until the [Send] button is clicked] checkbox in the [Scan to 
Mobile - Basic] window, the [Send] button appears in the [Scan to Mobile] window. Click 
the [Send] button to send the image to the mobile device.
For details about the features of ScanSnap Connect Application for mobile devices and 
how to use it, refer to the ScanSnap Connect Application User's Guide (iOS).

The [Scan to Mobile] window closes automatically when the mobile device is disconnected 
from the computer.
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Without Using the Quick Menu

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to  "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Application] pop-up menu in the [Application] tab, select [Scan to 
Mobile].

To disable the Quick Menu, you need to clear the [Use Quick Menu] checkbox in the ScanSnap 
setup window.
For details about how to perform scanning without using the Quick Menu, refer to  "Without Using 
the Quick Menu" (page 265).

When you add the customized settings as profiles, the application to link with ScanSnap 
Manager can be selected in the [Profile] pop-up menu or from the Profile menu next time 
you perform a scan.
For details about how to add a profile, refer to  "Profile Management" (page 276).
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3. Change the settings for [Scan to Mobile] (If you do not want to change 
any settings, go to step 4.).

1. Click the [Application Settings] button.

The [Scan to Mobile - Options] window appears.

2. Change the setting.
For details about the [Scan to Mobile - Options] window, refer to the ScanSnap 
Manager Help.

3. Click the [OK] button to close the [Scan to Mobile - Options] window.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window.

6. Load a document in the ScanSnap.

For details about how to load documents, refer to  "How to Load Documents" (page 31).

7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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8. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The [Scan to Mobile] window appears on the computer.

9. Connect to the computer from your mobile device.

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User's Guide (iOS).

When the connection is established, the [Scan to Mobile] window appears showing 
the mobile device that is currently connected to the computer. Then, the scanned 
image is sent to the mobile device.
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10.Click the [Close] button to close the [Scan to Mobile] window when the 
sending of the scanned image is completed.

When you select the [Wait until the [Send] button is clicked] checkbox in the [Scan to 
Mobile - Basic] window, the [Send] button appears in the [Scan to Mobile] window. Click 
the [Send] button to send the image to the mobile device.
For details about the features of ScanSnap Connect Application for mobile devices and 
how to use it, refer to the ScanSnap Connect Application User's Guide (iOS).

The [Scan to Mobile] window closes automatically when the mobile device is disconnected 
from the computer.
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Saving an Existing File to a Mobile Device

1. From Finder, select [Applications] and double-click [ScanSnap] → [Scan 
to Mobile].

The [Scan to Mobile] window appears.

For details about the features of ScanSnap Connect Application for mobile devices and how to 
use it, refer to the ScanSnap Connect Application User's Guide (iOS).
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2. Connect to the computer from your mobile device.

For details about how to connect to the computer from your mobile device, refer to the 
ScanSnap Connect Application User's Guide (iOS).

When the connection is established, the [Scan to Mobile] window appears showing 
the mobile device that is currently connected to the computer.

3. From the menu bar, select [File] → [Open].

The [Open] window appears.

4. Select a PDF or JPEG file to save to the mobile device, and click the 
[Open] button.

The file is sent to the mobile device from the computer.
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5. Click the [Close] button to close the [Scan to Mobile] window when the 
sending of the scanned image is completed.

When you select the [Wait until the [Send] button is clicked] checkbox in the [Scan to 
Mobile - Basic] window, the [Send] button appears in the [Scan to Mobile] window. Click 
the [Send] button to send the image to the mobile device.

The [Scan to Mobile] window closes automatically when the mobile device is disconnected 
from the computer.
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Using the ScanSnap in Various Ways

This section explains about various ways of using the ScanSnap.

■ Scanning Color Documents in Gray or Black & White 
Mode

When [Auto color detection] is specified for [Color mode] in the [Scanning] tab of the 
ScanSnap setup window, the ScanSnap automatically recognizes whether the scanned 
document is color, gray or black & white, and saved the documents in their respective color 
modes.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. From the [Color mode] pop-up menu in the [Scanning] tab, select [Gray] 
or [B&W].
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3. Click the [Apply] button.

4. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

5. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

6. Press the [Scan/Stop] button on the ScanSnap to start scanning.

7. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Scanned image is saved in gray or black & white.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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■ Correcting Skewed Character Strings

When documents with skewed character strings are scanned, the ScanSnap is able to detect 
the skewed character strings and correct them.
To correct skewed character strings, change the settings in the following procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

Up to +/-5 degrees of skew can be corrected.
Since this option is performed assuming that the document contains a certain amount of text, 
character strings may be adjusted at a wrong angle when scanning the following types of 
documents. In that case, clear the [Correct skewed character strings automatically] 
checkbox:
- Documents on which pitches between lines or characters are extremely narrow, or 

characters are overlapped
- Documents with many outlined or decorated characters
- Documents with many photographs or figures and few characters
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with characters printed in various directions such as drawings
- Documents with long diagonal lines
- Documents including handwritten characters

This setting is disabled when you perform a scan using the Carrier Sheet.

You do not have to enable [Correct skewed character strings automatically] when [Automatic 
detection] is specified for [Paper size] in the [Paper] tab in the ScanSnap setup window because 
the skewed image is always corrected when documents are scanned by this setting.
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2. Click the [Option] button in the [Scanning] tab.

The [Scanning mode option] window appears.

3. Select the [Correct skewed character strings automatically] checkbox.

4. Click the [OK] button to close the [Scanning mode option] window.

5. Click the [Apply] button in the ScanSnap setup window.

6. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 
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7. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

8. Press the [Scan/Stop] button on the ScanSnap to start scanning.

9. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Image data is saved with skewed character strings corrected.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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■ Correcting the Orientation of Scanned Images

In an office environment, it is often the case that a single batch contains same size documents 
of different page orientations.
The ScanSnap is able to automatically rotate each scanned image to its correct orientation for 
such document batches.
To rotate scanned images to their correct orientations, change the settings in the following 
procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

Since this option determines the document’s page orientation based on the character strings 
printed on the document, the following types of documents may be rotated to the wrong 
orientation. In that case, clear the [Allow automatic image rotation] checkbox.

Documents with many extremely large or small characters
Documents on which pitches between lines or characters are extremely narrow, or characters 
are overlapped
Documents with many characters contacting underlines or borders
Documents with many photographs or figures and few characters
Documents with characters on an unevenly colored background
e.g. Shaded characters
Documents with many decorated characters
e.g. Decorated characters (embossed/outlined)
Documents with characters on a patterned background
e.g. Characters overlapping illustrations and diagrams
Documents with characters printed in various directions such as drawings
Documents written using only capital letters
Documents including handwritten characters
Skewed documents
Documents written in an unsupported language (language other than Japanese/English/
French/German/Italian/Spanish/Russian/Portuguese)
Documents with complex layouts
Documents with a large amount of image noise
Documents with faint characters
Documents with faded characters 
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2. Click the [Option] button in the [Scanning] tab.

The [Scanning mode option] window appears.

3. Select the [Allow automatic image rotation] checkbox. 

4. Click the [OK] button to close the [Scanning mode option] window.

5. Click the [Apply] button in the ScanSnap setup window.

6. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 
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7. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

8. Press the [Scan/Stop] button on the ScanSnap to start scanning.

9. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The scanned image is saved in the correct orientation.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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■ Scanning Documents Larger Than A4/Letter Size 

You can scan documents larger than A4/Letter size such as A3, 11 × 17 in. and B4 using the 
Carrier Sheet (sold separately). By folding the document in half and scanning both sides 
consecutively in simplex mode, the two sides are merged into a single image and saved.
Change the settings to scan documents larger than A4/Letter size in the following procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Paper] tab select [Automatic detection] in [Paper size], and then 
click the [Carrier Sheet Settings] button.

The [Carrier Sheet Settings] window appears.

In the [Scanning mode option] window ([Scanning] tab → [Option] button in the ScanSnap setup 
window), the [Correct skewed character strings automatically] checkbox is disabled.

You can also scan documents smaller than A4/Letter size and have both sides saved as a single 
image.
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3. Select [one double-page spread image] in [Save as].

For details about the Carrier Sheet settings, refer to the ScanSnap Manager Help.

4. Click the [OK] button to close the [Carrier Sheet Settings] window.

5. Click the [Apply] button in the ScanSnap setup window.

6. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

7. Place the document inside the Carrier Sheet.

1. Fold the document in half so that the sides to be scanned are facing out.
Fold it tightly and smooth out any creases.
397



Using the ScanSnap in Various Ways (for Mac OS users)
2. Open the Carrier Sheet and place the document inside.
Align the fold line with the right edge of the 
Carrier Sheet so that the document fits in 
the upper right-hand corner of the Carrier 
Sheet. 

8. Insert the part with the black and white pattern straight into the feeding 
section of the ScanSnap, with the front side of the Carrier Sheet facing 
up.

                      

The Carrier Sheet is pulled in until it is set inside the ScanSnap.

Note that the front side of the Carrier Sheet has a thick vertical line in the 
upper right-hand corner.

If you perform a scan using the Carrier Sheet with the 
output guide open, a paper jam may occur and damage the 
documents. Make sure to close the output guide when you 
perform a scan using the Carrier Sheet.

Output guide
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9. Press the [Scan/Stop] button on the ScanSnap to start scanning.

Scanning starts and the [ScanSnap Manager - Image scanning and file saving] 
window appears. When the front side of the Carrier Sheet is scanned, the image 
data is displayed in the preview area.

10.Turn over the Carrier Sheet and insert it as explained in step 8.

Scanning starts automatically and the [ScanSnap Manager - Image scanning and file 
saving] window appears. When the back side of the Carrier Sheet is scanned, 
scanned images of the front and back side of the document inside the Carrier Sheet 
are displayed as a double-page spread image in the preview area.

Make sure to scan the front and back side of the Carrier Sheet consecutively.

Repeat steps 7. to 10. to scan more documents larger than A4/Letter size.
You can continue with scanning documents that can be set directly in the ScanSnap. For 
details about how to load documents, refer to "How to Load Documents" (page 31).
Scanning starts automatically when a document is loaded in the ScanSnap.
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11.Press the [Scan/Stop] button on the ScanSnap to finish scanning.

The scanned images of the front and back side of 
the document inside the Carrier Sheet are saved as 
a double-page spread image.

There may be a line or a gap appearing between the front and back side images. Also when 
you scan thick papers, images on both left and right may skew towards each other from the 
top.
These symptoms may be improved when you perform the following:
- Fold the document properly
- Neatly align the edges of the document with the edges of the Carrier Sheet when placing 

the document inside the Carrier Sheet
If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] window, an 
optimal size will be selected automatically from the available standard sizes (A3, B4 or 11 × 
17 in.) from the same pop-up menu.
Note that the size of the image may become smaller than the original document depending 
on the document.
Example: When you scan an A3 size document whose content is printed to fit A4 size in the 

center, the image data is output in B4 size.
To output the scanned image in its original size, specify the document size in the [Paper size] 
pop-up menu.
Part of the image data around where the document is folded may appear missing. In that 
case, place the document so that its edge is about 1 mm inside from the edge of the Carrier 
Sheet.
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■ Scanning Documents Such as Photographs and 
Clippings

Using the Carrier Sheet allows you to scan documents that can be damaged quite easily such 
as photographs, or non-standard size documents that are difficult to load directly such as 
clippings.
Change the settings to scan documents such as photographs and clippings in the following 
procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then 
click the [Carrier Sheet Settings] button.

The [Carrier Sheet Settings] window appears.

In the [Scanning mode option] window ([Scanning] tab → [Option] button in the ScanSnap setup 
window), the [Correct skewed character strings automatically] checkbox is disabled.
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3. Select [two separate images (front and back)] in [Save as].

For details about the Carrier Sheet settings, refer to the ScanSnap Manager Help.

4. Click the [OK] button to close the [Carrier Sheet Settings] window.

5. Click the [Apply] button in the ScanSnap setup window.

6. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

7. Place the document inside the Carrier Sheet.

Open the Carrier Sheet and place the top of the 
document against the top center of the Carrier Sheet. 
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8. Insert the part with the black and white pattern straight into the feeding 
section of the ScanSnap, with the scanning side of the document inside 
the Carrier Sheet facing up.

                   

The Carrier Sheet is pulled in until it is set inside the ScanSnap.

9. Press the [Scan/Stop] button on the ScanSnap to start scanning.

When scanning is completed, the scanned image of the document inside the Carrier 
Sheet is displayed in the preview area.

If you perform a scan using the Carrier Sheet with the 
output guide open, a paper jam may occur and damage the 
documents. Make sure to close the output guide when you 
perform a scan using the Carrier Sheet.

Repeat steps 7. to 8. to scan more documents such as photographs and clippings.
You can continue with scanning documents that can be set directly in the ScanSnap. For 
details about how to load documents, refer to "How to Load Documents" (page 31).
Scanning starts automatically when a document is loaded in the ScanSnap.

Output guide
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10.Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Scanned image is saved.

The scanned image is output at the center of the page in the size specified in the 
[Paper size] pop-up menu of the [Carrier Sheet Settings] window.
If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] 
window, an optimal size will be selected automatically from the available standard 
sizes (A3, B4 or 11 × 17 in.) from the same pop-up menu.
Note that the size of the image may become smaller than the original document 
depending on the document scanned, or part of the image may appear missing.
Example: When an A5 size image is printed in the center of an A4 size document, the 

image is output in A5 size.
To output the scanned image in its original size, specify the document size in the 
[Paper size] pop-up menu.

Place the document over a blank sheet if the following is observed:
Scanned image is not saved in the same size as the document (when [Automatic 
detection] is specified in the [Paper size] pop-up menu of the [Carrier Sheet Settings] 
window)
There are shadows around the edges of the scanned image
There are black lines around the scanned image of a uniquely shaped cutting

Blank sheet
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■ Long Page Scanning

Documents up to 863 mm (34 in.) in length can be scanned.
The following explains how to scan long pages.

1. Insert the document straight into the feeding section of the ScanSnap, 
with the scanning side facing up.

The document is pulled in until it is set inside the ScanSnap.

Secure enough space where the 
document exits the ScanSnap, and pick 
up the document with your hands to 
prevent it from falling off the unit where 
the ScanSnap is placed on.
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2. Press the [Scan/Stop] button on the ScanSnap for 3 seconds or longer 
until it flashes in blue.

Scanning starts.

When you scan the first page as a long page and continue scanning, the next document 
is also scanned as long page.

The error message below appears and long page scanning is disabled when 
[Excellent] is selected in the [Image quality] pop-up menu in the [Scanning] tab of the 
ScanSnap setup window.

When you perform a long page scan, the setting for [Paper size] in the [Paper] tab of 
the ScanSnap setup window automatically switches to [Automatic detection]. The 
current settings are used for other scan settings.
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■ Saving Scanned Images in Multiple PDF Files

The ScanSnap is able to save scanned image in separate PDF files based on the specified 
number of pages. For example, you can scan a batch of slips, and save each slip as a PDF 
file.
To save image data in multiple PDF files, change the settings in the following procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. From the [File format] pop-up menu in the [File option] tab, select [PDF 
(*.pdf)], and then click the [Option] button.

The [PDF file format option] window appears.
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3. Select [Generate one PDF file per (n) page(s)] and enter the number of 
pages to split.

One PDF is created every time the number of pages specified here has been saved.

4. Click the [OK] button to close the [PDF file format option] window.

5. Click the [Apply] button in the ScanSnap setup window.

6. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

7. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

8. Press the [Scan/Stop] button on the ScanSnap to start scanning.

9. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

One PDF file is created every time the number of pages specified in step 3. has been 
scanned.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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■ Creating Searchable PDF Files

The ScanSnap is able to perform text recognition on a scanned image automatically and 
create a searchable PDF file.
To create searchable PDF files, change the settings in the following procedure.

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. From the [File format] pop-up menu in the [File option] tab, select [PDF 
(*.pdf)].

It is recommended that you select [Better] or [Best] for [Image quality] in the [Scanning] tab 
in the ScanSnap setup window.
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3. Select the [Convert to Searchable PDF] checkbox.

The following message appears.

Click the [OK] button to close the window. 

Language
Select the language. Japanese, English, French, German, Italian, Spanish, Russian, 
and Portuguese can be selected.
Target pages
Select [All pages] to perform text recognition for all pages and [First page] for just the 
first page.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

6. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).
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7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

8. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Text recognition is performed on the scanned image and a searchable PDF file is 
created.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.

It may take extra time to process text recognition depending on your computer system 
environment when you enable this setting in step 3. 
Scanned images of the following types of documents (characters) may not be recog-
nized correctly.
In that case, better results in text recognition may be achieved by changing the setting 
for [Color mode] or specifying a higher resolution in [Image quality].
- Documents including handwritten characters
- Documents with small characters scanned at a low resolution
- Skewed documents
- Documents written in languages other than the specified language
- Documents including texts written in italic characters
- Documents containing characters with superscripts/subscripts and complicated 

mathematical expressions 
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders

It may take extra time to perform text recognition on the following documents: 
- Documents with complex layouts 
- Documents with information other than text

e.g. Text on a shaded background
Vertical text can be searched with Adobe Acrobat, but not with Spotlight or Preview.
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■ Automatically Setting Keywords for PDF Files

If the document is black & white, character strings (e.g. page heading, title) can be set as 
keywords and used for a PDF file search.
Mark a character string to be set as a keyword with a water-based highlight pen so that the 
character string is completely covered. 
When you perform a scan, the marked character strings are recognized and set as keywords 
for the PDF file.

Mark black & white documents in the following way:
Any regular highlight pen can be used.
The following shows the colors and thickness recommended for highlight pens:

Mark a straight line over a single character string.
The supported range of a marked section is as follows:
Minimum : 3 mm (short side) × 10 mm (long side) 
Maximum : 20 mm (short side) × 150 mm (long side)
Use only one color per page for marking.

Pink Yellow Blue Green

Scan

Scan

Scan Scan

Sets text as a keyword for 
the PDF file

Searchable PDF file

ImageConverts a character string in 
a marked section into text

Keyword

You can search for the file through 
the set keyword
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Using the ScanSnap in Various Ways (for Mac OS users)
Make sure to cover the entire character string when marking it. 
Mark sections so that the entire section is evenly colored.

Do not mark more than ten sections per page.

Good example: Bad example 1:
(does not cover the entire section)

Bad example 2:
(unevenly colored)

It is recommended that you use a blue or a green highlight pen for marking. When you use 
colors such as pink or yellow for marking, the marked sections may not be recognized as 
keywords.
Use a blue highlight pen for documents with dark background colors such as 
newspapers.Marked sections may not be detected when a color other than blue is used.
For the following document types, marked sections cannot be recognized and set as 
keywords:
- Color documents such as catalogues or pamphlets 
- Documents in which two or more colors are used for marking 
- Documents containing colors other than for marking (pens other than highlight pens are 

used or the document is stained) 
- Documents with too many marked sections on a single page

The following types of marked character strings cannot be set as keywords:
- The size of marked section is outside the supported range 
- The marking is irregular (e.g. skewed) 
- Multiple marked sections are too close to each other 
- The color of the highlight pen is too pale or the color has faded 

When you mark more than one character string, make sure to leave a gap of at least 5 mm 
between the marked sections. Marked sections that are too close to each other may be 
detected as one marked section.
In the following case, character strings surrounding marked sections may be set as 
keywords: 
- Marked section overlaps the line above and below 

In the following cases, unmarked character strings may be set as keywords:
- Color documents such as catalogues or pamphlets 
- Documents with color text, diagrams, pictures, tables and lines
- Documents containing sections framed by a highlight pen
- Stained documents

Increase the resolution when you have trouble setting the keywords correctly.
Keywords set for a PDF file can be checked [Document Properties] of Adobe Acrobat / 
Adobe Reader or Preview [Inspector].
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Using the ScanSnap in Various Ways (for Mac OS users)
Change the settings in the following procedure to automatically set keywords for PDF files. 

1. Select [Settings] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

The ScanSnap setup window appears.

2. From the [File format] pop-up menu in the [File option] tab, select [PDF 
(*.pdf)].

It is recommended that you select [Better] or [Best] for [Image quality] in the [Scanning] tab 
of the ScanSnap setup window.
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3. Select the [Set the marked text as a keyword for the PDF file] checkbox. 

 

Target marked sections
Select [First marked section] to perform text recognition and set a keyword for the 
PDF file only for the character strings in the first marked section, and [All marked 
sections] for all marked sections.

Do not select [First marked section] when the text orientation of your document is 
vertical.

The following explanation is for when you select [First marked section]:
Select this button to set a character string such as a title of a document as a 
keyword for the PDF file.
Example: When only the title of a document is marked, the marked character 
string is set as a keyword for the PDF file, and the PDF file becomes searchable 
by the title character string.

When multiple marked sections exist in line, the marked character string closest to 
the top of the document is set as a keyword. 
Example: In the following case, the character string in marked section B, which is 
higher than marked section A, is set as a keyword.

Marked section A Marked section B
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Language
Select the language. Japanese, English, French, German, Italian, Spanish, Russian, 
and Portuguese can be selected.
Target pages
Select [First page] to perform text recognition and set a keyword for the PDF file only 
for the first page, and [All pages] for all pages.

4. Click the [Apply] button.

5. Click the [ ] button in the upper left corner to close the ScanSnap 
setup window. 

6. Load the document in the ScanSnap.

For details about how to load documents, refer to "How to Load Documents" (page 31).

7. Press the [Scan/Stop] button on the ScanSnap to start scanning.

Load another document in the ScanSnap when you want to scan multiple sheets. Scanning 
starts automatically when a document is loaded.
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Using the ScanSnap in Various Ways (for Mac OS users)
8. Press the [Scan/Stop] button on the ScanSnap to finish scanning.

Text recognition is performed on marked character strings and a PDF file is created 
with the keywords added.

It may take extra time to process text recognition depending on your computer system 
environment when you enable this setting in step 3.
Scanned images of the following types of documents (characters) may not be recog-
nized correctly. 
In that case, better results in text recognition may be achieved by specifying a higher 
resolution in [Image quality].
- Documents including handwritten characters
- Documents with small characters scanned at a low resolution
- Skewed documents
- Documents written in languages other than the specified language
- Documents including texts written in italic characters
- Documents containing characters with superscripts/subscripts and complicated 

mathematical expressions 
- Documents with characters on an unevenly colored background

e.g. Shaded characters
- Documents with many decorated characters

e.g. Decorated characters (embossed/outlined)
- Documents with characters on a patterned background

e.g. Characters overlapping illustrations and diagrams
- Documents with many characters contacting underlines or borders

It may take extra time to perform text recognition on the following documents: 
- Documents with complex layouts 
- Documents with information other than text

e.g. Text on a shaded background
If the same character string is marked several times in the document, the same keyword 
is added multiple times in the PDF file.
Total length of all the keywords can be up to 255 characters.
When you check keywords in Adobe Acrobat or Adobe Reader, the added keywords 
may be displayed with a set of quotation marks (e.g. "ABC").
For Mac OS X v10.4, keywords cannot be set for PDF files that are 500 MB or larger.
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Using the ScanSnap in Various Ways (for Mac OS users)
■ Saving Two Files or Pages into One Double-Page 
Spread Image

With Page Merger, you can merge two JPEG files, two single-page PDF files, or two pages of 
a multi-page PDF file vertically or horizontally. The merged file or page is saved as a single 
double-page spread image.
For details about how to merge pages, refer to the ScanSnap Manager Help.
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Troubleshooting
For details about how to resolve problems such as removing jammed documents, refer to 
"Troubleshooting" in the ScanSnap Manager Help.

Select [Help] → [Troubleshooting] in the Right-Click Menu.

Select [Help] → [Troubleshooting] in the ScanSnap Manager menu.
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Daily Care
This chapter explains about cleaning materials and how to clean the ScanSnap.

Cleaning Materials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 421

Cleaning the Outside of the ScanSnap . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 422

Cleaning the Inside of the ScanSnap. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 423
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Cleaning Materials
Cleaning Materials

Cleaning materials and their part numbers are as below.

*1 : Cleaning Wipes are wet sheets pre-moistened with Cleaner F1 which can be used instead of 
cloths moistened with Cleaner F1.

*2 : Any lint-free cloth can be used.

To obtain these products, contact your FUJITSU dealer or an authorized FUJITSU scanner 
service provider.

Product Name Part No. Unit Note

Cleaner F1 PA03950-0352 1 bottle Size: 100 ml

Cleaning Wipe (*1) PA03950-0419 1 pack 24 packets

Lint-free dry cloth (*2) Commercially 
available

- -

PFU LIMITED
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Cleaning the Outside of the ScanSnap
Cleaning the Outside of the ScanSnap

Clean the outside of the ScanSnap in the following procedure.

How to perform cleaning

1. Unplug the USB cable from the ScanSnap.

2. Clean the outside of the ScanSnap with a dry cloth, or a cloth moistened 
with Cleaner F1/mild detergent.

Never use paint thinner or any other organic solvents.
Be careful not to get any moisture or water inside the scanner during cleaning.
It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten the 
cloth with moderate quantity. Wipe off the cleaner completely to leave no residue on the 
cleaned parts.

Mild detergent or 
Cleaner F1

Cloth
Thinner
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Cleaning the Inside of the ScanSnap

Scanning continuously may cause dust and paper dust to accumulate inside the ScanSnap 
and result in scanning error.
As a guideline, the inside of the ScanSnap should be cleaned every 100 sheets scanned. 
Note that this guideline varies depending on the types of documents you scan. For instance, it 
may be necessary to clean the scanner more frequently when you scan documents on which 
the toner is not sufficiently fused.
Clean the inside of the ScanSnap in the following procedure.

WARNING

Before you perform cleaning, you must turn off the ScanSnap and unplug the USB cable to 
avoid the risk of fire or electric shock.
Do not use aerosol spray or spray that contains alcohol to clean the scanner. Dust blown 
up by strong air from the spray may enter inside of the scanner which may cause scanner 
failure or malfunction. Also note that sparks generated by static electricity may cause a fire.

Check the number of sheets scanned in the following procedure.

Select [Help] → [About ScanSnap Manager] → [Detail] button in the Right-Click Menu to 
display the [ScanSnap Manager - Scanner and driver information] dialog box, and then see 
[Total page count]. 

Select [Help] → [About ScanSnap Manager] → [Detail] button in the ScanSnap Manager Menu 
to display the [ScanSnap Manager - Scanner and driver information] window, and then see 
[Total page count].
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How to perform cleaning

1. Unplug the USB cable from the ScanSnap.

2. Open the top cover and the output guide.

3. Clean the idler rollers and the glass with a cloth moistened with Cleaner 
F1.

Glass (× 2, one on the top cover and one on the opposite side)
Gently wipe the dirt and dust off the surface of the glass sections.
Idler roller (× 12, located on the top cover)
Gently wipe the dirt and dust off the rollers as you rotate them manually. Be careful 
not to damage the surface of the rollers. Make sure that it is cleaned properly 
because residue on the roller will affect the feeding performance.

Do not use water or mild detergent to clean the inside of the ScanSnap.
It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten 
the cloth with moderate quantity.
Wipe off the cleaner completely to leave no residue on the cleaned parts.

 Feed guide

Top cover

Output guide

Idler roller ( × 12)Glass ( × 2)
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Cleaning the Inside of the ScanSnap
4. Connect the USB cable to the ScanSnap and the computer, then press 
the [Scan/Stop] button for three seconds with the top cover open.

5. Clean the feed roller and the eject roller with a cloth moistened with 
Cleaner F1.

Feed roller (× 1)
Press the [Scan/Stop] button to rotate the roller. Gently wipe the dirt off while taking 
care not to damage the surface of the roller. Make sure that it is cleaned properly 
because residue on the roller will affect the feeding performance.
Eject roller (× 1)
Press the [Scan/Stop] button to rotate the roller. Gently wipe the dirt and dust off 
while taking care not to damage the surface of the roller. Make sure that it is cleaned 
properly because residue on the roller will affect the feeding performance.
If eject roller is difficult to clean, try cleaning it from the back while you keep the top 
cover slightly open. 

The USB cable should be connected to the computer only for cleaning the feed roller 
and the eject roller.

Do not use water or mild detergent to clean the inside of the ScanSnap.
It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten 
the cloth with moderate quantity.
Wipe off the cleaner completely to leave no residue on the cleaned parts.

Pressing the [Scan/Stop] button seven times will rotate the feed roller and the eject roller 
one revolution.

     Eject roller ( × 1)

Feed roller ( × 1)

 Eject roller ( × 1)
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Cleaning the Inside of the ScanSnap
6. Close the top cover and the output guide.

It clicks when it returns to its original position.

Make sure that the top cover is completely closed. Otherwise, paper jams or other 
feeding errors may occur.

Output guide

Feed guide

Top cover
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Updating ScanSnap Manager
Updating ScanSnap Manager

Updates are released regularly in an effort to improve the usability and functionality of 
ScanSnap Manager.
This section explains how to update ScanSnap Manager.

For details about updates of the software bundled with the ScanSnap, visit the following web 
page:
http://scansnap.fujitsu.com/

■ Updating in Windows

Update ScanSnap Manager in the following procedure.
We recommend that you run the update regularly.

1. Select [Help] →  [Online Update] from the Right-Click Menu.

For details about the Right-Click Menu, refer to "Right-Click Menu" (page 64).

 A confirmation message appears.

2. Click the [Yes] button.

If a later version of ScanSnap Manager (update) is available, a message confirming 
the update appears.

It is necessary to have a browser with Internet access to perform the update.
Always log on as a user with Administrator privileges.

You can also update ScanSnap Manager by selecting [Start] menu → [All Programs] → 
[ScanSnap Manager] → [Online Update].
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Updating ScanSnap Manager
3. Click the [Yes] button.

The program is downloaded, and a confirmation message to start the installation 
appears.

4. Click the [Install] button.

Installation starts, and the ScanSnap Manager installer starts up.
Follow the instructions on the screen to continue with the installation.

If the latest version of ScanSnap Manager is already installed, the message below 
appears.

Click the [OK] button to close the message.

When you click the [Information] button, Internet Explorer which displays information about 
the latest update for ScanSnap Manager opens.
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■ Updating in Mac OS

Update ScanSnap Manager in the following procedure.
We recommend that you run the update regularly. 

1. Select [Help] → [Online Update] from the ScanSnap Manager menu.

For details about the ScanSnap Manager menu, refer to "ScanSnap Manager Menu" 
(page 256).

 A confirmation message appears.

2. Click the [Yes] button.

If a later version of ScanSnap Manager (update) is available, a message confirming 
the update appears.

It is necessary to have a web browser with Internet access to perform the update.

You can also update ScanSnap Manager by selecting:
[Help] → [Online Update] from the menu bar
From Finder, [Applications] → [ScanSnap] and double-clicking [Online Update].

If the latest version of ScanSnap Manager is already installed, the message below 
appears.

Click the [OK] button to close the message.
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Updating ScanSnap Manager
3. Click the [Yes] button.

The program is downloaded, and a confirmation message to start the installation 
appears.

4. Select [Quit] from the ScanSnap Manager menu to exit ScanSnap 
Manager.

5. Click the [Install] button.

The ScanSnap Manager installer starts.
Follow the instructions on the screen to continue with installation.

When you click the [Information] button, a web browser which displays information about 
the latest update for ScanSnap Manager opens.
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Uninstalling the Software

This section explains how to uninstall the software bundled with the ScanSnap.
For details about installation, refer to "Installing the Software" (page 35).

■ Uninstalling in Windows
This section explains how to uninstall the following software:

ScanSnap Manager
ScanSnap Organizer
CardMinder
ABBYY FineReader for ScanSnap
Evernote for Windows
Scan to Microsoft SharePoint

The procedure is as follows.

1. Turn on the computer and log on as a user with Administrator privileges.

2. Exit all running software.

3. Select [Start] menu → [Control Panel] → [Programs] → [Programs and 
Features].

The [Uninstall or change a program] dialog box appears with a list of currently 
installed software.
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4. Select the software to uninstall.

To uninstall ScanSnap Manager
Select [ScanSnap Manager].
To uninstall ScanSnap Organizer
Select [ScanSnap Organizer].
To uninstall CardMinder
Select [CardMinder].
To uninstall ABBYY FineReader for ScanSnap
Select [ABBYY FineReader for ScanSnap (TM) 4.1].
To uninstall Evernote for Windows
Select [Evernote].
To uninstall Scan to Microsoft SharePoint
Select [Scan to Microsoft SharePoint].

5. Click the [Uninstall] button.

A confirmation message appears.

6.  Click the [Yes] button.

The software is uninstalled.

To uninstall more than one software, repeat steps 4. to 6. for each software.

Screen displays may vary slightly depending on the operating system that you are 
using. In that case, follow the instructions by the operating system.

Example:
- [Programs and Features]

In Windows XP: [Add or Remove Programs]
- [Uninstall] button 

In Windows XP: [Remove] button
If you cannot successfully uninstall the following software, select [Manuals] → 
[Troubleshooting (installation)] in the [ScanSnap Setup] dialog box and refer to 
Troubleshooting (installation).
- ScanSnap Manager
- ScanSnap Organizer
- CardMinder
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■ Uninstalling in Mac OS

This section explains how to uninstall the following software:
ScanSnap Manager (→ page 434)
ABBYY FineReader for ScanSnap (→ page 435)
Cardiris (→ page 436)
Evernote for Mac (→ page 437)

ScanSnap Manager

1. Turn on the computer and log in as a user with Administrator privileges.

2. From Finder, select [Applications] and double-click [ScanSnap] → [Sub] 
→ [ScanSnap Uninstaller.app].

The [ScanSnap Uninstaller] window appears, displaying the [Welcome to ScanSnap 
Uninstaller] screen.

3. Click the [Continue] button.

The [Read Me] screen appears.

4. Read [Read Me], and then click the [Uninstall] button.

An authentication window appears.

5. Enter the user name and password for a user with Administrator 
privileges, and click the [OK] button.

Uninstallation starts. When the uninstallation is complete, the [Uninstall succeeded] 
screen appears.
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6. Click the [Close] button.

ABBYY FineReader for ScanSnap

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ABBYY FineReader for ScanSnap if it is running (select [(Application 
name)] → [Quit FineReader for ScanSnap] from the menu bar).

One of the following application names is displayed on the menu bar:
FineReader for ScanSnap
Scan to Excel
Scan to Searchable PDF
Scan to Word

3. From Finder, select [Applications] → [ABBYY FineReader for ScanSnap], 
and drag the [ABBYY FineReader for ScanSnap] folder into the Trash.

4. Empty the Trash.

The [ABBYY FineReader for ScanSnap] folder is deleted.

If ScanSnap Manager has been configured as a login item with a user account other than 
the current one, remove it in the following procedure:

1. Log in under the user account where ScanSnap Manager is set as a login item.
2. From the Apple ( ) menu, select [System Preferences].

The [System Preferences] window appears.
3. Select [Accounts].

The [Accounts] window appears.
4.  From [My Account], select the currently logged-in user.
5. Select the [Login Items] tab.

A list of login items appears.
6. From this list, select [ScanSnap Manager].
7. Click the [ ] button under the list.

ScanSnap Manager is removed from the list.
8. Close the [Accounts] window.

For Mac OS X v.10.5/Mac OS X v10.4, also perform the following.
From the sidebar in Finder, select the [volume name] → [Library] → [Receipts], and drag 
[ABBYY FineReader.pkg] into the Trash.
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Cardiris

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit Cardiris if it is running (select [Cardiris for ScanSnap] → [Quit 
Cardiris for ScanSnap] from the menu bar).

3. From Finder, select [Applications] → [Cardiris for ScanSnap], and drag 
the [Cardiris for ScanSnap] folder into the Trash.

4. Empty the Trash.

The [Cardiris for ScanSnap] folder is deleted.

For Mac OS X v.10.5/Mac OS X v10.4, also perform the following.
From the sidebar in Finder, select [volume name] → [Library] → [Receipts], and drag 
[Cardiris.pkg] into the Trash.
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Evernote for Mac

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit Evernote if it is running (select [Evernote] → [Quit Evernote] from 
the menu bar).

If the Evernote icon ( ) is displayed on the right side of the menu bar, click the icon 
and select [Quit] from the menu that appears.

3. From Finder, select [Applications] → [Evernote], and drag the [Evernote] 
application into the Trash.

4. Empty the Trash.

The [Evernote] folder is deleted.
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Setting Items With/Without the Quick Menu
Setting Items With/Without the Quick Menu

Setting items that you can configure in the ScanSnap setup dialog box/window differ 
depending on whether you are using the Quick Menu. You can select whether or not to use 
the Quick Menu according to your preferences.
For details about setting items and default settings, refer to the ScanSnap Manager Help.

(OK: Available, NA: Not available)

Setting Items With/Without the Quick Menu

Setting Item Using the Quick Menu Without Using the Quick Menu

Profile Profile button OK NA

Recommended OK NA

Small File OK NA

High Quality OK NA

Customize OK NA

Select a profile NA OK

Application Application NA(*) OK

None (Scan to File) NA OK

Adobe® Acrobat®

Adobe Acrobat Pro, Adobe 
Acrobat Professional or Adobe 
Acrobat Standard

NA OK

Adobe® Reader®

Adobe Reader

NA OK

CardMinder

Cardiris

NA OK

ScanSnap Organizer
NA OK

ABBYY Scan to Excel

Scan to Excel

NA OK

ABBYY Scan to Word

Scan to Word

NA OK

ABBYY Scan to PowerPoint(R)
NA OK
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Application Application NA(*) OK

ABBYY Scan to Searchable PDF

Scan to Searchable PDF

NA OK

Scan to Folder NA OK

Scan to E-mail NA OK

Scan to Picture Folder
NA OK

Scan to Print NA OK

Rack2-Filer
NA OK

Scan to SharePoint
NA OK

Preview
NA OK

iPhoto
NA OK

Scan to Evernote (Note) NA OK

Scan to Evernote (Document) NA OK

Scan to Google Docs(TM) NA OK

Scan to Salesforce Chatter NA OK

Scan to SugarSync NA OK

Scan to Mobile NA OK

Save Image saving folder OK

File Name Format OK

Rename file after scanning NA OK

Setting Items With/Without the Quick Menu

Setting Item Using the Quick Menu Without Using the Quick Menu
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Scanning Image quality OK

Automatic resolution OK

Normal (Color/Gray: 150 dpi, 
B&W: 300 dpi)

OK

Better (Color/Gray: 200 dpi, 
B&W: 400 dpi)

OK

Best (Color/Gray: 300 dpi, B&W: 
600 dpi)

OK

Excellent (Color/Gray: 600 dpi, 
B&W: 1200 dpi)

OK

Color mode OK

Auto color detection OK

Color OK

Gray OK

B&W OK

Color high compression
NA OK

Scanning side OK

Simplex Scan (Single-sided) OK

Continue scanning after current 
scan is finished

OK

Option OK

Brightness (Black and White 
scanning only)

OK

Setting for text only document OK

Allow automatic blank page 
removal

OK

Correct skewed character strings 
automatically

OK

Allow automatic image rotation OK

Setting Items With/Without the Quick Menu

Setting Item Using the Quick Menu Without Using the Quick Menu
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Setting Items With/Without the Quick Menu
* : When using the Quick Menu, you can start an application to link with ScanSnap Manager from 
the Quick Menu after scanning. Therefore, the [Application] tab is not displayed.

File option File format OK

PDF (*.pdf) OK

JPEG (*.jpg) OK

Set the marked text as a keyword 
for the PDF file

OK

First marked section OK

All marked sections OK

Convert to Searchable PDF OK

Language OK

Target pages OK

First page OK

All pages OK

Option OK

Multipage PDF (whole batch in 
one PDF)

OK

Generate one PDF file per (n) 
page(s)

OK

Set a password for PDF file
NA OK

Paper Paper size OK

Automatic detection OK

A4 (210 × 297 mm) OK

A5 (148 × 210 mm) OK

A6 (105 × 148 mm) OK

B5 (JIS) (182 × 257mm) OK

B6 (JIS) (128 × 182mm) OK

Post card (100 × 148 mm) OK

Business card (90 × 55 mm, 55 × 
90 mm)

OK

Letter
(8.5 × 11 in. (216 × 279.4 mm))

OK

Legal 
(8.5 × 14 in. (216 × 355.6 mm))

OK

Customize OK

Carrier Sheet Settings OK

Compression Compression rate OK

1 OK

2 OK

3 OK

4 OK

5 OK

Setting Items With/Without the Quick Menu

Setting Item Using the Quick Menu Without Using the Quick Menu
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Purchasing/Cleaning the Carrier Sheet

The Carrier Sheet can be used to scan documents that are larger than A4/Letter size, 
photographs and clippings. 
This section explains about how to purchase/clean the Carrier Sheet.

■ Purchasing the Carrier Sheet

The product name and part number of the Carrier Sheet are as follows.

The Carrier Sheet should be replaced approximately every 500 scans.
However, replace it if damage or dirt is noticeable. 

To purchase the Carrier Sheet, contact your FUJITSU dealer or an authorized FUJITSU 
scanner service provider.

Name Quantity Part No.

ScanSnap Carrier Sheet 5 sheets PA03360-0013
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Purchasing/Cleaning the Carrier Sheet
■ Cleaning the Carrier Sheet

As you keep using the Carrier Sheet, dirt and dust will accumulate on the surface and the 
inside.
Clean the Carrier Sheet regularly because it may result in scanning errors.

How to perform cleaning

Gently wipe the dirt and dust off the surface and the inside of the Carrier Sheet with a cloth 
moistened with Cleaner F1/mild detergent.

Do not use paint thinner or any other organic solvents.
Do not use force to rub against the Carrier Sheet because it may be damaged or deformed.
Be careful not to leave any crease on the Carrier Sheet.
After cleaning the inside of the Carrier Sheet with a cloth moistened with Cleaner F1/mild 
detergent, make sure that it is completely dry before closing the Carrier Sheet.
The Carrier Sheet should be replaced approximately every 500 scans.
For details about purchasing the Carrier Sheet, refer to Purchasing/Cleaning the Carrier 
Sheet (page 442).
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Installation Specifications
Installation Specifications

The following table summarizes the installation specifications of the ScanSnap.

Item Specification

Outer dimensions (Width × Depth × Height) Minimum: 273 × 47.5 × 34 mm / 10.7 × 1.9 × 1.3 in.
(when the feed guide is closed)
Maximum: 273 × 77 × 52 mm / 10.7 × 3 × 2 in.
(when the feed guide or the output guide is open)

Weight 350 g (approx. 0.77 lb.)

Input power Voltage 5 V

Power consumption During operation: 2.5 W or less
During standby: 1.0 W or less

Temperature / humidity 
allowable ranges

Temperature During operation: 5 to 35°C / 41 to 95°F
During standby: -20 to 60°C / -4 to 140 °F
During storage/transportation: -20 to 60°C / -4 to 140°F

Humidity During operation: 20 to 80%
During standby: 8 to 95%
During storage/transportation: 8 to 95%

52 mm 
(2 in.)

77 mm (3 in.) 273 mm (10.7 in.)
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About Maintenance
Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for 
repairs on this product.

Do not perform repairs on this scanner.
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The contents of this manual are subject to change without notice.
PFU LIMITED assumes no liability for incidental or consequential damages arising 
from the use of this product, and any claims by a third party.
Copying of the contents of this manual, in whole or in part, as well as the scanner 
applications is prohibited under the copyright law.

ScanSnap S1100
Operator’s Guide

P3PC-3252-03ENZ0
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